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6-DOF Joint
Joint with one spherical and three prismatic primitives

Library
Joints

Description
This block represents a joint with three translational and three rotational degrees of
freedom. Three prismatic primitives provide the translational degrees of freedom. One
spherical primitive provides the three rotational degrees of freedom.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates or rotates the follower frame with respect to the
joint primitive base frame. For all but the first joint primitive, the base frame coincides
with the follower frame of the previous joint primitive in the sequence.
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At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Translation:

a Along the X axis of the X Prismatic Primitive (Px) base frame.
b Along the Y axis of the Y Prismatic Primitive (Py) base frame. This frame is

coincident with the X Prismatic Primitive (Px) follower frame.
c Along the Z axis of the Z Prismatic Primitive (Pz) base frame. This frame is

coincident with the Y Prismatic Primitive (Py) follower frame.
2 Rotation:

• About a general 3-D axis resolved in the base frame. This frame is coincident
with the Z Prismatic Primitive (Pz) follower frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation. Because 3-D rotation occurs as a single rotation
about an arbitrary 3-D axis (as opposed to three separate rotations about the X, Y, Z
axes), gimbal lock does not occur.

Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
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and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.

Parameters

Prismatic Primitive: State Targets

Specify the prismatic primitive state targets and their priority levels. A state target is
the desired value for one of the joint state parameters—position and velocity. The
priority level is the relative importance of a state target. It determines how precisely the
target must be met. Use the Model Report tool in Mechanics Explorer to check the
assembly status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative position, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. The specified target is resolved in the
base frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative velocity, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. It is resolved in the base frame.
Selecting this option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.
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Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is m for position and m/s for velocity.

Prismatic Primitive: Internal Mechanics

Specify the prismatic primitive internal mechanics. Internal mechanics include linear
spring forces, accounting for energy storage, and damping forces, accounting for energy
dissipation. You can ignore internal mechanics by keeping spring stiffness and damping
coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the distance between base and follower
frame origins at which the spring force is zero. The default value is 0. Select or enter
a physical unit. The default is m.

Spring Stiffness
Enter the linear spring constant. This is the force required to displace the joint
primitive by a unit distance. The default is 0. Select or enter a physical unit. The
default is N/m.

Damping Coefficient
Enter the linear damping coefficient. This is the force required to maintain a
constant joint primitive velocity between base and follower frames. The default is 0.
Select or enter a physical unit. The default is N/(m/s).

Prismatic Primitive: Actuation

Specify actuation options for the prismatic joint primitive. Actuation modes include
Force and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Actuation signals are resolved in the base frame.

Force
Select an actuation force setting. The default setting is None.
Actuation Force Setting Description
None No actuation force.
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Actuation Force Setting Description
Provided by Input Actuation force from physical signal

input. The signal provides the force
acting on the follower frame with respect
to the base frame along the joint
primitive axis. An equal and opposite
force acts on the base frame.

Automatically computed Actuation force from automatic
calculation. Simscape Multibody
computes and applies the actuation force
based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Prismatic Primitive: Sensing

Select the variables to sense in the prismatic joint primitive. Selecting a variable exposes
a physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative position of the follower frame origin with
respect to the base frame origin along the joint primitive axis.
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Velocity
Select this option to sense the relative velocity of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Acceleration
Select this option to sense the relative acceleration of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Actuator Force
Select this option to sense the actuation force acting on the follower frame with
respect to the base frame along the joint primitive axis.

Spherical Primitive: State Targets

Specify the spherical primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation of the follower frame with respect to the base frame. It is
resolved in the base frame. Selecting this option exposes priority and value fields.

Priority
Select state target priority. This is the importance level assigned to the state target.
If all state targets cannot be simultaneously satisfied, the priority level determines
which targets to satisfy first and how closely to satisfy them. This option applies to
both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.
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Value
Select a method to specify the joint primitive state target.
Method Description
None Constrain the base and follower frames

to share the same orientation.
Aligned Axes Set frame rotation by aligning two

follower frame axes with two base frame
axes.

Standard Axis Specify frame rotation as an angle about
a standard axis (x, y, or z).

Arbitrary Axis Specify frame rotation as an angle about
a general [x, y, z] axis.

Rotation Sequence Specify frame rotation as a sequence of
three elementary rotations.

Rotation Matrix Specify frame rotation as a right-handed
orthogonal rotation matrix.

Aligned Axes
Select two pairs of base-follower frame axes.
Parameter Description
Pair 1 First pair of base-follower frame axes to

align.
Pair 2 Second pair of base-follower frame axes

to align. Axis choices depend on Pair 1
axis selections.

Standard Axis
Select a standard rotation axis, resolved in the base frame, and specify the follower
frame rotation angle.
Parameter Description
Axis Standard rotation axis (X, Y, or Z)

resolved in the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.
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Arbitrary Axis
Select a general 3-D rotation axis, resolved in the base frame, and specify the
follower frame rotation angle.
Parameter Description
Axis General rotation axis [X Y Z] resolved in

the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Rotation Sequence
Specify a sequence of three elementary rotations about the selected permutation of x,
y, and z axes. These rotation sequences are also known as Euler and Tait-Bryan
sequences. The rotations are those of the follower frame relative to the frame selected
in the Rotate About parameter.

If you set the Rotate About parameter to Follower Frame, the follower frame
rotates about its own axes. These axes change orientation with each successive
rotation. If you set the Rotate About parameter to Base Frame, the follower frame
rotates about the fixed base frame axes.
Parameter Description
Rotation About Frame whose axes to rotate the follower

frame about.
Sequence Sequence of axes about which to apply

the elementary rotations.
Angles Three-element vector with elementary

rotation angles about the axes specified
in the Sequence parameter.

Rotation Matrix
Specify the 3×3 transformation matrix of a proper rotation between the base and
follower frames. The matrix must be orthogonal and have determinant +1. The
default matrix is [1 0 0; 0 1 0; 0 0 1].

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity of the follower frame with respect to the base frame. It is
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resolved in the base frame. Selecting this option exposes priority and value fields.
The priority field is identical to that used for the position state target.
Value

Enter a three element vector with the angular velocity components of the follower
frame with respect to the base frame. Select a physical unit. The default is deg/s
(degree/second).

Resolution Frame
From the drop-down list, select a resolution frame. This is the frame in which the
state target is resolved. It identifies the axes the velocity vector components
apply to. The default is Follower.

Spherical Primitive: Internal Mechanics

Specify the spherical primitive internal mechanics. This includes linear spring and
damping forces, accounting for energy storage and dissipation, respectively. To ignore
internal mechanics, keep spring stiffness and damping coefficient values at the default
value of 0.

Equilibrium Position
Select a method to specify the spring equilibrium position. The equilibrium position
is the rotation angle between base and follower port frames at which the spring
torque is zero.
Method Description
None Constrain the base and follower frames

to share the same orientation.
Aligned Axes Set frame rotation by aligning two

follower frame axes with two base frame
axes.

Standard Axis Specify frame rotation as an angle about
a standard axis (x, y, or z).

Arbitrary Axis Specify frame rotation as an angle about
a general [x, y, z] axis.

Rotation Sequence Specify frame rotation as a sequence of
three elementary rotations.
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Method Description
Rotation Matrix Specify frame rotation as a right-handed

orthogonal rotation matrix.

Aligned Axes
Select two pairs of base-follower frame axes.
Parameter Description
Pair 1 First pair of base-follower frame axes to

align.
Pair 2 Second pair of base-follower frame axes

to align. Axis choices depend on Pair 1
axis selections.

Standard Axis
Select a standard rotation axis, resolved in the base frame, and specify the follower
frame rotation angle.
Parameter Description
Axis Standard rotation axis (X, Y, or Z)

resolved in the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Arbitrary Axis
Select a general 3-D rotation axis, resolved in the base frame, and specify the
follower frame rotation angle.
Parameter Description
Axis General rotation axis [X Y Z] resolved in

the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Rotation Sequence
Specify a sequence of three elementary rotations about the selected permutation of x,
y, and z axes. These rotation sequences are also known as Euler and Tait-Bryan
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sequences. The rotations are those of the follower frame relative to the frame selected
in the Rotate About parameter.

If you set the Rotate About parameter to Follower Frame, the follower frame
rotates about its own axes. These axes change orientation with each successive
rotation. If you set the Rotate About parameter to Base Frame, the follower frame
rotates about the fixed base frame axes.
Parameter Description
Rotation About Frame whose axes to rotate the follower

frame about.
Sequence Sequence of axes about which to apply

the elementary rotations.
Angles Three-element vector with elementary

rotation angles about the axes specified
in the Sequence parameter.

Rotation Matrix
Specify the 3×3 transformation matrix of a proper rotation between the base and
follower frames. The matrix must be orthogonal and have determinant +1. The
default matrix is [1 0 0; 0 1 0; 0 0 1].

Spring Stiffness
Enter the linear spring constant. This is the torque required to displace the joint
primitive by a unit angle. The term linear refers to the mathematical form of the
spring equation. The default is 0. Select a physical unit. The default is N*m/deg.

Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select a physical unit. The default is N*m/(deg/s).

Spherical Primitive: Actuation
Specify actuation options for the spherical joint primitive. Actuation modes include
Torque only. Selecting a torque input adds the corresponding physical signal port to the
block. Use this port to specify the actuation torque signal.

Torque
Select a source for the actuation torque. The default setting is None.
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Actuation Torque Setting Description
None Apply no actuation torque.
Provided by Input Apply an actuation torque based on a

physical signal. The signal specifies the
torque acting on the follower frame with
respect to the base frame. An equal and
opposite torque acts on the base frame.
Selecting this option exposes additional
parameters.

Torque (X), Torque (Y), Torque (Z)
Select in order to actuate the spherical joint primitive about each standard Cartesian
axis (X, Y, Z) separately. The block exposes the corresponding physical signal ports.
Use these ports to specify the actuation torque signals. The signals must be scalar
values.

Torque (XYZ)
Select in order to actuate the spherical joint primitive about an arbitrary axis [X Y
Z]. The block exposes the corresponding physical signal port. Use this port to specify
the actuation torque signal. The signal must be a 3-D vector.

Frame
Select the frame to resolve the actuation torque signal in. The axes of this frame
establish the directions of the X, Y, and Z torque components. The default setting is
Base.

Spherical Primitive: Sensing

Select the motion variables to sense in the spherical joint primitive. The block adds the
corresponding physical signal ports. Use these ports to output the numerical values of
the motion variables.

The block measures each motion variable for the follower frame with respect to the base
frame. It resolves that variable in the resolution frame that you select from the Frame
drop-down list.
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Motion Variables Description
Position Quaternion describing follower frame

rotation with respect to base frame. The
quaternion coefficients are

cos , sin , sin , sin
q q q q
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The measurement is the same in all
measurement frames.

Velocity (X), Velocity (Y), Velocity (Z) Angular velocity components about X, Y,
and Z axes.

Velocity 3–D angular velocity vector with
components about X, Y, and Z axes.

Acceleration (X), Acceleration (Y),
Acceleration (Z)

Angular acceleration components about X,
Y, and Z axes.

Acceleration 3–D angular acceleration vector with
components about X, Y, and Z axes.

Frame
Select the frame to resolve the measurement in. The axes of this frame establish the
directions of X, Y, and Z vector components. The default setting is Base.

Composite Force/Torque Sensing
Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

1 Blocks—Alphabetical List

1-14



Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
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• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.

Frame Ports
• B — Base frame
• F — Follower frame

Actuation Ports

The prismatic joint primitives provide the following actuation ports:
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• fx, fy, fz — Actuation forces of the X, Y, and Z prismatic joint primitives
• px, py, pz — Desired trajectories of the X, Y, and Z prismatic joint primitives

The spherical joint primitive provides the following actuation ports:

• t — Actuation torque vector [tx, ty, tz] acting on the spherical joint primitive
• tx, ty, tz — X, Y, and Z components of the actuation torque acting on the spherical

joint primitive

Sensing Ports

The prismatic primitives provide the following sensing ports:

• px, py, pz — Positions of the X, Y, and Z prismatic joint primitives
• vx, vy, vz — Velocities of the X, Y, and Z prismatic joint primitives
• ax, ay, az — Accelerations of the X, Y, and Z prismatic joint primitives
• fx, fy, fz — Actuation forces acting on the X, Y, and Z prismatic joint primitives

The spherical primitive provides the following sensing ports:

• Q — Orientation of the spherical joint primitive in quaternion form
• wx, wy, wz — X, Y, and Z angular velocity components of the spherical joint primitive
• w — Angular velocity [wx, wy, wz] of the spherical joint primitive
• bx, by, bz — X, Y, and Z angular acceleration components of the spherical joint

primitive
• b — Angular acceleration [bx, by, bz] of the spherical joint primitive

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
Bushing Joint | Prismatic Joint | Spherical Joint
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Topics
“Motion Sensing”
“Measurement Frames”
“Actuating and Sensing with Physical Signals”

Introduced in R2012a
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Angle Constraint
Fixed angle between two frame Z axes

Library
Constraints

Description
This block applies a fixed angle between the Z axes of the base and follower port frames.
The frames lose one rotational degree of freedom if the constraint angle is greater than 0°
and smaller than 180°. They lose two rotational degrees of freedom if the constraint
angle is exactly 0° or 180°—that is, if the frames are parallel or anti-parallel. The figure
shows the constraint angle between two frames.

C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.
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Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters
Type

Angle constraint type. The default setting is General.
Type Purpose
Parallel Align the base and follower frame +Z

axes.
Anti-Parallel Align the base frame +Z axis with the

follower frame -Z axis.
Perpendicular Make the base and follower frame Z axes

perpendicular to each other.
General Hold the specified angle between the Z

axes of the base and follower port frames.
Angle

Constraint angle between the base and follower frame Z axes. The angle must lie in
the range 0 < θ < 180 deg. For an angle of 0 or 180 deg, set Type to Parallel or
Anti-Parallel instead. The default value is 45 deg.

Constraint Torque Sensing

Select whether to compute and output the distance constraint torque vector and its
magnitude. The distance constraint torque is the torque the block must apply in order to
maintain the angle you specify between the base and follower port frames.

Direction
Constraint torques act in pairs. As expressed by Newton’s third law of motion, if the
base port frame exerts a constraint torque on the follower port frame, then the
follower port frame must exert an equal and opposite torque on the base port frame.
Select which of the two constraint torques to sense:
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• Follower on Base — Sense the constraint torque that the follower port frame
exerts on the base port frame.

• Base on Follower — Sense the constraint torque that the base port frame
exerts on the follower port frame.

Resolution Frame
The block expresses the constraint torque vector in terms of its Cartesian vector
components. The splitting of a vector into vector components is known as vector
resolution. The frame whose axes define the vector component directions is known as
the resolution frame. Select whether to resolve the constraint torque vector in the
base or follower port frame.

Torque Vector
Compute and output the Cartesian components of the angle constraint torque vector.
The output signal is a three-dimensional vector with components expressed about the
X, Y, and Z axes of the resolution frame.

Signed Torque Magnitude
Compute and output the magnitude of the angle constraint torque, including its sign.

Ports
The block provides two frame ports:

• B — Base frame port
• F — Follower frame port

In addition, the block provides two physical signal output ports:

• t — Angle constraint torque vector
• tm — Signed magnitude of the angle constraint torque

See Also
Bevel Gear Constraint | Common Gear Constraint | Distance Constraint | Point on
Curve Constraint | Rack and Pinion Constraint

Introduced in R2012a
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Bearing Joint
Joint with one prismatic and three revolute primitives

Library
Joints

Description
This block represents a joint with one translational and three rotational degrees of
freedom. One prismatic primitive provides the translational degree of freedom. Three
revolute primitives provide the three rotational degrees of freedom.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates or rotates the follower frame with respect to the
joint primitive base frame. For all but the first joint primitive, the base frame coincides
with the follower frame of the previous joint primitive in the sequence.
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At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Translation:

• Along the Z axis of the Z Prismatic Primitive (Pz) base frame.
2 Rotation:

a About the X axis of the X Revolute Primitive (Rx) base frame. This frame is
coincident with the Z Prismatic Primitive (Pz) follower frame.

b About the Y axis of the Y Revolute Primitive (Ry) base frame. This frame is
coincident with the X Revolute Primitive (Rx) follower frame.

c About the Z axis of the Z Revolute Primitive (Rz) base frame. This frame is
coincident with the Y Revolute Primitive (Ry) follower frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation. Because 3-D rotation occurs as a sequence, it is
possible for two axes to align, causing to the loss of one rotational degree of freedom. This
phenomenon is known as gimbal lock.

Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
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and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.

C/C++ Code Generation
This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters

Prismatic Primitive: State Targets
Specify the prismatic primitive state targets and their priority levels. A state target is
the desired value for one of the joint state parameters—position and velocity. The
priority level is the relative importance of a state target. It determines how precisely the
target must be met. Use the Model Report tool in Mechanics Explorer to check the
assembly status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative position, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. The specified target is resolved in the
base frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative velocity, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. It is resolved in the base frame.
Selecting this option exposes priority and value fields.
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Priority
Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is m for position and m/s for velocity.

Prismatic Primitive: Internal Mechanics
Specify the prismatic primitive internal mechanics. Internal mechanics include linear
spring forces, accounting for energy storage, and damping forces, accounting for energy
dissipation. You can ignore internal mechanics by keeping spring stiffness and damping
coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the distance between base and follower
frame origins at which the spring force is zero. The default value is 0. Select or enter
a physical unit. The default is m.

Spring Stiffness
Enter the linear spring constant. This is the force required to displace the joint
primitive by a unit distance. The default is 0. Select or enter a physical unit. The
default is N/m.

Damping Coefficient
Enter the linear damping coefficient. This is the force required to maintain a
constant joint primitive velocity between base and follower frames. The default is 0.
Select or enter a physical unit. The default is N/(m/s).
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Prismatic Primitive: Actuation

Specify actuation options for the prismatic joint primitive. Actuation modes include
Force and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Actuation signals are resolved in the base frame.

Force
Select an actuation force setting. The default setting is None.
Actuation Force Setting Description
None No actuation force.
Provided by Input Actuation force from physical signal

input. The signal provides the force
acting on the follower frame with respect
to the base frame along the joint
primitive axis. An equal and opposite
force acts on the base frame.

Automatically computed Actuation force from automatic
calculation. Simscape Multibody
computes and applies the actuation force
based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.
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Prismatic Primitive: Sensing

Select the variables to sense in the prismatic joint primitive. Selecting a variable exposes
a physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative position of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Velocity
Select this option to sense the relative velocity of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Acceleration
Select this option to sense the relative acceleration of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Actuator Force
Select this option to sense the actuation force acting on the follower frame with
respect to the base frame along the joint primitive axis.

Revolute Primitive: State Targets

Specify the revolute primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation angle, measured about the joint primitive axis, of the follower
frame with respect to the base frame. The specified target is resolved in the base
frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity, measured about the joint primitive axis, of the follower
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frame with respect to the base frame. It is resolved in the base frame. Selecting this
option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is deg for position and deg/s for velocity.

Revolute Primitive: Internal Mechanics

Specify the revolute primitive internal mechanics. Internal mechanics include linear
spring torques, accounting for energy storage, and linear damping torques, accounting
for energy dissipation. You can ignore internal mechanics by keeping spring stiffness and
damping coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the rotation angle between base and
follower frames at which the spring torque is zero. The default value is 0. Select or
enter a physical unit. The default is deg.

Spring Stiffness
Enter the linear spring constant. This is the torque required to rotate the joint
primitive by a unit angle. The default is 0. Select or enter a physical unit. The
default is N*m/deg.
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Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select or enter a physical unit. The default is N*m/(deg/s).

Revolute Primitive: Actuation

Specify actuation options for the revolute joint primitive. Actuation modes include
Torque and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Input signals are resolved in the base frame.

Torque
Select an actuation torque setting. The default setting is None.
Actuation Torque Setting Description
None No actuation torque.
Provided by Input Actuation torque from physical signal

input. The signal provides the torque
acting on the follower frame with respect
to the base frame about the joint
primitive axis. An equal and opposite
torque acts on the base frame.

Automatically computed Actuation torque from automatic
calculation. Simscape Multibody
computes and applies the actuation
torque based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.
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Actuation Motion Setting Description
Automatically computed Joint primitive motion from automatic

calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Revolute Primitive: Sensing
Select the variables to sense in the revolute joint primitive. Selecting a variable exposes a
physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative rotation angle of the follower frame with
respect to the base frame about the joint primitive axis.

Velocity
Select this option to sense the relative angular velocity of the follower frame with
respect to the base frame about the joint primitive axis.

Acceleration
Select this option to sense the relative angular acceleration of the follower frame with
respect to the base frame about the joint primitive axis.

Actuator Torque
Select this option to sense the actuation torque acting on the follower frame with
respect to the base frame about the joint primitive axis.

Composite Force/Torque Sensing
Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.
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Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
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joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.
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Frame Ports
• B — Base frame
• F — Follower frame

Actuation Ports

The prismatic joint primitive provides the following actuation ports:

• fz — Actuation force acting on the Z prismatic joint primitive
• pz — Desired trajectory of the Z prismatic joint primitive

The revolute joint primitives provide the following actuation ports:

• tx, ty, tz — Actuation torques acting on the X, Y, and Z revolute joint primitives
• qx, qy, qz — Desired rotations of the X, Y, and Z revolute joint primitives

Sensing Ports

The prismatic primitive provides the following sensing ports:

• pz — Position of the Z prismatic joint primitive
• vz — Velocity of the Z prismatic joint primitive
• az — Acceleration of the Z prismatic joint primitive
• fz — Actuation force acting on the Z prismatic joint primitive

The revolute primitives provide the following sensing ports:

• qx, qy, qz — Angular positions of the X, Y, and Z revolute joint primitives
• wx, wy, wz — Angular velocities of the X, Y, and Z revolute joint primitives
• bx, by, bz — Angular accelerations of the X, Y, and Z revolute joint primitives
• tx, ty, tz — Actuation torques acting on the X, Y, and Z revolute joint primitives

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
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• ft — Total force
• tt — Total torque

See Also
Prismatic Joint | Revolute Joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Rotational Measurements”
“Translational Measurements”

Introduced in R2012a
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Bevel Gear Constraint
Kinematic constraint between two bevel gear bodies with angled intersecting rotation
axes
Library: Gears and Couplings / Gears

Description
The Bevel Gear Constraint block represents a kinematic constraint between two gear
bodies with intersecting rotation axes held at a specified angle. The base and follower
frame ports identify the connection frames on the gear bodies. The gear rotation axes
coincide with the connection frame z-axes. The gears rotate at a fixed velocity ratio
determined by the gear pitch radii.

The block represents only the kinematic constraint characteristic to a bevel gear system.
Gear inertia and geometry are solid properties that you must specify using Solid blocks.
The gear constraint model is ideal. Backlash and gear losses due to Coulomb and viscous
friction between teeth are ignored. You can, however, model viscous friction at joints by
specifying damping coefficients in the joint blocks.
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Gear Geometry

The bevel gear constraint is parameterized in terms of the dimensions of the gear pitch
circles. The pitch circles are imaginary circles concentric with the gear bodies and
tangent to the tooth contact point. The pitch radii, labeled RB and RF in the figure, are the
outer radii that the gears would have if they were reduced to friction cones in mutual
contact.

Gear Assembly

Gear constraints occur in closed kinematic loops. The figure shows the closed-loop
topology of a simple bevel gear model. Joint blocks connect the gear bodies to a common
fixture or carrier, defining the maximum degrees of freedom between them. A Bevel Gear
Constraint block connects the gear bodies, eliminating one degree of freedom and
effectively coupling the gear motions.
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Assembly Requirements

The block imposes special restrictions on the relative positions and orientations of the
gear connection frames. The restrictions ensure that the gears assemble only at distances
and angles suitable for meshing. The block enforces the restrictions during model
assembly, when it first attempts to place the gears in mesh, but relies on the remainder
of the model to keep the gears in mesh during simulation.
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Position Restrictions

• The distance between the base and follower frame origins must be such that, at the
given shaft angle and pitch radii, the gear pitch circles are tangent to each other. This
distance, denoted dB-F, follows from the law of cosines:

d R R R RB F B F B F- = + - -( )2 2
2 cos ,p q

where RB is the pitch radius of the base gear, RF is the pitch radius of the follower
gear, and θShaft is the intersection angle between the rotation axes.

• The distance between the base and follower frame origins along the z-axis of the base
frame, denoted ΔzB, must be equal to:
Dz R

B F
= ( )·sin qShaft

• The distance between the base and follower frame origins along the z-axis of the
follower frame, denoted ΔzF, must be equal to:
Dz R

F B
= ( )·sin qShaft
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Orientation Restrictions

• The imaginary lines extending from the base and follower z-axes must intersect at the
shaft angle set in the block dialog box. The angle is denoted θB-F in the figure. If the
Shaft Axes parameter is set to Perpendicular, the angle is 90°.

C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.
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Ports

Frame
B — Base frame
frame

Connection frame on the base bevel gear

F — Follower frame
frame

Connection frame on the follower bevel gear

Parameters
Base Gear Radius — Radius of the base gear pitch circle
10 cm (default) | positive scalar with units of length

Radius of the base gear pitch circle. The pitch circle is concentric with the gear and
tangent to the tooth contact points. The gear radii impact the torque transmission
between the base and follower gear bodies.

Follower Gear Radius — Radius of the follower gear pitch circle
10 cm (default) | positive scalar with units of length

Radius of the follower gear pitch circle. The pitch circle is concentric with the gear and
tangent to the tooth contact points. The gear radii impact the torque transmission
between the base and follower gear bodies.

Shaft Axes — Parameterization for the gear shaft angle
Perpendicular (default) | Arbitrarily Oriented

Parameterization for the intersection angle between the bevel gear shafts. Select
Perpendicular to align the gear shafts at a right angle. Select Arbitrarily
Oriented to align the gear shafts at any angle from 0 to 180 deg.

Angle Between Shafts — Angle between the base and follower shafts
90 deg (default) | positive scalar
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Angle between the imaginary lines extending from the base and follower frame z-axes.
The angle must in the range of 0–180 deg. The actual angle between the base and
follower gears, typically set through rigid transforms, joints, and occasionally other
constraints, must be the same as that specified here.
Dependencies

This parameter is enabled when the Shaft Axes parameter is set to Arbitrarily
Oriented.

See Also
Bevel Gear Constraint | Common Gear Constraint | Rack and Pinion Constraint

Topics
“Bevel Gear”

Introduced in R2013b
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Bushing Joint
Joint with three prismatic and three revolute primitives

Library
Joints

Description
This block represents a joint with three translational and three rotational degrees of
freedom. Three prismatic primitives provide the translational degrees of freedom. Three
revolute primitives provide the rotational degrees of freedom.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates or rotates the follower frame with respect to the
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joint primitive base frame. For all but the first joint primitive, the base frame coincides
with the follower frame of the previous joint primitive in the sequence.

At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Translation:

a Along the X axis of the X Prismatic Primitive (Px) base frame.
b Along the Y axis of the Y Prismatic Primitive (Py) base frame. This frame is

coincident with the X Prismatic Primitive (Px) follower frame.
c Along the Z axis of the Z Prismatic Primitive (Pz) base frame. This frame is

coincident with the Y Prismatic Primitive (Py) follower frame.
2 Rotation:

a About the X axis of the X Revolute Primitive (Rx) base frame. This frame is
coincident with the Z Prismatic Primitive (Pz) follower frame.

b About the Y axis of the Y Revolute Primitive (Ry) base frame. This frame is
coincident with the X Revolute Primitive (Rx) follower frame.

c About the Z axis of the Z Revolute Primitive (Rz) base frame. This frame is
coincident with the Y Revolute Primitive (Ry) follower frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation. Because 3-D rotation occurs as a sequence, it is
possible for two axes to align, causing to the loss of one rotational degree of freedom. This
phenomenon is known as gimbal lock.
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Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.

C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.
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Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters

Prismatic Primitive: State Targets

Specify the prismatic primitive state targets and their priority levels. A state target is
the desired value for one of the joint state parameters—position and velocity. The
priority level is the relative importance of a state target. It determines how precisely the
target must be met. Use the Model Report tool in Mechanics Explorer to check the
assembly status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative position, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. The specified target is resolved in the
base frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative velocity, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. It is resolved in the base frame.
Selecting this option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately
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Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is m for position and m/s for velocity.

Prismatic Primitive: Internal Mechanics

Specify the prismatic primitive internal mechanics. Internal mechanics include linear
spring forces, accounting for energy storage, and damping forces, accounting for energy
dissipation. You can ignore internal mechanics by keeping spring stiffness and damping
coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the distance between base and follower
frame origins at which the spring force is zero. The default value is 0. Select or enter
a physical unit. The default is m.

Spring Stiffness
Enter the linear spring constant. This is the force required to displace the joint
primitive by a unit distance. The default is 0. Select or enter a physical unit. The
default is N/m.

Damping Coefficient
Enter the linear damping coefficient. This is the force required to maintain a
constant joint primitive velocity between base and follower frames. The default is 0.
Select or enter a physical unit. The default is N/(m/s).

Prismatic Primitive: Actuation

Specify actuation options for the prismatic joint primitive. Actuation modes include
Force and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Actuation signals are resolved in the base frame.

Force
Select an actuation force setting. The default setting is None.
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Actuation Force Setting Description
None No actuation force.
Provided by Input Actuation force from physical signal

input. The signal provides the force
acting on the follower frame with respect
to the base frame along the joint
primitive axis. An equal and opposite
force acts on the base frame.

Automatically computed Actuation force from automatic
calculation. Simscape Multibody
computes and applies the actuation force
based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Prismatic Primitive: Sensing

Select the variables to sense in the prismatic joint primitive. Selecting a variable exposes
a physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.
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Position
Select this option to sense the relative position of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Velocity
Select this option to sense the relative velocity of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Acceleration
Select this option to sense the relative acceleration of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Actuator Force
Select this option to sense the actuation force acting on the follower frame with
respect to the base frame along the joint primitive axis.

Revolute Primitive: State Targets

Specify the revolute primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation angle, measured about the joint primitive axis, of the follower
frame with respect to the base frame. The specified target is resolved in the base
frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity, measured about the joint primitive axis, of the follower
frame with respect to the base frame. It is resolved in the base frame. Selecting this
option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
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Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is deg for position and deg/s for velocity.

Revolute Primitive: Internal Mechanics
Specify the revolute primitive internal mechanics. Internal mechanics include linear
spring torques, accounting for energy storage, and linear damping torques, accounting
for energy dissipation. You can ignore internal mechanics by keeping spring stiffness and
damping coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the rotation angle between base and
follower frames at which the spring torque is zero. The default value is 0. Select or
enter a physical unit. The default is deg.

Spring Stiffness
Enter the linear spring constant. This is the torque required to rotate the joint
primitive by a unit angle. The default is 0. Select or enter a physical unit. The
default is N*m/deg.

Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select or enter a physical unit. The default is N*m/(deg/s).

Revolute Primitive: Actuation
Specify actuation options for the revolute joint primitive. Actuation modes include
Torque and Motion. Selecting Provided by Input from the drop-down list for an
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actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Input signals are resolved in the base frame.

Torque
Select an actuation torque setting. The default setting is None.
Actuation Torque Setting Description
None No actuation torque.
Provided by Input Actuation torque from physical signal

input. The signal provides the torque
acting on the follower frame with respect
to the base frame about the joint
primitive axis. An equal and opposite
torque acts on the base frame.

Automatically computed Actuation torque from automatic
calculation. Simscape Multibody
computes and applies the actuation
torque based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Revolute Primitive: Sensing

Select the variables to sense in the revolute joint primitive. Selecting a variable exposes a
physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
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in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative rotation angle of the follower frame with
respect to the base frame about the joint primitive axis.

Velocity
Select this option to sense the relative angular velocity of the follower frame with
respect to the base frame about the joint primitive axis.

Acceleration
Select this option to sense the relative angular acceleration of the follower frame with
respect to the base frame about the joint primitive axis.

Actuator Torque
Select this option to sense the actuation torque acting on the follower frame with
respect to the base frame about the joint primitive axis.

Composite Force/Torque Sensing

Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.
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Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.
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The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.

Frame Ports
• B — Base frame
• F — Follower frame

Actuation Ports

The prismatic joint primitives provide the following actuation ports:

• fx, fy, fz — Actuation forces acting on the X, Y, and Z prismatic joint primitives
• px, py, pz — Desired trajectories of the X, Y, Z prismatic joint primitives

The revolute joint primitives provide the following actuation ports:
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• tx, ty, tz — Actuation torques acting on the X, Y, and Z revolute joint primitives
• qx, qy, qz — Desired rotations of the X, Y, and Z revolute joint primitives

Sensing Ports

The prismatic joint primitives provide the following sensing ports:

• px, py, pz — Positions of the X, Y, and Z prismatic joint primitives
• vx, vy, vz — Velocities of the X, Y, and Z prismatic joint primitives
• ax, ay, az — Accelerations of the X, Y, and Z prismatic joint primitives
• fx, fy, fz — Actuation forces acting on the X, Y, and Z prismatic joint primitives

The revolute joint primitives provide the following sensing ports:

• qx, qy, qz — Angular positions of the X, Y, and Z revolute joint primitives
• wx, wy, wz — Angular velocities of the X, Y, and Z revolute joint primitives
• bx, by, bz — Angular accelerations of the X, Y, and Z revolute joint primitives
• tx, ty, tz — Actuation torques acting on the X, Y, and Z revolute joint primitives

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
6-DOF Joint | Gimbal Joint | Prismatic Joint | Revolute Joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Rotational Measurements”
“Translational Measurements”
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Introduced in R2012a
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Cartesian Joint
Joint with three prismatic primitives

Library
Joints

Description
This block represents a joint with three translational degrees of freedom. Three prismatic
primitives provide the three translational degrees of freedom. The base and follower
frames remain parallel during simulation.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates the follower frame with respect to the joint
primitive base frame. For all but the first joint primitive, the base frame coincides with
the follower frame of the previous joint primitive in the sequence.
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At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Translation:

a Along the X axis of the X Prismatic Primitive (Px) base frame.
b Along the Y axis of the Y Prismatic Primitive (Py) base frame. This frame is

coincident with the X Prismatic Primitive (Px) follower frame.
c Along the Z axis of the Z Prismatic Primitive (Pz) base frame. This frame is

coincident with the Y Prismatic Primitive (Py) follower frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation.

Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.
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C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters

Prismatic Primitive: State Targets

Specify the prismatic primitive state targets and their priority levels. A state target is
the desired value for one of the joint state parameters—position and velocity. The
priority level is the relative importance of a state target. It determines how precisely the
target must be met. Use the Model Report tool in Mechanics Explorer to check the
assembly status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative position, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. The specified target is resolved in the
base frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative velocity, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. It is resolved in the base frame.
Selecting this option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
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determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is m for position and m/s for velocity.

Prismatic Primitive: Internal Mechanics

Specify the prismatic primitive internal mechanics. Internal mechanics include linear
spring forces, accounting for energy storage, and damping forces, accounting for energy
dissipation. You can ignore internal mechanics by keeping spring stiffness and damping
coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the distance between base and follower
frame origins at which the spring force is zero. The default value is 0. Select or enter
a physical unit. The default is m.

Spring Stiffness
Enter the linear spring constant. This is the force required to displace the joint
primitive by a unit distance. The default is 0. Select or enter a physical unit. The
default is N/m.

Damping Coefficient
Enter the linear damping coefficient. This is the force required to maintain a
constant joint primitive velocity between base and follower frames. The default is 0.
Select or enter a physical unit. The default is N/(m/s).
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Prismatic Primitive: Actuation

Specify actuation options for the prismatic joint primitive. Actuation modes include
Force and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Actuation signals are resolved in the base frame.

Force
Select an actuation force setting. The default setting is None.
Actuation Force Setting Description
None No actuation force.
Provided by Input Actuation force from physical signal

input. The signal provides the force
acting on the follower frame with respect
to the base frame along the joint
primitive axis. An equal and opposite
force acts on the base frame.

Automatically computed Actuation force from automatic
calculation. Simscape Multibody
computes and applies the actuation force
based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.
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Prismatic Primitive: Sensing

Select the variables to sense in the prismatic joint primitive. Selecting a variable exposes
a physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative position of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Velocity
Select this option to sense the relative velocity of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Acceleration
Select this option to sense the relative acceleration of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Actuator Force
Select this option to sense the actuation force acting on the follower frame with
respect to the base frame along the joint primitive axis.

Composite Force/Torque Sensing

Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.
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Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
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• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.

Frame Ports
• B — Base frame
• F — Follower frame

Actuation Ports

The prismatic joint primitives provide the following actuation ports:
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• fx, fy, fz — Actuation forces acting on the X, Y, and Z prismatic joint primitives
• px, py, pz — Desired trajectories of the X, Y, Z prismatic joint primitives

Sensing Ports

The prismatic joint primitives provide the following sensing ports:

• px, py, pz — Positions of the X, Y, and Z prismatic joint primitives
• vx, vy, vz — Velocities of the X, Y, and Z prismatic joint primitives
• ax, ay, az — Accelerations of the X, Y, and Z prismatic joint primitives
• fx, fy, fz — Actuation forces acting on the X, Y, and Z prismatic joint primitives

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
Prismatic Joint | Rectangular Joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Translational Measurements”

Introduced in R2012a
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Common Gear Constraint
Kinematic constraint between two coplanar spur gear bodies with parallel rotation axes
Library: Gears and Couplings / Gears

Description
The Common Gear Constraint block represents a kinematic constraint between two
coplanar spur gear bodies with parallel rotation axes. The gear meshing can be external
to both gears or internal to one of the gears. The base and follower frame ports identify
the connection frames on the spur gear bodies. The gear rotation axes coincide with the
frame z-axes.

The block represents only the kinematic constraint characteristic to a spur gear system.
Gear inertia and geometry are solid properties that you must specify using Solid blocks.
The gear constraint model is ideal. Backlash and gear losses due to Coulomb and viscous
friction between teeth are ignored. You can, however, model viscous friction at joints by
specifying damping coefficients in the joint blocks.
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Gear Geometry

The common gear constraint is parameterized in terms of the dimensions of the gear
pitch circles. A pitch circle is an imaginary circle concentric with the gear body and
tangent to the tooth contact point. The pitch radii, labeled RB and RF in the figure, are the
radii that the gears would have if they were reduced to friction cylinders in mutual
contact.

Gear Assembly

Gear constraints occur in closed kinematic loops. The figure shows the closed-loop
topology of a simple common gear model. Joint blocks connect the gear bodies to a
common fixture or carrier, defining the maximum degrees of freedom between them. A
Common Gear Constraint block connects the gear bodies, eliminating one degree of
freedom and effectively coupling the two gear motions.
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Assembly Requirements

The block imposes special restrictions on the relative positions and orientations of the
gear connection frames. The restrictions ensure that the gears assemble only at distances
and angles suitable for meshing. The block enforces the restrictions during model
assembly, when it first attempts to place the gears in mesh, but relies on the remainder
of the model to keep the gears in mesh during simulation.
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Position Restrictions

• The distance between the z-axes of the base and follower frame, denoted dB-F in the
figure, must equal the distance between the gear centers. This constraint ensures
that the rotation axes of the gears are at the proper distance for meshing.

• The follower frame origin must lie on the xy plane of the base frame. This constraint
ensures that the pitch circle of one gear is coplanar with the pitch circle of the other.

Orientation Restrictions

• The z-axes of the base and follower frames must point in the same direction. This
constraint ensures that the gear rotation axes are parallel to each other. The figure
shows the z-axes of the base and follower frames pointing out of the screen.
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C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Ports

Frame

B — Base frame
frame

Connection frame on the base gear body.

F — Follower frame
frame

Connection frame on the follower gear body.

Parameters
Type — Type of meshing between the base and follower gear bodies
External (default) | Internal

Type of meshing between the base and follower gear bodies. Select External if both
gears have outward-facing teeth. Select Internal if one gear has inward-facing teeth.
Such a gear is known as a ring gear. The gear with the greater pitch radius serves as the
ring gear.
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Center Distance — Distance between the base and follower gear centers
20 cm (default) | positive scalar in units of length

Distance between the centers of the base and follower gear bodies. This distance is the
sum of the base and follower gear pitch radii.
Dependencies

This parameter is enabled when the Specification Method parameter is set to Center
Distance and Ratio.

Gear Ratio (Nf/Nb) — Ratio of follower gear teeth to base gear teeth
1.0 (default) | unitless positive scalar

Number of follower gear teeth divided by the number of base gear teeth. The block uses
this ratio to determine the speed and torque transmitted between the base and follower
gear shafts.
Dependencies

This parameter is enabled when the Specification Method parameter is set to Center
Distance and Ratio.

Base Gear Radius — Radius of the pitch circle of the base gear body
10 cm (default) | positive scalar in units of length

Radius of the pitch circle of the base gear body. The pitch circle is an imaginary circle
concentric with the gear body and tangent to the tooth contact point.
Dependencies

This parameter is enabled when the Specification Method parameter is set to Pitch
Circle Radii.

Follower Gear Radius — Radius of the pitch circle of the follower gear body
10 cm (default) | positive scalar in units of length

Radius of the pitch circle of the follower gear body. The pitch circle is an imaginary circle
concentric with the gear body and tangent to the tooth contact point.
Dependencies

This parameter is enabled when the Specification Method parameter is set to Pitch
Circle Radii.
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See Also
Bevel Gear Constraint | Rack and Pinion Constraint | Worm and Gear Constraint

Topics
“External Spur Gear”
“Internal Spur Gear”

Introduced in R2013a
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Constant Velocity Joint
Joint with two rotational DoFs between shafts constrained to spin with equal velocity

Library
Joints

Description
This block represents a joint with two rotational degrees of freedom constrained to
maintain a constant angular velocity about the base and follower Z axes. The base and
follower frame origins remain coincident throughout simulation.

The joint applies three rotation transformations between the base and follower frames in
the sequence azimuth → bend angle → -azimuth. Each transformation takes place
relative to the intermediate frame resulting from any prior transformations. For
example, the bend angle transformation takes place relative to the intermediate frame
resulting from the azimuth transformation.

Joint Degrees of Freedom
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A set of optional state targets guide assembly for the joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Optional sensing ports output the joint primitive motion through physical signals.
Motion variables that you can sense include joint position, velocity, and acceleration.
Selecting a variable in the Sensing menu exposes the physical signal port for that
variable.

C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters

Constant Velocity Primitive: State Targets

Specify Position Target
Desired joint primitive position at the start of simulation. This is the relative angular
position of the follower frame relative to the base frame. Selecting this option exposes
priority and value fields.

Specify Velocity Target
Desired joint velocity at the start of simulation. This is the relative angular velocity
of the follower frame relative to the base frame. Selecting this option exposes priority
and value fields.
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Priority
Select state target priority. This is the importance level assigned to the state target.
If all state targets cannot be simultaneously satisfied, the priority level determines
which targets to satisfy first and how closely to satisfy them. This option applies to
both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Joint primitive angles to specify. Angles include bend and azimuth angles.

Value: Bend Angle
Angle between the base and follower frame Z axes. The block applies this angle about
the rotated Y axis resulting from the azimuth transformation. At zero bend angle, the
follower frame Z axis is coincident with the base frame Z axis.

Value: Azimuth
Angle about the base frame Z axis prior to bending. At zero azimuth, the base and
follower Z axes are in the XZ plane of the base frame.

Constant Velocity Primitive: Sensing

Select the variables to sense in the constant velocity joint primitive. Selecting a variable
exposes a physical signal port that outputs the measured quantity as a function of time.
Each quantity is measured for the follower frame with respect to the base frame. It is
resolved in the base frame.
Variable Description
Bend Angle: Position Angle between the base and follower frame

Z axes
Bend Angle: Velocity First time derivative of the bend angle.
Bend Angle: Acceleration Second time derivative of the bend angle.
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Variable Description
Azimuth: Position Angle about the base frame Z axis prior to

bending.
Azimuth: Velocity First time derivative of the azimuth angle.
Azimuth: Acceleration Second time derivative of the azimuth

angle.

Composite Force/Torque Sensing

Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.
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Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
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• Internal spring and damper torques that resist motion at revolute or spherical
joint primitives.

• Constraint torques that forbid motion in directions orthogonal to the revolute or
spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for sensing
dynamical variables such as forces, torques, and motion. You expose an optional port by
selecting the sensing check box corresponding to that port.

Frame Ports
• B — Base frame
• F — Follower frame

Sensing Ports

The constant velocity joint primitive provides the following sensing ports:

• qb — Bend angle
• wb — First time-derivative of the bend angle
• bb — Second time-derivative of the bend angle
• qa — Azimuth angle
• wa — First time-derivative of the azimuth angle
• ba — Second time-derivative of the azimuth angle

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
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• ft — Total force
• tt — Total torque

See Also
Universal Joint

Introduced in R2015a
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Cylindrical Joint
Joint with one prismatic and one revolute primitives possessing parallel motion axes

Library
Joints

Description
This block represents a joint with one translational and one rotational degree of freedom.
One prismatic primitive provides the translational degree of freedom. One revolute
primitive provides the rotational degree of freedom. The translation and rotation axes
remain aligned during simulation.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates or rotates the follower frame with respect to the
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joint primitive base frame. For all but the first joint primitive, the base frame coincides
with the follower frame of the previous joint primitive in the sequence.

At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Rotation:

• About the Z axis of the Z Revolute Primitive (Rz) base frame.
2 Translation:

• Along the Z axis of the Z Prismatic Primitive (Pz) base frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation.

Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.
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C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters

Revolute Primitive: State Targets

Specify the revolute primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation angle, measured about the joint primitive axis, of the follower
frame with respect to the base frame. The specified target is resolved in the base
frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity, measured about the joint primitive axis, of the follower
frame with respect to the base frame. It is resolved in the base frame. Selecting this
option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
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determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is deg for position and deg/s for velocity.

Revolute Primitive: Internal Mechanics

Specify the revolute primitive internal mechanics. Internal mechanics include linear
spring torques, accounting for energy storage, and linear damping torques, accounting
for energy dissipation. You can ignore internal mechanics by keeping spring stiffness and
damping coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the rotation angle between base and
follower frames at which the spring torque is zero. The default value is 0. Select or
enter a physical unit. The default is deg.

Spring Stiffness
Enter the linear spring constant. This is the torque required to rotate the joint
primitive by a unit angle. The default is 0. Select or enter a physical unit. The
default is N*m/deg.

Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select or enter a physical unit. The default is N*m/(deg/s).
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Revolute Primitive: Actuation

Specify actuation options for the revolute joint primitive. Actuation modes include
Torque and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Input signals are resolved in the base frame.

Torque
Select an actuation torque setting. The default setting is None.
Actuation Torque Setting Description
None No actuation torque.
Provided by Input Actuation torque from physical signal

input. The signal provides the torque
acting on the follower frame with respect
to the base frame about the joint
primitive axis. An equal and opposite
torque acts on the base frame.

Automatically computed Actuation torque from automatic
calculation. Simscape Multibody
computes and applies the actuation
torque based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.
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Revolute Primitive: Sensing

Select the variables to sense in the revolute joint primitive. Selecting a variable exposes a
physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative rotation angle of the follower frame with
respect to the base frame about the joint primitive axis.

Velocity
Select this option to sense the relative angular velocity of the follower frame with
respect to the base frame about the joint primitive axis.

Acceleration
Select this option to sense the relative angular acceleration of the follower frame with
respect to the base frame about the joint primitive axis.

Actuator Torque
Select this option to sense the actuation torque acting on the follower frame with
respect to the base frame about the joint primitive axis.

Prismatic Primitive: State Targets

Specify the prismatic primitive state targets and their priority levels. A state target is
the desired value for one of the joint state parameters—position and velocity. The
priority level is the relative importance of a state target. It determines how precisely the
target must be met. Use the Model Report tool in Mechanics Explorer to check the
assembly status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative position, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. The specified target is resolved in the
base frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative velocity, measured along the joint primitive axis, of the follower frame
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origin with respect to the base frame origin. It is resolved in the base frame.
Selecting this option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is m for position and m/s for velocity.

Prismatic Primitive: Internal Mechanics

Specify the prismatic primitive internal mechanics. Internal mechanics include linear
spring forces, accounting for energy storage, and damping forces, accounting for energy
dissipation. You can ignore internal mechanics by keeping spring stiffness and damping
coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the distance between base and follower
frame origins at which the spring force is zero. The default value is 0. Select or enter
a physical unit. The default is m.

Spring Stiffness
Enter the linear spring constant. This is the force required to displace the joint
primitive by a unit distance. The default is 0. Select or enter a physical unit. The
default is N/m.
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Damping Coefficient
Enter the linear damping coefficient. This is the force required to maintain a
constant joint primitive velocity between base and follower frames. The default is 0.
Select or enter a physical unit. The default is N/(m/s).

Prismatic Primitive: Actuation

Specify actuation options for the prismatic joint primitive. Actuation modes include
Force and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Actuation signals are resolved in the base frame.

Force
Select an actuation force setting. The default setting is None.
Actuation Force Setting Description
None No actuation force.
Provided by Input Actuation force from physical signal

input. The signal provides the force
acting on the follower frame with respect
to the base frame along the joint
primitive axis. An equal and opposite
force acts on the base frame.

Automatically computed Actuation force from automatic
calculation. Simscape Multibody
computes and applies the actuation force
based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.
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Actuation Motion Setting Description
Automatically computed Joint primitive motion from automatic

calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Prismatic Primitive: Sensing
Select the variables to sense in the prismatic joint primitive. Selecting a variable exposes
a physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative position of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Velocity
Select this option to sense the relative velocity of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Acceleration
Select this option to sense the relative acceleration of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Actuator Force
Select this option to sense the actuation force acting on the follower frame with
respect to the base frame along the joint primitive axis.

Composite Force/Torque Sensing
Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.
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Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
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joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.
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Frame Ports
• B — Base frame
• F — Follower frame

Actuation Ports

The prismatic joint primitive provides the following actuation ports:

• fz — Actuation force acting on the Z prismatic joint primitive
• pz — Desired trajectory of the Z prismatic joint primitive

The revolute joint primitive provides the following actuation ports:

• tz — Actuation torque acting on the Z revolute joint primitive
• qz — Desired rotation of the Z revolute joint primitive

Sensing Ports

The prismatic joint primitive provides the following sensing ports:

• pz — Position of the Z prismatic joint primitive
• vz — Velocity of the Z prismatic joint primitive
• az — Acceleration of the Z prismatic joint primitive
• fz — Actuation force acting on the Z prismatic joint primitive

The revolute joint primitive provides the following sensing ports:

• qz — Angular position of the Z revolute joint primitive
• wz — Angular velocity of the Z revolute joint primitive
• bz — Angular acceleration of the Z revolute joint primitive
• tz — Actuation torque acting on the Z revolute joint primitive

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
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• ft — Total force
• tt — Total torque

See Also
Prismatic Joint | Revolute Joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Rotational Measurements”
“Translational Measurements”

Introduced in R2012a
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Distance Constraint
Fixed distance between two frame origins

Library
Constraints

Description
This block applies a fixed distance between the origins of the base and follower port
frames. The frames lose one translational degree of freedom with respect to each other.
The constraint distance between the frame origins, labeled D in the figure, must be
greater than zero.

The block provides constraint force sensing in the form of a vector or a signed magnitude.
These quantities are contained in physical signals that the block outputs through
Simscape PS ports. The constraint force is the force required to maintain the specified
distance between the port frame origins.

C/C++ Code Generation
This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
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on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters
Distance

Constraint distance between the base and follower frame origins. The distance must
be greater than zero. For a distance of zero, use a Spherical Joint or Gimbal Joint
block instead. The default value is 1 m.

Constraint Force Sensing

Select whether to compute and output the distance constraint force vector and its signed
magnitude. The distance constraint force is the force that the block must apply in order
to maintain the distance you specify between the base and follower port frames.

Direction
Constraint forces act in pairs. As expressed by Newton’s third law of motion, if the
base port frame exerts a constraint force on the follower port frame, then the follower
port frame must exert an equal and opposite force on the base port frame. Select
which of the two constraint forces to sense:

• Follower on Base — Sense the constraint force that the follower port frame
exerts on the base port frame.

• Base on Follower — Sense the constraint force that the base port frame exerts
on the follower port frame.

Resolution Frame
The block expresses the constraint force vector in terms of its Cartesian vector
components. The splitting of a vector into vector components is known as vector
resolution. The frame whose axes define the vector component directions is known as
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the resolution frame. Select whether to resolve the constraint force vector in the base
or follower port frame.

Force Vector
Compute and output the Cartesian components of the distance constraint force
vector. The output signal is a three-dimensional vector, [fx, fy, fz].

Signed Force Magnitude
Compute and output the magnitude of the distance constraint force, including its
sign.

Ports
The block provides two frame ports:

• B — Base frame port
• F — Follower frame port

In addition, the block provides two physical signal output ports:

• f — Distance constraint force vector
• fm — Signed magnitude of the distance constraint force

See Also
Angle Constraint | Bevel Gear Constraint | Common Gear Constraint | Point on Curve
Constraint | Rack and Pinion Constraint

Introduced in R2012a
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Internal Force
General force acting reciprocally between two frame origins

Library
Forces and Torques

Description
This block represents a general force pair acting reciprocally between base and follower
frame origins. The two forces in the pair have equal magnitude but opposite directions.
One force acts on the base frame origin, along the vector connecting follower to base
frame origins. The other force acts on the follower frame origin, along the vector
connecting base to follower frame origins.

To specify the internal force, the block provides physical signal port fm. A positive input
signal represents a repulsive force, which pushes base and follower frame origins apart.
A negative input signal represents an attractive force, which pulls base and follower
frame origins together. If at any time the two frame origins are coincident, the internal
force direction becomes undefined and Simscape Multibody might stop with an error.

C/C++ Code Generation
This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
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time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Ports
This block contains frame ports B and F, representing base and follower port frames,
respectively. A physical signal port, fm, provides the means to specify the internal force
acting between the two port frames.

See Also
External Force and Torque | Inverse Square Law Force | Spring and Damper Force

Topics
“Actuating and Sensing with Physical Signals”

Introduced in R2013a
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External Force and Torque
General force and torque arising outside the modeled system

Library
Forces and Torques

Description
This block represents a general force and torque that an external agency applies on a
rigid body frame. The force and torque input can be constant or it can vary with time.
The block provides a set of physical signal ports that you use to specify this input. The
ports are hidden by default. Selecting an actuation mode exposes the corresponding
physical signal port.

Each force and torque input acts on the origin of the follower frame in a direction that
depends on the chosen force type and resolution frame. A force/torque vector component
acts along/about the associated Cartesian axis, resolved in the chosen resolution frame.
For example, the Force(X) input acts along the X axis of the resolution frame. A
complete force/torque vector acts in the general direction that its components specify,
resolved in the chosen resolution frame.

A force input with a positive value acts along the positive direction of the associated axis.
A torque input with a positive value acts about the associated axis according to the right-
hand rule.

C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
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on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters

Actuation: Force

Select the force inputs to specify and the frame to resolve them in.

Force Resolution Frame
Select the frame to resolve each force signal in. The components of the force vector
align with the axes of the resolution frame. The default setting is Attached Frame.
The table summarizes the resolution frames that you can select.
Resolution Frame Description
World Resolve each force component in the

World frame of the model.
Attached Frame Resolve each force component in the

follower frame of the External Force and
Torque block. The follower frame is the
attached frame of the block.

Force Inputs
Select the force inputs to specify. Options include the complete force vector and the
separate components of that vector. Selecting a force input exposes the physical
signal port associated with that input. Use that port to specify the force input via
physical signals. The table summarizes the force inputs that you can select.
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Force Input Description Input
Force(X), Force(Y),
Force(Z)

Specify separately the
force components acting on
the origin of the follower
frame along the X, Y, and
Z axes of the resolution
frame

Scalar

Force Specify the complete force
vector [fx fy fz] acting on
the origin of the follower
frame along the X, Y, and
Z axes of the resolution
frame

Three-element vector

Actuation: Torque

Select the torque inputs to specify and the frame to resolve them in.

Torque Resolution Frame
Select the frame to resolve each torque signal in. The components of the torque vector
align with the axes of the resolution frame. The default setting is Attached Frame.
The table summarizes the resolution frames that you can select.
Resolution Frame Description
World Resolve each torque component in the

World frame of the model.
Attached Frame Resolve each torque component in the

follower frame of the External Force and
Torque block. The follower frame is the
attached frame of the block.

Torque Inputs
Select the torque inputs to specify. Options include the complete torque vector and
the separate components of that vector. Selecting a torque input exposes the physical
signal port associated with that input. Use that port to specify the torque input via
physical signals. The table summarizes the torque inputs that you can select.
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Force Input Description Input
Torque(X), Torque(Y),
Torque(Z)

Specify separately the
torque components acting
on the origin of the
follower frame about the X,
Y, and Z axes of the
resolution frame

Scalar

Torque Specify the complete
torque vector [fx fy fz]
acting on the origin of the
follower frame about a
general direction in the
resolution frame

Three-element vector

Ports
The block contains frame port F, representing the follower frame. Selecting an actuation
mode exposes additional physical signal ports. Use the ports to input the selected
actuation signals.

Each physical signal port has a unique label. The table identifies the actuation modes
that the port labels correspond to.
Port Label Description
fx, fy, fz Force vector components acting on the

origin of the follower frame along the X, Y,
and Z axes, respectively

f Force vector [fx, fy, fz] acting on the origin
of the follower frame along a general
direction [X Y Z]

tx, ty, tz Torque vector components acting on the
origin of the follower frame about the X, Y,
and Z axes, respectively

t Torque vector [tx ty tz] acting on the origin
of the follower frame about a general
direction [X Y Z]
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See Also
Internal Force | Inverse Square Law Force | Spring and Damper Force

Topics
“Actuating and Sensing with Physical Signals”

Introduced in R2012a
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General Variable Mass
Mass element with variable inertial properties
Library: Body Elements / Variable Mass

Description
The General Variable Mass block adds to the attached frame a mass element with
constant or time-varying inertial properties. The mass element can be a point mass
without rotational inertia or a custom mass with rotational inertia. The inertial
properties include mass, center of mass, moments of inertia, and products of inertia.
Each inertial property can be independently configured as constant or time-varying.

The geometry of the mass element is unspecified. A marker or equivalent inertia ellipsoid
identifies the mass element in the visualization pane of Mechanics Explorer. An inertia
ellipsoid provides a graphical representation of the principal moments of inertia of the
mass element. The block includes an option to hide the variable mass element in the
Mechanics Explorer visualization window.

Ports

Input

m — Mass
physical signal specified as a scalar with units of mass

Input port for the time-varying mass.

Dependencies

This port is enabled when the Inertia > Mass parameter is set to Time-Varying.
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com — Center of mass
physical signal specified as a 3-by-1 or 1-by-3 vector with units of length

Input port for the time-varying center-of-mass coordinates. Specify the coordinates in the
order [x y z] relative to the block reference frame.

Dependencies

This port is enabled when the Inertia > Center of Mass parameter is set to Time-
Varying.

I — Inertia
physical signal specified as a 3-by-3 matrix with units of mass × length^2

Input port for the time-varying inertia tensor. Specify the tensor elements in the order
[Ixx Ixy I xz; Iyx Iyy Iyz; Izx Izy Izz]. The elements are defined relative to
a frame with origin at the center of mass and axes aligned with the reference frame. See
the Inertia tensor parameter description for the definitions of the moments and
products of inertia.

Dependencies

This port is enabled when the Inertia > Type parameter is set to Custom.

Frame

R — Reference frame
frame

Local reference frame of the variable mass element. Connect the port to a frame line or
another frame port to define the relative position and orientation of the variable mass.

Parameters
Inertia

Type — Choice of point or distributed mass
Custom (default) | Point Mass
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Choice of point or distributed mass. Select Point Mass to model a concentrated mass
with no rotational inertia. Select Custom to model a distributed mass with the specified
inertia tensor and center of mass.

Mass — Mass parameterization
Time-Varying (default) | Constant

Choice of fixed or variable mass. Select Time-Varying to specify the mass as a variable
using physical signal input port m. Select Constant to specify the mass as a constant
parameter.

Mass: Value — Aggregate mass of the mass element
1 kg (default) | scalar with units of mass

Aggregate mass of the mass element. The mass can be a positive or negative value.
Specify a negative mass to model the aggregate effect of voids and cavities in a compound
body. The mass is constant when this parameter is active.
Dependencies

This parameter is enabled when the Mass parameter is set to Constant.

Center of Mass — Center-of-mass parameterization
Time-Varying (default) | Constant

Choice of fixed or variable center of mass. Select Time-Varying to specify the center of
mass as a variable using physical signal input port com. Select Constant to specify the
center of mass as a constant parameter.

Center of Mass: Value — Center-of-mass coordinates
[0 0 0] m (default) | three-element vector with units of length

[x y z] coordinates of the center of mass relative to the origin of the reference frame. The
center of mass coincides with the center of gravity in uniform gravitational fields only.
The center of mass is constant when this parameter is active.
Dependencies

This parameter is enabled when the Center of Mass parameter is set to Constant.

Inertia Matrix — Inertia-matrix parameterization
Time-Varying (default) | Constant
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Choice of a variable or fixed inertia matrix. Select Time-Varying to specify the inertia
matrix as a variable using physical signal input port I. Select Constant to specify the
moments and products of inertia separately as constant block parameters.

Inertia Matrix: Moments of Inertia — Diagonal elements of the inertia matrix
[1 1 1] kg * m^2 (default) | three-element vector with units of mass*length^2

Moments of inertia of the variable mass element specified in the order [Ixx Iyy Izz]. The
moments of inertia are defined relative to a frame with origin at the center of mass and
with axes parallel to the reference frame axes. The moments of inertia are the diagonal
elements of the inertia tensor,
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Dependencies

This parameter is enabled when the Inertia Matrix parameter is set to Constant.

Inertia Matrix: Products of Inertia — Off-diagonal elements of the inertia matrix
[0 0 0] kg * m^2 (default) | 3-element array with units of mass * length^2

Products of inertia of the variable mass element specified in the order [Iyz Izx Ixy]. The
products of inertia are defined relative to a frame with origin at the center of mass and
with axes parallel to the reference frame axes. The products of inertia are the off-
diagonal elements of the inertia matrix,
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Dependencies

This parameter is enabled when the Inertia Matrix parameter is set to Constant.

Graphic

Type — Geometry type to use in model visualizations
Equivalent Inertia Ellipsoid (default) | Marker | None

Visualization setting for this solid. Marker dimensions are fixed and specified in pixel
units. Ellipsoid dimensions are variable and depend on the specified mass and inertia
tensor. The center of the ellipsoid coincides with the specified center of mass. Marker
visualization is active on model update and during simulation. Ellipsoid visualization is
active during simulation only.

Marker: Shape — Shape of the graphic marker
Sphere (default) | Cube | Frame

Geometrical shape of the graphic marker. Mechanics Explorer shows the marker using
the selected shape.

Marker: Size — Pixel size of the graphic marker
10 (default) | scalar with units of pixels
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Size of the marker in units of pixels. The size does not change with zoom level.

Visual Properties — Parameterizations for color and opacity
Simple (default) | Advanced

Parameterization for specifying visual properties. Select Simple to specify color and
opacity. Select Advanced to add specular highlights, ambient shadows, and self-
illumination effects.

Simple: Color — True color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

RGB color vector with red (R), green (G), and blue (B) color amounts specified on a 0–1
scale. A color picker provides an alternative interactive means of specifying a color. If you
change the Visual Properties setting to Advanced, the color specified in this parameter
becomes the Diffuse Color vector.

Simple: Opacity — Surface opacity as scalar number on 0–1 scale
1.0 (default) | scalar with value constrained to 0–1

Graphic opacity specified on a scale of 0–1. An opacity of 0 corresponds to a completely
transparent graphic and an opacity of 1 to a completely opaque graphic.

Advanced: Diffuse Color — True color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

True color under direct white light specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. An optional fourth element specifies the color opacity also on a scale of 0–1.
Omitting the opacity element is equivalent to specifying a value of 1.

Advanced: Specular Color — Highlight color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of specular highlights specified as an [R,G,B] or [R,G,B,A] vector on a 0–1 scale.
The optional fourth element specifies the color opacity. Omitting the opacity element is
equivalent to specifying a value of 1.

Advanced: Ambient Color — Shadow color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1
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Color of shadow areas in diffuse ambient light, specified as an [R,G,B] or [R,G,B,A] vector
on a 0–1 scale. The optional fourth element specifies the color opacity. Omitting the
opacity element is equivalent to specifying a value of 1.

Advanced: Emissive Color — Self-illumination color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Surface color due to self illumination, specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. The optional fourth element specifies the color opacity. Omitting the opacity
element is equivalent to specifying a value of 1.

Advanced: Shininess — Highlight sharpness as scalar number on 0–128 scale
75 (default) | scalar with value constrained to 0–128

Sharpness of specular light reflections, specified as a scalar number on a 0–128 scale.
Increase the shininess value for smaller but sharper highlights. Decrease the value for
larger but smoother highlights.

See Also
Graphic | Inertia | Solid | Spline

Topics
“Specifying Custom Inertias”
“Representing Solid Inertia”
“Manipulate the Color of a Solid”

Introduced in R2016b
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Gimbal Joint
Joint with three revolute primitives

Library
Joints

Description
This block represents a joint with three rotational degrees of freedom. Three revolute
primitives provide the three rotational degrees of freedom. The base and follower frame
origins remain coincident during simulation.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates or rotates the follower frame with respect to the
joint primitive base frame. For all but the first joint primitive, the base frame coincides
with the follower frame of the previous joint primitive in the sequence.
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At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Rotation:

a About the X axis of the X Revolute Primitive (Rx) base frame.
b About the Y axis of the Y Revolute Primitive (Ry) base frame. This frame is

coincident with the X Revolute Primitive (Rx) follower frame.
c About the Z axis of the Z Revolute Primitive (Rz) base frame. This frame is

coincident with the Y Revolute Primitive (Ry) follower frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation. Because 3-D rotation occurs as a sequence, it is
possible for two axes to align, causing to the loss of one rotational degree of freedom. This
phenomenon is known as gimbal lock.

Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.
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C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters

Revolute Primitive: State Targets

Specify the revolute primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation angle, measured about the joint primitive axis, of the follower
frame with respect to the base frame. The specified target is resolved in the base
frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity, measured about the joint primitive axis, of the follower
frame with respect to the base frame. It is resolved in the base frame. Selecting this
option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
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determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is deg for position and deg/s for velocity.

Revolute Primitive: Internal Mechanics

Specify the revolute primitive internal mechanics. Internal mechanics include linear
spring torques, accounting for energy storage, and linear damping torques, accounting
for energy dissipation. You can ignore internal mechanics by keeping spring stiffness and
damping coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the rotation angle between base and
follower frames at which the spring torque is zero. The default value is 0. Select or
enter a physical unit. The default is deg.

Spring Stiffness
Enter the linear spring constant. This is the torque required to rotate the joint
primitive by a unit angle. The default is 0. Select or enter a physical unit. The
default is N*m/deg.

Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select or enter a physical unit. The default is N*m/(deg/s).
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Revolute Primitive: Actuation

Specify actuation options for the revolute joint primitive. Actuation modes include
Torque and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Input signals are resolved in the base frame.

Torque
Select an actuation torque setting. The default setting is None.
Actuation Torque Setting Description
None No actuation torque.
Provided by Input Actuation torque from physical signal

input. The signal provides the torque
acting on the follower frame with respect
to the base frame about the joint
primitive axis. An equal and opposite
torque acts on the base frame.

Automatically computed Actuation torque from automatic
calculation. Simscape Multibody
computes and applies the actuation
torque based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.
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Revolute Primitive: Sensing

Select the variables to sense in the revolute joint primitive. Selecting a variable exposes a
physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative rotation angle of the follower frame with
respect to the base frame about the joint primitive axis.

Velocity
Select this option to sense the relative angular velocity of the follower frame with
respect to the base frame about the joint primitive axis.

Acceleration
Select this option to sense the relative angular acceleration of the follower frame with
respect to the base frame about the joint primitive axis.

Actuator Torque
Select this option to sense the actuation torque acting on the follower frame with
respect to the base frame about the joint primitive axis.

Composite Force/Torque Sensing

Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.
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Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
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• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.

Frame Ports
• B — Base frame
• F — Follower frame

Actuation Ports

The revolute joint primitives provide the following actuation ports:
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• tx, ty, tz — Actuation torques acting on the X, Y, and Z revolute joint primitives
• qx, qy, qz — Desired rotations of the X, Y, and Z revolute joint primitives

Sensing Ports

The revolute joint primitives provide the following sensing ports:

• qx, qy, qz — Angular positions of the X, Y, and Z revolute joint primitives
• wx, wy, wz — Angular velocities of the X, Y, and Z revolute joint primitives
• bx, by, bz — Angular accelerations of the X, Y, and Z revolute joint primitives
• tx, ty, tz — Actuation torques acting on the X, Y, and Z revolute joint primitives

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
Bushing Joint | Revolute Joint | Spherical Joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Rotational Measurements”

Introduced in R2012a
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Graphic
Marker with graphic properties
Library: Body Elements

Description
The Graphic block adds a simple marker to the attached frame. The marker has a simple
geometry, color, and no inertia. You can use this block to highlight a frame of interest in
the Mechanics Explorer visualization pane. The graphic marker has no impact on model
dynamics.

Graphic Marker Geometries

Ports

Frame

R — Reference frame
frame

Local reference frame of the graphic marker. Connect to a frame line or frame port to
define the relative position and orientation of the marker.
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Parameters
Shape — Marker geometry type
Sphere (default) | Cube | Frame

Marker shape to show in the Mechanics Explorer visualization pane.

Size — Absolute size in pixels
10 (default)

Marker size in pixels. Zooming has no impact on the apparent marker size.

Visual Properties — Parameterizations for color and opacity
Simple (default) | Advanced

Parameterization for specifying visual properties. Select Simple to specify color and
opacity. Select Advanced to add specular highlights, ambient shadows, and self-
illumination effects.

Simple: Color — True color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

RGB color vector with red (R), green (G), and blue (B) color amounts specified on a 0–1
scale. A color picker provides an alternative interactive means of specifying a color. If you
change the Visual Properties setting to Advanced, the color specified in this parameter
becomes the Diffuse Color vector.

Simple: Opacity — Surface opacity as scalar number on 0–1 scale
1.0 (default) | scalar with value constrained to 0–1

Graphic opacity specified on a scale of 0–1. An opacity of 0 corresponds to a completely
transparent graphic and an opacity of 1 to a completely opaque graphic.

Advanced: Diffuse Color — True color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

True color under direct white light specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. An optional fourth element specifies the color opacity also on a scale of 0–1.
Omitting the opacity element is equivalent to specifying a value of 1.
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Advanced: Specular Color — Highlight color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of specular highlights specified as an [R,G,B] or [R,G,B,A] vector on a 0–1 scale.
The optional fourth element specifies the color opacity. Omitting the opacity element is
equivalent to specifying a value of 1.

Advanced: Ambient Color — Shadow color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of shadow areas in diffuse ambient light, specified as an [R,G,B] or [R,G,B,A] vector
on a 0–1 scale. The optional fourth element specifies the color opacity. Omitting the
opacity element is equivalent to specifying a value of 1.

Advanced: Emissive Color — Self-illumination color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Surface color due to self illumination, specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. The optional fourth element specifies the color opacity. Omitting the opacity
element is equivalent to specifying a value of 1.

Advanced: Shininess — Highlight sharpness as scalar number on 0–128 scale
75 (default) | scalar with value constrained to 0–128

Sharpness of specular light reflections, specified as a scalar number on a 0–128 scale.
Increase the shininess value for smaller but sharper highlights. Decrease the value for
larger but smoother highlights.

See Also
Inertia | Solid | Spline

Topics
“Visualize Simscape Multibody Frames”
“Manipulate the Color of a Solid”
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Introduced in R2012a
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Gravitational Field
Field of force due to point mass

Library
Forces and Torques

Description
This block represents the gravitational field of a point mass. This field applies a
gravitational force at the center of mass of each rigid body. The force magnitude decays
with the square distance from the field origin, coincident with the base port frame origin.
The force on a rigid body follows from Newton’s universal gravitation law:

F G
Mm

R
g

BF

= -

2
,

where:

• Fg is the force that the gravitational field exerts on a given rigid body.
• G is the universal gravitational constant, 6.67384 × 10-11 m3kg-1s-2.
• M is the total mass generating the gravitational field.
• m is the total mass of the rigid body the gravitational force acts upon.
• RBF is the distance between the source mass position and the rigid body center of

mass.

The figure shows these variables. The plot shows the inverse square dependence between
the gravitational force and distance.
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The source mass can be positive or negative. Combine multiple instances of this block to
model the gravitational effects that positive and negative mass disturbances impose on a
stronger gravitational field, such as a reduction in the gravitational pull of a planet due
to a concentration of low-density material along a portion of its surface.

This block excludes the gravitational forces that other rigid bodies exert on the field
source mass. To include these forces, you can connect Gravitational Field blocks to other
rigid bodies in the model. Alternatively, you can use the Inverse Square Law Force block
to model the gravitational forces between a single pair of rigid bodies.

The gravitational field is time invariant. To specify a time-varying, spatially uniform
field, use the Mechanism Configuration block.

C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.
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Parameters
Mass

Total mass generating the gravitational field. The resulting gravitational forces are
directly proportional to this mass. This mass adds no inertia to the model. The
default value for the mass parameter is 1.0 kg.

Ports
Frame port B represents a frame with origin at the point mass responsible for the
gravitational field.

See Also
Inverse Square Law Force | Mechanism Configuration

Topics
“Model Gravity in a Planetary System”

Introduced in R2014a
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Inertia
Mass element with fixed inertial properties
Library: Body Elements

Description
The Inertia block adds a point or distributed mass with fixed inertial properties to the
attached frame. The type of mass depends on the inertia parameterization selected. A
Point Mass parameterization enables you to model a concentrated mass with no
rotational inertia. A Custom parameterization enables you to model a distributed mass
with the specified moments of inertia, products of inertia, and center of mass. An inertia
icon identifies the inertia location in the Mechanics Explorer visualization pane.

Ports

Frame
R — Reference frame
frame

Local reference frame of the inertia element. Connect to a frame line or frame port to
define the relative position and orientation of the inertia.

Parameters
Type — Inertia parameterization to use
Point Mass (default) | Custom

Inertia parameterization to use. Select Point Mass to represent a mass with no
rotational inertia. Select Custom to represent a distributed mass with rotational inertia.
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Mass — Aggregate mass of the solid
1 kg (default) | scalar with units of mass

Aggregate mass of the solid. The mass can be a positive or negative value. Specify a
negative mass to model the aggregate effect of voids and cavities in a compound body.

Custom: Center of Mass — Center-of-mass coordinates
[0 0 0] m (default) | three-element vector with units of length

[x y z] coordinates of the center of mass relative to the block reference frame. The center
of mass coincides with the center of gravity in uniform gravitational fields only.

Custom: Moments of Inertia — Diagonal elements of inertia tensor
[1 1 1] kg*m^2 (default) | three-element vector with units of mass*length^2

Three-element vector with the [Ixx Iyy Izz] moments of inertia specified relative to a frame
with origin at the center of mass and axes parallel to the block reference frame. The
moments of inertia are the diagonal elements of the inertia tensor
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Custom: Products of Inertia — Off-diagonal elements of inertia tensor
[0 0 0] kg*m^2 (default) | three-element vector with units of mass*length^2

Three-element vector with the [Iyz Izx Ixy] products of inertia specified relative to a frame
with origin at the center of mass and axes parallel to the block reference frame. The
products of inertia are the off-diagonal elements of the inertia tensor
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See Also
General Variable Mass | Graphic | Solid

Topics
“Representing Solid Inertia”
“Specifying Custom Inertias”

Introduced in R2012a
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Inverse Square Law Force
Force proportional to the inverse square distance between two frame origins

Library
Forces and Torques

Description
This block represents a force pair that is inversely proportional to the square distance
between the base and follower frame origins. The two forces in the pair have equal
magnitude but opposite directions. One force acts on the base frame origin, along the
vector connecting the follower to base frame origins. The other force acts on the follower
frame origin, along the vector connecting base to follower frame origins.

The value of the force depends on a force constant that you specify. A positive force
constant represents a repulsive force that pushes the two frame origins apart. A negative
force constant represents an attractive force that pulls the two frame origins together.

C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
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Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters
Force Constant

Specify the proportionality constant of the inverse square law force. This constant is
a lumped parameter that encodes the dependence of the force magnitude on the
inverse square distance between the two frame origins. The default value is 1. Select
or specify a physical unit.

Sense Force
Select the check box to sense the signed magnitude of the inverse square law force
acting between the two frame origins. The block exposes an additional physical signal
port to output the force signal. The output signal is a scalar value. This value is
positive if the force is repulsive; it is negative if the force is attractive.

Ports
The block contains frame ports B and F, representing base and follower frames,
respectively.

Selecting Sense Force in the block dialog box exposes an additional physical signal port,
fm.

See Also
External Force and Torque | Internal Force | Spring and Damper Force

Topics
“Actuating and Sensing with Physical Signals”

Introduced in R2012a
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Lead Screw Joint
Joint with coupled rotational and translational degrees of freedom

Library
Joints

Description
This block represents a joint with one rotational degree of freedom coupled with one
translational degree of freedom. The coupling between the two degrees of freedom
ensures that whenever the joint frames rotate relative to each other, they also translate
by a commensurate amount and vice-versa. The joint lead determines the translation
distance associated with a unit rotation angle while the joint direction determines
whether a positive angle results in a positive or negative translation.

During assembly and simulation, the joint aligns the Z axes of its port frames. The
common Z axis functions as the rotation and translation axis. Whenever the joint frames
rotate, they do so about the common Z axis, and whenever the joint frames translate,
they do so along the common Z axis. You can orient the motion axis in a different
direction by applying rotation transforms to the joint frames through Rigid Transform
blocks.

Joint Degrees of Freedom

A set of optional state targets guide assembly for the joint primitive. Targets include
position and velocity. You can specify these based on the relative rotation or translation
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between the joint frames. A priority level sets the relative importance of the state
targets. If two targets are incompatible, the priority level determines which of the targets
to satisfy.

Each joint primitive has a set of optional sensing ports. These ports provide physical
signal outputs that measure joint primitive motion. Variables that you can sense include
those describing translational motion, rotational motion, and constraint forces and
torques.

Parameters

Lead Screw Primitive
Direction

Handedness of motion between the joint frames. Motion is right-handed if a positive
rotation leads to a positive translation and left-handed if a positive rotation leads to a
negative translation. The default setting is Right-Hand.

Lead
Translation distance between the joint frames due to a unit rotation angle. The
larger the lead, the longer the frames must translate before completing a full
revolution. The default value is 1.0 mm/rev.

Lead Screw Primitive: State Targets
Specify the lead screw primitive state targets and their priority levels. A state target is
the desired value for one of the joint state variables—position or velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be satisfied.

Specify Position Target
Desired joint primitive position at the start of simulation. This is the relative
position, rotational or translational, of the follower frame relative to the base frame.
Selecting this option exposes priority and value fields.

Specify Velocity Target
Desired joint velocity at the start of simulation. This is the relative velocity,
rotational or translational, of the follower frame relative to the base frame. Selecting
this option exposes priority and value fields.
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Priority
Select state target priority. This is the importance level assigned to the state target.
If all state targets cannot be simultaneously satisfied, the priority level determines
which targets to satisfy first and how closely to satisfy them. This option applies to
both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Based On
Motion type that the state target is based on. Options include Rotation and
Translation. The default setting is Translation.

Value
Desired value of the position or velocity state target. The default value is 0.

Lead Screw Primitive: Sensing

Select the variables to sense in the lead screw primitive. Selecting a variable exposes a
physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame.
Variable Description
Rotation: Position Rotation angle of the follower frame

relative to the base frame about the
common Z axis. Selecting the check box
exposes a physical signal port labeled q.

Rotation: Velocity Rotational velocity of the follower frame
relative to the base frame about the
common Z axis. Selecting the check box
exposes a physical signal port labeled w.
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Variable Description
Rotation: Acceleration Rotational acceleration of the follower

frame relative to the base frame about the
common Z axis. Selecting the check box
exposes a physical signal port labeled b.

Translation: Position Offset distance of the follower frame
relative to the base frame along the
common Z axis. Selecting the check box
exposes a physical signal port labeled p.

Translation: Velocity Translational velocity of the follower frame
relative to the base frame along the
common Z axis. Selecting the check box
exposes a physical signal port labeled v.

Translation: Acceleration Translational acceleration of the follower
frame relative to the base frame along the
common Z axis. Selecting the check box
exposes a physical signal port labeled a.

Composite Force/Torque Sensing
Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.
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Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.
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The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for sensing
dynamical variables such as forces, torques, and motion. You expose an optional port by
selecting the sensing check box corresponding to that port.

Frame Ports
• B — Base frame
• F — Follower frame

Sensing Ports

The lead screw joint primitive provides the following sensing ports:

• q — Angular position
• w — Angular velocity
• b — Angular acceleration
• p — Linear position
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• v — Linear velocity
• a — Linear acceleration

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
Prismatic Joint | Revolute Joint

Introduced in R2015a
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Mechanism Configuration
Mechanism-wide simulation and mechanical parameters

Library
Utilities

Description
This block provides mechanical and simulation parameters to a mechanism, i.e., a self-
contained group of interconnected Simscape Multibody blocks. Parameters include
gravity and a linearization delta for computing numerical partial derivatives during
linearization. These parameters apply only to the target mechanism, i.e., the mechanism
that the block connects to.

The Mechanism Configuration block is optional. If you omit it, the gravitational
acceleration vector is set to zero. Use only one instance of this block per mechanism,
setting uniform gravity to None if that mechanism contains one or more Gravitational
Field blocks.

C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
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time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters
Uniform Gravity

Type of gravitational acceleration vector in effect at the target mechanism. Options
include:

• None — Specify zero gravity. The block automatically applies the gravitational
acceleration vector [0 0 0] to the target mechanism. If the mechanism contains
one or more Gravitational Field blocks, you must select this option.

• Constant — Specify a gravitational acceleration vector that remains constant in
space and in time. Selecting this option exposes an additional parameter,
Gravity. If the target mechanism contains one or more Gravitational Field
blocks, you must select None instead.

• Time-Varying — Specify a gravitational acceleration vector that remains
constant in space but varies in time. Selecting this option exposes a physical
signal port. Use that port to specify the time-varying gravitational acceleration
vector. If the target mechanism contains one or more Gravitational Field blocks,
you must select None instead.

Gravity
Nominal acceleration vector due to gravity. The block resolves this vector in the
mechanism World frame. The default vector is [0 0 –9.80665] m/s^2.

Linearization Delta
Perturbation value for computing numerical partial derivatives during linearization.
The default value is 0.001.
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Ports
Port Description
C Frame port that identifies the target

mechanism to which the block parameters
apply.

g Physical signal port through which you
specify a time-varying gravity vector.

See Also
Gravitational Field

Introduced in R2012a
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Pin Slot Joint
Joint with one prismatic and one revolute primitives possessing mutually orthogonal
motion axes

Library
Joints

Description
This block represents a joint with one translational and one rotational degrees of
freedom. One prismatic primitive provides the translational degree of freedom. One
revolute primitive provides the rotational degree of freedom. Prismatic and revolute axes
are mutually orthogonal.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates or rotates the follower frame with respect to the
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joint primitive base frame. For all but the first joint primitive, the base frame coincides
with the follower frame of the previous joint primitive in the sequence.

At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Translation:

• Along the X axis of the X Prismatic Primitive (Px) base frame.
2 Rotation:

• About the Z axis of the Z Revolute Primitive (Rz) base frame. This frame is
coincident with the X Prismatic Primitive (Px) follower frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation.

Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.
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C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters

Prismatic Primitive: State Targets

Specify the prismatic primitive state targets and their priority levels. A state target is
the desired value for one of the joint state parameters—position and velocity. The
priority level is the relative importance of a state target. It determines how precisely the
target must be met. Use the Model Report tool in Mechanics Explorer to check the
assembly status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative position, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. The specified target is resolved in the
base frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative velocity, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. It is resolved in the base frame.
Selecting this option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
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determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is m for position and m/s for velocity.

Prismatic Primitive: Internal Mechanics

Specify the prismatic primitive internal mechanics. Internal mechanics include linear
spring forces, accounting for energy storage, and damping forces, accounting for energy
dissipation. You can ignore internal mechanics by keeping spring stiffness and damping
coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the distance between base and follower
frame origins at which the spring force is zero. The default value is 0. Select or enter
a physical unit. The default is m.

Spring Stiffness
Enter the linear spring constant. This is the force required to displace the joint
primitive by a unit distance. The default is 0. Select or enter a physical unit. The
default is N/m.

Damping Coefficient
Enter the linear damping coefficient. This is the force required to maintain a
constant joint primitive velocity between base and follower frames. The default is 0.
Select or enter a physical unit. The default is N/(m/s).
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Prismatic Primitive: Actuation

Specify actuation options for the prismatic joint primitive. Actuation modes include
Force and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Actuation signals are resolved in the base frame.

Force
Select an actuation force setting. The default setting is None.
Actuation Force Setting Description
None No actuation force.
Provided by Input Actuation force from physical signal

input. The signal provides the force
acting on the follower frame with respect
to the base frame along the joint
primitive axis. An equal and opposite
force acts on the base frame.

Automatically computed Actuation force from automatic
calculation. Simscape Multibody
computes and applies the actuation force
based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.
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Prismatic Primitive: Sensing

Select the variables to sense in the prismatic joint primitive. Selecting a variable exposes
a physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative position of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Velocity
Select this option to sense the relative velocity of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Acceleration
Select this option to sense the relative acceleration of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Actuator Force
Select this option to sense the actuation force acting on the follower frame with
respect to the base frame along the joint primitive axis.

Revolute Primitive: State Targets

Specify the revolute primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation angle, measured about the joint primitive axis, of the follower
frame with respect to the base frame. The specified target is resolved in the base
frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity, measured about the joint primitive axis, of the follower
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frame with respect to the base frame. It is resolved in the base frame. Selecting this
option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is deg for position and deg/s for velocity.

Revolute Primitive: Internal Mechanics

Specify the revolute primitive internal mechanics. Internal mechanics include linear
spring torques, accounting for energy storage, and linear damping torques, accounting
for energy dissipation. You can ignore internal mechanics by keeping spring stiffness and
damping coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the rotation angle between base and
follower frames at which the spring torque is zero. The default value is 0. Select or
enter a physical unit. The default is deg.

Spring Stiffness
Enter the linear spring constant. This is the torque required to rotate the joint
primitive by a unit angle. The default is 0. Select or enter a physical unit. The
default is N*m/deg.
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Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select or enter a physical unit. The default is N*m/(deg/s).

Revolute Primitive: Actuation

Specify actuation options for the revolute joint primitive. Actuation modes include
Torque and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Input signals are resolved in the base frame.

Torque
Select an actuation torque setting. The default setting is None.
Actuation Torque Setting Description
None No actuation torque.
Provided by Input Actuation torque from physical signal

input. The signal provides the torque
acting on the follower frame with respect
to the base frame about the joint
primitive axis. An equal and opposite
torque acts on the base frame.

Automatically computed Actuation torque from automatic
calculation. Simscape Multibody
computes and applies the actuation
torque based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.
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Actuation Motion Setting Description
Automatically computed Joint primitive motion from automatic

calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Revolute Primitive: Sensing
Select the variables to sense in the revolute joint primitive. Selecting a variable exposes a
physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative rotation angle of the follower frame with
respect to the base frame about the joint primitive axis.

Velocity
Select this option to sense the relative angular velocity of the follower frame with
respect to the base frame about the joint primitive axis.

Acceleration
Select this option to sense the relative angular acceleration of the follower frame with
respect to the base frame about the joint primitive axis.

Actuator Torque
Select this option to sense the actuation torque acting on the follower frame with
respect to the base frame about the joint primitive axis.

Composite Force/Torque Sensing
Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.
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Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
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joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.
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Frame Ports
• B — Base frame
• F — Follower frame

Actuation Ports

The prismatic joint primitive provides the following actuation ports:

• fx — Actuation force acting on the X prismatic joint primitive
• px — Desired trajectory of the X prismatic joint primitive

The revolute joint primitive provides the following actuation ports:

• tz — Actuation torque acting on the Z revolute joint primitive
• qz — Desired rotation of the Z revolute joint primitive

Sensing Ports

The prismatic joint primitive provides the following sensing ports:

• px — Position of the X prismatic joint primitive
• vx — Velocity of the X prismatic joint primitive
• ax — Acceleration of the X prismatic joint primitive
• fx — Actuation force acting on the X prismatic joint primitive

The revolute joint primitive provides the following sensing ports:

• qz — Angular position of the Z revolute joint primitive
• wz — Angular velocity of the Z revolute joint primitive
• bz — Angular acceleration of the Z revolute joint primitive
• tz — Actuation torque acting on the Z revolute joint primitive

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
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• ft — Total force
• tt — Total torque

See Also
Cylindrical Joint | Prismatic Joint | Revolute joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Rotational Measurements”
“Translational Measurements”

Introduced in R2013a
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Planar Joint
Joint with one revolute and two prismatic primitives

Library
Joints

Description
This block represents a joint with one rotational and two translational degrees of
freedom. Two prismatic primitives provide the two translational degrees of freedom. One
revolute primitive provides the rotational degree of freedom.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates or rotates the follower frame with respect to the
joint primitive base frame. For all but the first joint primitive, the base frame coincides
with the follower frame of the previous joint primitive in the sequence.
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At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Translation:

a Along the X axis of the X Prismatic Primitive (Px) base frame.
b Along the Y axis of the Y Prismatic Primitive (Py) base frame. This frame is

coincident with the X Prismatic Primitive (Px) follower frame.
2 Rotation:

• About the Z axis of the Z Revolute Primitive (Rz) base frame. This frame is
coincident with the Y Prismatic Primitive (Py) follower frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation.

Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.
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C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters

Prismatic Primitive: State Targets

Specify the prismatic primitive state targets and their priority levels. A state target is
the desired value for one of the joint state parameters—position and velocity. The
priority level is the relative importance of a state target. It determines how precisely the
target must be met. Use the Model Report tool in Mechanics Explorer to check the
assembly status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative position, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. The specified target is resolved in the
base frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative velocity, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. It is resolved in the base frame.
Selecting this option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
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determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is m for position and m/s for velocity.

Prismatic Primitive: Internal Mechanics

Specify the prismatic primitive internal mechanics. Internal mechanics include linear
spring forces, accounting for energy storage, and damping forces, accounting for energy
dissipation. You can ignore internal mechanics by keeping spring stiffness and damping
coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the distance between base and follower
frame origins at which the spring force is zero. The default value is 0. Select or enter
a physical unit. The default is m.

Spring Stiffness
Enter the linear spring constant. This is the force required to displace the joint
primitive by a unit distance. The default is 0. Select or enter a physical unit. The
default is N/m.

Damping Coefficient
Enter the linear damping coefficient. This is the force required to maintain a
constant joint primitive velocity between base and follower frames. The default is 0.
Select or enter a physical unit. The default is N/(m/s).
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Prismatic Primitive: Actuation

Specify actuation options for the prismatic joint primitive. Actuation modes include
Force and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Actuation signals are resolved in the base frame.

Force
Select an actuation force setting. The default setting is None.
Actuation Force Setting Description
None No actuation force.
Provided by Input Actuation force from physical signal

input. The signal provides the force
acting on the follower frame with respect
to the base frame along the joint
primitive axis. An equal and opposite
force acts on the base frame.

Automatically computed Actuation force from automatic
calculation. Simscape Multibody
computes and applies the actuation force
based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.
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Prismatic Primitive: Sensing

Select the variables to sense in the prismatic joint primitive. Selecting a variable exposes
a physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative position of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Velocity
Select this option to sense the relative velocity of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Acceleration
Select this option to sense the relative acceleration of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Actuator Force
Select this option to sense the actuation force acting on the follower frame with
respect to the base frame along the joint primitive axis.

Revolute Primitive: State Targets

Specify the revolute primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation angle, measured about the joint primitive axis, of the follower
frame with respect to the base frame. The specified target is resolved in the base
frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity, measured about the joint primitive axis, of the follower
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frame with respect to the base frame. It is resolved in the base frame. Selecting this
option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is deg for position and deg/s for velocity.

Revolute Primitive: Internal Mechanics

Specify the revolute primitive internal mechanics. Internal mechanics include linear
spring torques, accounting for energy storage, and linear damping torques, accounting
for energy dissipation. You can ignore internal mechanics by keeping spring stiffness and
damping coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the rotation angle between base and
follower frames at which the spring torque is zero. The default value is 0. Select or
enter a physical unit. The default is deg.

Spring Stiffness
Enter the linear spring constant. This is the torque required to rotate the joint
primitive by a unit angle. The default is 0. Select or enter a physical unit. The
default is N*m/deg.
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Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select or enter a physical unit. The default is N*m/(deg/s).

Revolute Primitive: Actuation

Specify actuation options for the revolute joint primitive. Actuation modes include
Torque and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Input signals are resolved in the base frame.

Torque
Select an actuation torque setting. The default setting is None.
Actuation Torque Setting Description
None No actuation torque.
Provided by Input Actuation torque from physical signal

input. The signal provides the torque
acting on the follower frame with respect
to the base frame about the joint
primitive axis. An equal and opposite
torque acts on the base frame.

Automatically computed Actuation torque from automatic
calculation. Simscape Multibody
computes and applies the actuation
torque based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.
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Actuation Motion Setting Description
Automatically computed Joint primitive motion from automatic

calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Revolute Primitive: Sensing
Select the variables to sense in the revolute joint primitive. Selecting a variable exposes a
physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative rotation angle of the follower frame with
respect to the base frame about the joint primitive axis.

Velocity
Select this option to sense the relative angular velocity of the follower frame with
respect to the base frame about the joint primitive axis.

Acceleration
Select this option to sense the relative angular acceleration of the follower frame with
respect to the base frame about the joint primitive axis.

Actuator Torque
Select this option to sense the actuation torque acting on the follower frame with
respect to the base frame about the joint primitive axis.

Composite Force/Torque Sensing
Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.
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Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
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joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.
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Frame Ports
• B — Base frame

• F — Follower frame

Actuation Ports

The prismatic joint primitives provide the following actuation ports:

• fx, fy — Actuation forces acting on the X and Y prismatic joint primitives
• px, py — Desired trajectories of the X and Y prismatic joint primitives

The revolute joint primitive provides the following actuation ports:

• tz — Actuation torque acting on the Z revolute joint primitive
• qz — Desired rotation of the Z revolute joint primitive

Sensing Ports

The prismatic joint primitives provide the following sensing ports:

• px, py — Positions of the X and Y prismatic joint primitives
• vx, vy — Velocities of the X and Y prismatic joint primitives
• ax, ay — Accelerations of the X and Y prismatic joint primitives
• fx, fy — Actuator forces acting on the X and Y prismatic joint primitives

The revolute joint primitive provides the following sensing ports:

• qz — Angular position of the Z revolute joint primitive
• wz — Angular velocity of the Z revolute joint primitive
• bz — Angular acceleration of the Z revolute joint primitive
• tz — Actuation torque acting on the Z revolute joint primitive

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
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• ft — Total force
• tt — Total torque

See Also
Prismatic Joint | Rectangular Joint | Revolute Joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Rotational Measurements”
“Translational Measurements”

Introduced in R2012a
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Point On Curve Constraint
Kinematic constraint between a frame origin and a curved path

Library
Constraints

Description
This block represents a kinematic constraint between a point and a curve. The constraint
allows the follower frame origin to translate only along the curve connected to the base
geometry port. The follower frame is free to rotate depending on other constraints in the
model. Use this block to model point-on-curve constraints, such as that between a roller
coaster and a track or a cam follower and a cam.

Examples of Point-on-Curve Constraints

Specify the constraint curve by connecting a curve block to the base geometry port. As a
best practice, always use the curve block as part of a rigid body, for example, by keeping
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it inside a rigid body subsystem. This enables you to quickly switch, for example,
between different cams or roller coaster tracks. Avoid curves with sharp changes in slope,
as these can cause simulation issues.

Parameters

Constraint Force Sensing
Direction

Select the force in the constraint action-reaction force pair to sense. You can sense
the force that the follower frame exerts on the base curve or vice-versa. The default
setting is Follower on Base.

Resolution Frame
Select the frame to resolve the constraint force measurement in. You can select the
base or follower frame. The default setting is Base.

Force Vector
Select the check box to sense the constraint force. The block exposes physical signal
output port f, which outputs the force measurement as a three-dimensional vector,
[Fx, Fy, Fz].

Ports
The block contains two ports:

• B — Base geometry port representing the constraint curve
• F — Follower frame port representing the constrained point

An optional port appears when you select constraint force sensing:

• f — Physical signal with the constraint force components [Fx, Fy, Fz]

See Also
Angle Constraint | Bevel Gear Constraint | Common Gear Constraint | Distance
Constraint | Rack and Pinion Constraint | Spline
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Topics
sm_cam_flapping_wing

Introduced in R2015b
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Prismatic Joint
Joint with one prismatic primitive

Library
Joints

Description
This block represents a joint with one translational degree of freedom. One prismatic
primitive provides the translational degree of freedom. The base and follower frames
remain parallel during simulation.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a single time-
varying transformation. The Z prismatic primitive (Pz) applies this transformation,
which causes the follower frame to translate with respect to the base frame along the
common Z axis.
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Joint Transformation

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.

C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.
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Parameters

Prismatic Primitive: State Targets
Specify the prismatic primitive state targets and their priority levels. A state target is
the desired value for one of the joint state parameters—position and velocity. The
priority level is the relative importance of a state target. It determines how precisely the
target must be met. Use the Model Report tool in Mechanics Explorer to check the
assembly status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative position, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. The specified target is resolved in the
base frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative velocity, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. It is resolved in the base frame.
Selecting this option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is m for position and m/s for velocity.
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Prismatic Primitive: Internal Mechanics

Specify the prismatic primitive internal mechanics. Internal mechanics include linear
spring forces, accounting for energy storage, and damping forces, accounting for energy
dissipation. You can ignore internal mechanics by keeping spring stiffness and damping
coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the distance between base and follower
frame origins at which the spring force is zero. The default value is 0. Select or enter
a physical unit. The default is m.

Spring Stiffness
Enter the linear spring constant. This is the force required to displace the joint
primitive by a unit distance. The default is 0. Select or enter a physical unit. The
default is N/m.

Damping Coefficient
Enter the linear damping coefficient. This is the force required to maintain a
constant joint primitive velocity between base and follower frames. The default is 0.
Select or enter a physical unit. The default is N/(m/s).

Prismatic Primitive: Actuation

Specify actuation options for the prismatic joint primitive. Actuation modes include
Force and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Actuation signals are resolved in the base frame.

Force
Select an actuation force setting. The default setting is None.
Actuation Force Setting Description
None No actuation force.
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Actuation Force Setting Description
Provided by Input Actuation force from physical signal

input. The signal provides the force
acting on the follower frame with respect
to the base frame along the joint
primitive axis. An equal and opposite
force acts on the base frame.

Automatically computed Actuation force from automatic
calculation. Simscape Multibody
computes and applies the actuation force
based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Prismatic Primitive: Sensing

Select the variables to sense in the prismatic joint primitive. Selecting a variable exposes
a physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative position of the follower frame origin with
respect to the base frame origin along the joint primitive axis.
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Velocity
Select this option to sense the relative velocity of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Acceleration
Select this option to sense the relative acceleration of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Actuator Force
Select this option to sense the actuation force acting on the follower frame with
respect to the base frame along the joint primitive axis.

Composite Force/Torque Sensing

Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.
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Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.
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Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.

Frame Ports

• B — Base frame
• F — Follower frame

Actuation Ports

The prismatic joint primitive provides the following actuation ports:

• f — Actuation force acting on the Z prismatic joint primitive
• p — Desired trajectory of the Z prismatic joint primitive

Sensing Ports

The prismatic joint primitive provides the following sensing ports:
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• p — Position of the Z prismatic joint primitive
• v — Velocity of the Z prismatic joint primitive
• a — Acceleration of the Z prismatic joint primitive
• f — Actuation force acting on the Z prismatic joint primitive

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
Revolute Joint | Spherical Joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Translational Measurements”

Introduced in R2012a
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Rack and Pinion Constraint
Kinematic constraint between a translating rack body and a rotating pinion body
Library: Gears and Couplings / Gears

Description
The Rack and Pinion Constraint block represents a kinematic constraint between a
translating rack body and a rotating pinion body. The base frame port identifies the
connection frame on the pinion body and the follower frame port identifies the connection
frame on the rack body. The pinion rotation axis and the rack translation axis coincide
with the frame z-axes.

The block represents only the kinematic constraint characteristic to a rack-and-pinion
system. Gear inertia and geometry are solid properties that you must specify using Solid
blocks. The gear constraint model is ideal. Backlash and gear losses due to Coulomb and
viscous friction between teeth are ignored. You can, however, model viscous friction at
joints by specifying damping coefficients in the joint blocks.

Gear Geometry
The rack-and-pinion constraint is parameterized in terms of the dimensions of the pinion
pitch circle. The pitch circle is an imaginary circle concentric with the pinion body and
tangent to the tooth contact point. The pitch radius, labeled RB in the figure, is the radius
that the pinion would have if it was reduced to a friction cylinder in contact with a brick
approximation of the rack.
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Gear Assembly

Gear constraints occur in closed kinematic loops. The figure shows the closed-loop
topology of a simple rack-and-pinion model. Joint blocks connect the rack and pinion
bodies to a common fixture or carrier, defining the maximum degrees of freedom between
them. A Rack and Pinion Constraint block connects the rack and pinion bodies,
eliminating one degree of freedom and effectively coupling the rack and pinion motions.
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Assembly Requirements

The block imposes special restrictions on the relative positions and orientations of the
gear connection frames. The restrictions ensure that the gears assemble only at distances
and angles suitable for meshing. The block enforces the restrictions during model
assembly, when it first attempts to place the gears in mesh, but relies on the remainder
of the model to keep the gears in mesh during simulation.
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Position Restrictions

• The distance between the base and follower frame origins along the follower frame y-
axis must equal the pinion radius. This constraint ensures that the pitch point of the
rack is at the proper distance from the rotation axis of the pinion.

• The follower frame origin must lie on the xy plane of the base frame. This constraint
ensures that the pitch point of the rack is coplanar with the pitch circle of the pinion.

Orientation Restrictions

• The x-axis of the follower frame must be perpendicular to the xy plane of the base
frame. This constraint ensures that the rack and pinion are coplanar, and therefore
that their motion axes are perpendicular to each other.

C/C++ Code Generation
This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Ports

Frame
B — Base frame
frame

Connection frame on the pinion body.

F — Follower frame
frame
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Connection frame on the rack body.

Parameters
Pinion Radius — Radius of the pitch circle of the pinion body
10 cm (default) | positive scalar in units of length

Radius of the pitch circle of the pinion body. The pitch circle is an imaginary circle
concentric with the pinion body and tangent to the tooth contact point.

See Also
Bevel Gear Constraint | Common Gear Constraint | Worm and Gear Constraint

Topics
“Rack and Pinion”

Introduced in R2013a
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Rectangular Joint
Joint with two prismatic primitives

Library
Joints

Description
This block represents a joint with two translational degrees of freedom. Two prismatic
primitives provide the two translational degrees of freedom. The base and follower
frames remain parallel during simulation.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates or rotates the follower frame with respect to the
joint primitive base frame. For all but the first joint primitive, the base frame coincides
with the follower frame of the previous joint primitive in the sequence.
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At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Translation:

a Along the X axis of the X Prismatic Primitive (Px) base frame.
b Along the Y axis of the Y Prismatic Primitive (Py) base frame. This frame is

coincident with the X Prismatic Primitive (Px) follower frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation.

Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.

C/C++ Code Generation
This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
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on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.

Parameters

Prismatic Primitive: State Targets

Specify the prismatic primitive state targets and their priority levels. A state target is
the desired value for one of the joint state parameters—position and velocity. The
priority level is the relative importance of a state target. It determines how precisely the
target must be met. Use the Model Report tool in Mechanics Explorer to check the
assembly status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative position, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. The specified target is resolved in the
base frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative velocity, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. It is resolved in the base frame.
Selecting this option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
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Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is m for position and m/s for velocity.

Prismatic Primitive: Internal Mechanics
Specify the prismatic primitive internal mechanics. Internal mechanics include linear
spring forces, accounting for energy storage, and damping forces, accounting for energy
dissipation. You can ignore internal mechanics by keeping spring stiffness and damping
coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the distance between base and follower
frame origins at which the spring force is zero. The default value is 0. Select or enter
a physical unit. The default is m.

Spring Stiffness
Enter the linear spring constant. This is the force required to displace the joint
primitive by a unit distance. The default is 0. Select or enter a physical unit. The
default is N/m.

Damping Coefficient
Enter the linear damping coefficient. This is the force required to maintain a
constant joint primitive velocity between base and follower frames. The default is 0.
Select or enter a physical unit. The default is N/(m/s).

Prismatic Primitive: Actuation
Specify actuation options for the prismatic joint primitive. Actuation modes include
Force and Motion. Selecting Provided by Input from the drop-down list for an
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actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Actuation signals are resolved in the base frame.

Force
Select an actuation force setting. The default setting is None.
Actuation Force Setting Description
None No actuation force.
Provided by Input Actuation force from physical signal

input. The signal provides the force
acting on the follower frame with respect
to the base frame along the joint
primitive axis. An equal and opposite
force acts on the base frame.

Automatically computed Actuation force from automatic
calculation. Simscape Multibody
computes and applies the actuation force
based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Prismatic Primitive: Sensing

Select the variables to sense in the prismatic joint primitive. Selecting a variable exposes
a physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
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in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative position of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Velocity
Select this option to sense the relative velocity of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Acceleration
Select this option to sense the relative acceleration of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Actuator Force
Select this option to sense the actuation force acting on the follower frame with
respect to the base frame along the joint primitive axis.

Composite Force/Torque Sensing

Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.
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Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.
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The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.

Frame Ports

• B — Base frame
• F — Follower frame

Actuation Ports

The prismatic joint primitives provide the following actuation ports:

• fx, fy — Actuation forces acting on the X and Y prismatic joint primitives
• px, py — Desired trajectories of the X and Y prismatic joint primitives
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Sensing Ports

The prismatic joint primitives provide the following sensing ports:

• px, py — Positions of the X and Y prismatic joint primitives
• vx, vy — Velocities of the X and Y prismatic joint primitives
• ax, ay — Accelerations of the X and Y prismatic joint primitives
• fx, fy — Actuation forces acting on the X and Y prismatic joint primitives

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
Planar Joint | Prismatic Joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Translational Measurements”

Introduced in R2012a
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Reference Frame
Non-inertial reference frame
Library: Frames and Transforms

Description
This block represents a reference frame with respect to which you can define other
frames. The reference frame is generally non-inertial. It can accelerate with respect to
the World frame. This block is optional in a model.

Ports

Frame

R — Reference frame
frame

Local reference frame represented by the block. Connect to a frame line or frame port to
define the relative position and orientation of the reference frame.

See Also
Rigid Transform | World Frame

Topics
“Working with Frames”
“Creating Connection Frames”
“Visualize Simscape Multibody Frames”
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Introduced in R2012a
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Revolute Joint
Joint with one revolute primitive

Library
Joints

Description
This block represents a joint with one rotational degree of freedom. One revolute
primitive provides the rotational degree of freedom. The base and follower frame origins
remain coincident during simulation.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a single time-
varying transformation. The Z revolute primitive (Pz) applies this transformation, which
causes the follower frame to rotate with respect to the base frame about the common Z
axis.
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Joint Transformation

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.

C/C++ Code Generation

This block supports code generation for real-time simulation tasks. Certain blocks and
block settings may be more suitable for simulation on a real-time device. For suggestions
on how to improve real-time simulation performance, use the Simulink Performance
Advisor (Simulink). Suggestions include ways to reduce model complexity where helpful
and to decrease numerical stiffness.

Select Analysis > Performance Tools > Performance Advisor in the Simulink menu
bar to open the Performance Advisor. Set the Activity parameter to Execute real-
time application to view suggestions specific to real-time simulation performance.
Expand the Real-Time node in the tree view pane to select performance checks specific
to Simscape products.
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Parameters

Revolute Primitive: State Targets
Specify the revolute primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation angle, measured about the joint primitive axis, of the follower
frame with respect to the base frame. The specified target is resolved in the base
frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity, measured about the joint primitive axis, of the follower
frame with respect to the base frame. It is resolved in the base frame. Selecting this
option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is deg for position and deg/s for velocity.
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Revolute Primitive: Internal Mechanics

Specify the revolute primitive internal mechanics. Internal mechanics include linear
spring torques, accounting for energy storage, and linear damping torques, accounting
for energy dissipation. You can ignore internal mechanics by keeping spring stiffness and
damping coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the rotation angle between base and
follower frames at which the spring torque is zero. The default value is 0. Select or
enter a physical unit. The default is deg.

Spring Stiffness
Enter the linear spring constant. This is the torque required to rotate the joint
primitive by a unit angle. The default is 0. Select or enter a physical unit. The
default is N*m/deg.

Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select or enter a physical unit. The default is N*m/(deg/s).

Revolute Primitive: Actuation

Specify actuation options for the revolute joint primitive. Actuation modes include
Torque and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Input signals are resolved in the base frame.

Torque
Select an actuation torque setting. The default setting is None.
Actuation Torque Setting Description
None No actuation torque.
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Actuation Torque Setting Description
Provided by Input Actuation torque from physical signal

input. The signal provides the torque
acting on the follower frame with respect
to the base frame about the joint
primitive axis. An equal and opposite
torque acts on the base frame.

Automatically computed Actuation torque from automatic
calculation. Simscape Multibody
computes and applies the actuation
torque based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Revolute Primitive: Sensing

Select the variables to sense in the revolute joint primitive. Selecting a variable exposes a
physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative rotation angle of the follower frame with
respect to the base frame about the joint primitive axis.
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Velocity
Select this option to sense the relative angular velocity of the follower frame with
respect to the base frame about the joint primitive axis.

Acceleration
Select this option to sense the relative angular acceleration of the follower frame with
respect to the base frame about the joint primitive axis.

Actuator Torque
Select this option to sense the actuation torque acting on the follower frame with
respect to the base frame about the joint primitive axis.

Composite Force/Torque Sensing

Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.
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Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.
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Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.

Frame Ports

• B — Base frame
• F — Follower frame

Actuation Ports

The revolute joint primitive provides the following actuation ports:

• t — Actuation torque acting on the Z revolute joint primitive
• q — Desired rotation of the Z revolute joint primitive

Sensing Ports

The revolute joint primitive provides the following sensing ports:
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• q — Angular position of the Z revolute joint primitive
• w — Angular velocity of the Z revolute joint primitive
• b — Angular acceleration of the Z revolute joint primitive
• t — Actuation torque acting on the Z revolute joint primitive

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
Prismatic Joint | Spherical Joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Rotational Measurements”

Introduced in R2012a
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Rigid Transform
Fixed spatial relationship between frames
Library: Frames and Transforms

Description
This block applies a time-invariant transformation between two frames. The
transformation rotates and translates the follower port frame (F) with respect to the base
port frame (B). Connecting the frame ports in reverse causes the transformation itself to
reverse. The frames remain fixed with respect to each other during simulation, moving
only as a single unit. Combine Rigid Transform and Solid blocks to model compound rigid
bodies.

Ports

Frame

B — Base frame
frame

Frame with respect to which you specify the transforms.

F — Follower frame
frame

Frame to which you apply the transforms.
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Parameters
Rotation: Method — Method for specifying the rotation transform
None (default) | Aligned Axes | Standard Axis | Arbitrary Axis | Rotation Sequence |
Rotation Matrix

Method to use to specify the rotation transform between the base and follower frames.
The table summarizes the available options.
Method Description
None Constrain the base and follower frames to

share the same orientation.
Aligned Axes Set frame rotation by aligning two follower

frame axes with two base frame axes.
Standard Axis Specify frame rotation as an angle about a

standard axis (x, y, or z).
Arbitrary Axis Specify frame rotation as an angle about a

general [x, y, z] axis.
Rotation Sequence Specify frame rotation as a sequence of

three elementary rotations.
Rotation Matrix Specify frame rotation as a right-handed

orthogonal rotation matrix.

Aligned Axes
Select two pairs of base-follower frame axes.
Parameter Description
Pair 1 First pair of base-follower frame axes to

align.
Pair 2 Second pair of base-follower frame axes

to align. Axis choices depend on Pair 1
axis selections.

Standard Axis
Select a standard rotation axis, resolved in the base frame, and specify the follower
frame rotation angle.
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Parameter Description
Axis Standard rotation axis (X, Y, or Z)

resolved in the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Arbitrary Axis
Select a general 3-D rotation axis, resolved in the base frame, and specify the
follower frame rotation angle.
Parameter Description
Axis General rotation axis [X Y Z] resolved in

the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Rotation Sequence
Specify a sequence of three elementary rotations about the selected permutation of x,
y, and z axes. These rotation sequences are also known as Euler and Tait-Bryan
sequences. The rotations are those of the follower frame relative to the frame selected
in the Rotate About parameter.

If you set the Rotate About parameter to Follower Frame, the follower frame
rotates about its own axes. These axes change orientation with each successive
rotation. If you set the Rotate About parameter to Base Frame, the follower frame
rotates about the fixed base frame axes.
Parameter Description
Rotation About Frame whose axes to rotate the follower

frame about.
Sequence Sequence of axes about which to apply

the elementary rotations.
Angles Three-element vector with elementary

rotation angles about the axes specified
in the Sequence parameter.
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Rotation Matrix
Specify the 3×3 transformation matrix of a proper rotation between the base and
follower frames. The matrix must be orthogonal and have determinant +1. The
default matrix is [1 0 0; 0 1 0; 0 0 1].

Translation: Method — Method for specifying the translation transform
None (default) | Cartesian | Standard Axis | Cylindrical

Method to use to specify the translation transform between the base and follower frames.
The table summarizes the available options.
Method Description
None Make base and follower frames coincident.

This method requires no parameters.
Cartesian Specify a 3-D translation in terms of

Cartesian coordinates
Standard Axis Specify a 1-D translation along the X, Y, or

Z axis
Cylindrical Specify a 3-D translation in terms of

cylindrical coordinates

Cartesian Axis
Specify the Offset of the follower frame with respect to the base frame. This is the 3-
D translation vector that brings the base frame into coincidence with the follower
frame. Select or enter a physical unit.

Standard Axis
Specify the offset of the follower frame with respect to the base frame along the base
frame X, Y, or Z axis. Select or enter a physical unit.
Parameter Description
Axis Axis the follower frame translates along
Offset Translation of the follower frame with

respect to the base frame along the
specified axis

Cylindrical
Specify in cylindrical coordinates the translation that brings the base frame into
coincidence with the follower frame. Select or enter a physical unit.
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Parameter Description
Radius Distance between the origin of the

follower frame and the Z axis of the base
frame. This is the cylindrical radius
coordinate.

Theta Rotation angle of the line connecting base
and follower frame origins with respect to
the base frame X axis. This is the
cylindrical azimuth coordinate.

Z Offset Distance between base and follower
frame origins along the base frame Z
axis. This is the cylindrical length
coordinate.

See Also
Reference Frame | Transform Sensor | Variable Brick Solid | World Frame

Topics
“Working with Frames”
“Creating Connection Frames”
“Visualize Simscape Multibody Frames”

Introduced in R2012a
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Solid
Solid element with geometry, inertia, and color
Library: Body Elements

Description
The Solid block adds to the attached frame a solid element with geometry, inertia, and
color. The solid element can be a simple rigid body or part of a compound rigid body—a
group of rigidly connected solids, often separated in space through rigid transformations.
Combine Solid and Rigid Transform blocks to model a compound rigid body.

Geometry parameters include shape and size. You can choose from a list of preset shapes
or import a custom shape from an external file in STL or STEP format. By default, for all
but STL-derived shapes, the block automatically computes the mass properties of the
solid from the specified geometry and either mass or mass density. You can change this
setting in the Inertia > Type block parameter.

A reference frame encodes the position and orientation of the solid. In the default
configuration, the block provides only the reference frame. A frame-creation interface
provides the means to define additional frames based on solid geometry features. You
access this interface by selecting the Create button  in the Frames expandable area.

Derived Properties

You can view the calculated values of the solid mass properties directly in the block
dialog box. Setting the Inertia > Type parameter to Calculate from Geometry
causes the block to expose a new node, Derived Values. Click the Update button
provided under this node to calculate the mass properties and display their values in the
fields below the button.
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Derived Values Display

Visualization Pane

The block dialog box contains a collapsible visualization pane. This pane provides instant
visual feedback on the solid you are modeling. Use it to find and fix any issues with the
shape and color of the solid. You can examine the solid from different perspectives by
selecting a standard view or by rotating, panning, and zooming the solid.

Select the Update Visualization button  to view the latest changes to the solid
geometry in the visualization pane. Select Apply or OK to commit your changes to the
solid. Closing the block dialog box without first selecting Apply or OK causes the block
to discard those changes.
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Solid Visualization Pane

Right-click the visualization pane to access the visualization context-sensitive menu.
This menu provides additional options so that you can change the background color, split
the visualization pane into multiple tiles, and modify the view convention from the
default +Z up (XY Top) setting.
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Ports

Frame

R — Reference frame
frame

Local reference frame of the solid. This frame is fixed with respect to the solid geometry.
For the frame placement relative to a specific geometry see “Shape” on page 1-0 .
Connect this port to a frame entity—port, line, or junction—to resolve the placement of
the reference frame in a model. For more information, see “Working with Frames”.

Parameters
Geometry

Shape — Shape parameterization to use
Brick (default) | Cylinder | Sphere | Ellipsoid | Regular Extrusion | General
Extrusion | Revolution | From File

Shape parameterization to use. Select a preset shape such as Sphere or use the From
File option to import an external STEP or STL geometry.

• Cylinder — Cylindrical shape with geometry center coincident with the reference
frame origin and symmetry axis coincident with the reference frame z axis.

• Sphere — Spherical shape with geometry center coincident with the reference frame
origin.
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• Brick — Prismatic shape with geometry center coincident with the reference frame
origin and prismatic surfaces normal to the reference frame x, y, and z axes.

• Ellipsoid — Three-dimensional extension of the ellipse with geometry center
coincident with the reference frame origin and semi-principal axes coincident with the
reference frame x, y, and z axes.

• Regular Extrusion — Translational sweep of a regular polygon cross section with
geometry center coincident with the reference frame origin and extrusion axis
coincident with the reference frame z axis.

• General Extrusion — Translational sweep of a general cross section with geometry
center coincident with the [0 0] coordinate on the cross-sectional XY plane and
extrusion axis coincident with the reference frame z axis.

• Revolution — Rotational sweep of a general cross section with geometry center
coincident with the [0 0] coordinate on the cross-sectional XZ plane and revolution
axis coincident with the reference frame z axis.
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• From File — Imported custom shape with geometry center and orientation as
defined in STL or STEP geometry file.

Cylinder: Radius — Radius of the cylinder
1 m (default) | scalar with units of length

Distance between the axis of the cylinder and its surface.

Cylinder: Length — Length of the cylinder
1 m (default) | scalar with units of length

Distance between the opposing ends of the cylinder.

Sphere: Radius — Radius of the sphere
1 m (default) | scalar with units of length

Distance between the center of the sphere and its surface.
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Brick: Dimensions — Width, thickness, and height of the brick
[1 1 1] m (default) | scalar with units of length

Lengths of the brick sides along the x-, y-, and z-axes of the solid reference frame. These
lengths give, in no specific order, the width, thickness, and height of the brick.

Ellipsoid: Radii — Ellipsoid radii along the x, y, and z semiprincipal axes
[1,1,1] m (default) | scalar with units of length

Ellipsoid radii along the x, y, and z axes of the solid reference frame. The ellipsoid
becomes a sphere if all radii are equal.

Regular Extrusion: Number of Sides — Number of sides of the extrusion cross-
section
3 (default) | scalar with units of length

Number of sides of the extrusion cross-section. The cross-section is by definition a regular
polygon—one whose sides are of equal lenth. The number specified must be greater than
two.

Regular Extrusion: Outer Radius — Radius of the inscribed circle of the extrusion
cross-section
1 m (default) | scalar with units of length
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Radius of the circle that fully inscribes the extrusion cross-section. The cross-section is by
definition a regular polygon—one whose sides are of equal length.

Regular Extrusion: Length — Sweep length of the extrusion
1 m (default) | scalar with units of length

Length by which to sweep the specified extrusion cross-section. The extrusion axis is the
z-axis of the solid reference frame. The cross-section is swept by equal amounts in the
positive and negative directions.

General Extrusion: Cross-section — Cross-section coordinates specified on the XY
plane
[1 1; -1 1; -1 -1; 1 -1] (default) | two-column matrix with units of length

Cross-sectional shape specified as an [x,y] coordinate matrix, with each row
corresponding to a point on the cross-sectional profile. The coordinates specified must
define a closed loop with no self-intersecting segments.

The coordinates must be arranged such that from one point to the next the solid region
always lies to the left. The block extrudes the cross-sectional shape specified along the z
axis to obtain the extruded solid.
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General Extrusion: Length — Sweep length of the extrusion
1 m (default) | scalar with units of length

Length by which to sweep the specified extrusion cross-section. The extrusion axis is the
z-axis of the solid reference frame. The cross-section is swept by equal amounts in the
positive and negative directions.

Revolution: Cross-section — Cross-section coordinates specified on the XZ plane
[1 1; 1 -1; 2 -1; 2 1] m (default) | two-column matrix with units of length

Cross-sectional shape specified as an [x,z] coordinate matrix, with each row
corresponding to a point on the cross-sectional profile. The coordinates specified must
define a closed loop with no self-intersecting segments.

The coordinates must be arranged such that from one point to the next the solid region
always lies to the left. The block revolves the cross-sectional shape specified about the
reference frame z axis to obtain the revolved solid.

Revolution: Extent of Revolution — Selection of a full or partial revolution
Full (default) | Custom

Type of revolution sweep to use. Use the default setting of Full to revolve the cross-
sectional shape by the maximum 360 degrees. Select Custom to revolve the cross-
sectional shape by a lesser angle.
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Revolution: Revolution Angle — Sweep angle of a partial revolution
180 (default) | scalar number in the specified units

Angle of the rotational sweep associated with the revolution.

From File: File Type — Type of geometry file to import
STEP (default) | STL

Type of geometry file to import. Automatic inertia calculation is available for STEP files
only. You must specify all inertial properties explicitly for STL files.

From File: File Name — Geometry file name
character vector with the geometry file name

Name, path, and extension of the geometry file—e.g., ‘C:/Users/Jdoe/Documents/
myShape.STEP’. File paths can be absolute or relative.

From File: Units — Unit of length for the STL file
m (default) | cm | mm | km | in | ft | yd | mi

Unit of length to apply to the STL file. You can change the units to scale the dimensions
of the imported geometry.

Inertia

Type — Inertia parameterization to use
Calculate from Geometry (default) | Point Mass | Custom

Inertia parameterization to use. Select Point Mass to model a concentrated mass with
negligible rotational inertia. Select Custom to model a distributed mass with the
specified moments and products of inertia. The default setting, Calculate from
Geometry, enables the block to automatically calculate the rotational inertia properties
from the solid geometry and specified mass or mass density.
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Based on — Parameter to base inertia calculation on
Density (default) | Mass

Parameter to use in inertia calculation. The block obtains the inertia tensor from the
solid geometry and the parameter selected. Use Density if the material properties are
known. Use Mass if the total solid mass if known.

Density — Mass per unit volume of material
1000 kg/m^3 (default)

Mass per unit volume of material. The mass density can take on a positive or negative
value. Specify a negative mass density to model the effects of a void or cavity in a solid
body.

Mass — Aggregate mass of the solid
1 kg (default) | scalar with units of mass

Aggregate mass of the solid. The mass can be a positive or negative value. Specify a
negative mass to model the aggregate effect of voids and cavities in a compound body.

Custom: Center of Mass — Center-of-mass coordinates
[0 0 0] m (default) | three-element vector with units of length

[x y z] coordinates of the center of mass relative to the block reference frame. The center
of mass coincides with the center of gravity in uniform gravitational fields only.

Custom: Moments of Inertia — Diagonal elements of inertia tensor
[1 1 1] kg*m^2 (default) | three-element vector with units of mass*length^2

Three-element vector with the [Ixx Iyy Izz] moments of inertia specified relative to a frame
with origin at the center of mass and axes parallel to the block reference frame. The
moments of inertia are the diagonal elements of the inertia tensor
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Custom: Products of Inertia — Off-diagonal elements of inertia tensor
[0 0 0] kg*m^2 (default) | three-element vector with units of mass*length^2

Three-element vector with the [Iyz Izx Ixy] products of inertia specified relative to a frame
with origin at the center of mass and axes parallel to the block reference frame. The
products of inertia are the off-diagonal elements of the inertia tensor
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Calculate from Geometry: Derived Values — Display of calculated values of mass
properties
button

Display of the calculated values of the solid mass properties—mass, center of mass,
moments of inertia, and products of inertia. Click the Update button to calculate and
display the mass properties of the solid. Click this button following any changes to the
block parameters to ensure that the displayed values are still current.

The center of mass is resolved in the local reference frame of the solid. The moments and
products of inertia are each resolved in the inertia frame of resolution—a frame whose
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axes are parallel to those of the reference frame but whose origin coincides with the solid
center of mass.

Dependencies

The option to calculate and display the mass properties is active when the Inertia >
Type block parameter is set to Calculate from Geometry.

Graphic

Type — Solid visualization setting
From Geometry (default) | Marker | None

Visualization setting for this solid. Use the default setting, From Geometry, to show the
solid geometry. Select Marker to show a graphic marker such as a sphere or frame.
Select None to disable visualization for this solid.

Marker: Shape — Shape of the graphic marker
Sphere (default) | Cube | Frame

Geometrical shape of the graphic marker. Mechanics Explorer shows the marker using
the selected shape.

Marker: Size — Pixel size of the graphic marker
10 (default) | scalar with units of pixels

Absolute size of the graphic marker in screen pixels. The marker size is invariant with
zoom level.

Visual Properties — Parameterizations for color and opacity
Simple (default) | Advanced

Parameterization for specifying visual properties. Select Simple to specify color and
opacity. Select Advanced to add specular highlights, ambient shadows, and self-
illumination effects.

Simple: Color — True color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

RGB color vector with red (R), green (G), and blue (B) color amounts specified on a 0–1
scale. A color picker provides an alternative interactive means of specifying a color. If you
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change the Visual Properties setting to Advanced, the color specified in this parameter
becomes the Diffuse Color vector.

Simple: Opacity — Surface opacity as scalar number on 0–1 scale
1.0 (default) | scalar with value constrained to 0–1

Graphic opacity specified on a scale of 0–1. An opacity of 0 corresponds to a completely
transparent graphic and an opacity of 1 to a completely opaque graphic.

Advanced: Diffuse Color — True color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

True color under direct white light specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. An optional fourth element specifies the color opacity also on a scale of 0–1.
Omitting the opacity element is equivalent to specifying a value of 1.

Advanced: Specular Color — Highlight color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of specular highlights specified as an [R,G,B] or [R,G,B,A] vector on a 0–1 scale.
The optional fourth element specifies the color opacity. Omitting the opacity element is
equivalent to specifying a value of 1.

Advanced: Ambient Color — Shadow color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of shadow areas in diffuse ambient light, specified as an [R,G,B] or [R,G,B,A] vector
on a 0–1 scale. The optional fourth element specifies the color opacity. Omitting the
opacity element is equivalent to specifying a value of 1.

Advanced: Emissive Color — Self-illumination color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Surface color due to self illumination, specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. The optional fourth element specifies the color opacity. Omitting the opacity
element is equivalent to specifying a value of 1.

Advanced: Shininess — Highlight sharpness as scalar number on 0–128 scale
75 (default) | scalar with value constrained to 0–128
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Sharpness of specular light reflections, specified as a scalar number on a 0–128 scale.
Increase the shininess value for smaller but sharper highlights. Decrease the value for
larger but smoother highlights.

Frames

Show Port R — Show the reference frame port for connection to other blocks
checked (default) | cleared

Clear the check box to hide the reference frame port in the Solid block. Hiding the
reference frame port suppresses the frame visualization in Mechanics Explorer. You
must expose the reference frame port if the block has no custom frames.

New Frame — Create a custom frame for connection to other blocks
empty (default)

Select the Create button  to define a new frame using the frame-creation interface.
Each new frame appears on a row above the New Frame parameter. To edit an existing
frame, select the Edit button . To delete an existing frame, select the Delete button .

Frame Creation Interface

Frame Name — MATLAB® string used to identify the custom frame
custom character vector

Frame identifier specified as a MATLAB string. This string identifies the frame port in
the block diagram and in the tree view pane of Mechanics Explorer. Keep the frame
name short to ensure it fits in the block icon width.

Frame Origin — Position of the custom frame origin
At Reference Frame Origin (default) | At Center of Mass | Based on Geometric
Feature

Select the location of the frame origin. Options include:

• At Reference Frame Origin — Make the new frame origin coincident with the
reference frame origin. This is the default option.

• At Center of Mass — Make the new frame origin coincident with the solid center of
mass. The reference frame origin is located at the center of mass in symmetrical
shapes such as spheres and bricks but not in certain extrusions or revolutions.
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• Based on Geometric Feature — Place the new frame origin at the center of the
selected geometry feature. Valid geometry features include surfaces, lines, and points.
You must select a geometry feature from the visualization pane and then select the
Use Selected Feature button. The name of the selected geometry feature appears in
the field below this option.

Frame Axes: Primary Axis — Axis used to constrain the possible directions of the
remaining frame axes
Along Reference Frame Axis (default) | Along Principal Inertia Axis | Based on
Geometric Feature

Select the axis of the new frame that you want to set as the primary axis. The primary
axis constrains the possible orientations of the remaining two axes. Specify the
orientation of the primary axis by selecting from the following options:

• Along Reference Frame Axis — Align the primary axis with the selected axis of
the reference frame.

• Along Principal Inertia Axis — Align the primary axis with the selected principal
inertia axis. The principal inertia axes are those about which the products of inertia
are zero.

• Based on Geometric Feature — Align the primary axis with the vector associated
with the selected geometric feature. Valid geometric features include surfaces and
lines.

Frame Axes: Secondary Axis — Axis used to constrain the possible directions of the
remaining frame axis
Along Reference Frame Axis (default) | Along Principal Inertia Axis | Based on
Geometric Feature

Select the axis of the new frame that you want to set as the secondary axis. The
secondary axis is the projection of the selected direction onto the normal plane of the
primary axis. Select the direction to project from the following options:

• Along Reference Frame Axis — Project the selected reference frame axis onto the
normal plane of the primary axis. Align the secondary axis with the projection.

• Along Principal Inertia Axis — Project the selected principal inertia axis onto the
normal plane of the primary axis. Align the secondary axis with the projection. The
principal inertia axes are those about which the products of inertia are zero.

• Based on Geometric Feature — Project the vector associated with the selected
geometry feature onto the normal plane of the primary axis. Align the secondary axis
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with the projection. Valid geometry features include surfaces and lines. You must
select a geometry feature from the visualization pane and then select the Use
Selected Feature button.

See Also
Rigid Transform | Variable Brick Solid | Variable Cylindrical Solid | Variable Spherical
Solid

Topics
“Modeling Bodies”
“Representing Solid Geometry”
“Specifying Custom Inertias”
“Creating Custom Solid Frames”
“Manipulate the Color of a Solid”

Introduced in R2012a
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Spherical Joint
Joint with one spherical primitive

Library
Joints

Description
This block represents a joint with three rotational degrees of freedom. One spherical
primitive provides the three rotational degrees of freedom. The base and follower frame
origins remain coincident during simulation.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a single time-
varying transformation. The spherical primitive (S) applies this transformation, which
causes the follower frame to rotate with respect to the base frame about an arbitrary 3-D
axis. This joint primitive is not susceptible to gimbal lock.
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Joint Transformation

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.

Parameters

Spherical Primitive: State Targets
Specify the spherical primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation of the follower frame with respect to the base frame. It is
resolved in the base frame. Selecting this option exposes priority and value fields.
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Priority
Select state target priority. This is the importance level assigned to the state target.
If all state targets cannot be simultaneously satisfied, the priority level determines
which targets to satisfy first and how closely to satisfy them. This option applies to
both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Select a method to specify the joint primitive state target.
Method Description
None Constrain the base and follower frames

to share the same orientation.
Aligned Axes Set frame rotation by aligning two

follower frame axes with two base frame
axes.

Standard Axis Specify frame rotation as an angle about
a standard axis (x, y, or z).

Arbitrary Axis Specify frame rotation as an angle about
a general [x, y, z] axis.

Rotation Sequence Specify frame rotation as a sequence of
three elementary rotations.

Rotation Matrix Specify frame rotation as a right-handed
orthogonal rotation matrix.

Aligned Axes
Select two pairs of base-follower frame axes.
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Parameter Description
Pair 1 First pair of base-follower frame axes to

align.
Pair 2 Second pair of base-follower frame axes

to align. Axis choices depend on Pair 1
axis selections.

Standard Axis
Select a standard rotation axis, resolved in the base frame, and specify the follower
frame rotation angle.
Parameter Description
Axis Standard rotation axis (X, Y, or Z)

resolved in the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Arbitrary Axis
Select a general 3-D rotation axis, resolved in the base frame, and specify the
follower frame rotation angle.
Parameter Description
Axis General rotation axis [X Y Z] resolved in

the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Rotation Sequence
Specify a sequence of three elementary rotations about the selected permutation of x,
y, and z axes. These rotation sequences are also known as Euler and Tait-Bryan
sequences. The rotations are those of the follower frame relative to the frame selected
in the Rotate About parameter.

If you set the Rotate About parameter to Follower Frame, the follower frame
rotates about its own axes. These axes change orientation with each successive
rotation. If you set the Rotate About parameter to Base Frame, the follower frame
rotates about the fixed base frame axes.
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Parameter Description
Rotation About Frame whose axes to rotate the follower

frame about.
Sequence Sequence of axes about which to apply

the elementary rotations.
Angles Three-element vector with elementary

rotation angles about the axes specified
in the Sequence parameter.

Rotation Matrix
Specify the 3×3 transformation matrix of a proper rotation between the base and
follower frames. The matrix must be orthogonal and have determinant +1. The
default matrix is [1 0 0; 0 1 0; 0 0 1].

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity of the follower frame with respect to the base frame. It is
resolved in the base frame. Selecting this option exposes priority and value fields.
The priority field is identical to that used for the position state target.
Value

Enter a three element vector with the angular velocity components of the follower
frame with respect to the base frame. Select a physical unit. The default is deg/s
(degree/second).

Resolution Frame
From the drop-down list, select a resolution frame. This is the frame in which the
state target is resolved. It identifies the axes the velocity vector components
apply to. The default is Follower.

Spherical Primitive: Internal Mechanics

Specify the spherical primitive internal mechanics. This includes linear spring and
damping forces, accounting for energy storage and dissipation, respectively. To ignore
internal mechanics, keep spring stiffness and damping coefficient values at the default
value of 0.
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Equilibrium Position
Select a method to specify the spring equilibrium position. The equilibrium position
is the rotation angle between base and follower port frames at which the spring
torque is zero.
Method Description
None Constrain the base and follower frames

to share the same orientation.
Aligned Axes Set frame rotation by aligning two

follower frame axes with two base frame
axes.

Standard Axis Specify frame rotation as an angle about
a standard axis (x, y, or z).

Arbitrary Axis Specify frame rotation as an angle about
a general [x, y, z] axis.

Rotation Sequence Specify frame rotation as a sequence of
three elementary rotations.

Rotation Matrix Specify frame rotation as a right-handed
orthogonal rotation matrix.

Aligned Axes
Select two pairs of base-follower frame axes.
Parameter Description
Pair 1 First pair of base-follower frame axes to

align.
Pair 2 Second pair of base-follower frame axes

to align. Axis choices depend on Pair 1
axis selections.

Standard Axis
Select a standard rotation axis, resolved in the base frame, and specify the follower
frame rotation angle.
Parameter Description
Axis Standard rotation axis (X, Y, or Z)

resolved in the base frame.
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Parameter Description
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Arbitrary Axis
Select a general 3-D rotation axis, resolved in the base frame, and specify the
follower frame rotation angle.
Parameter Description
Axis General rotation axis [X Y Z] resolved in

the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Rotation Sequence
Specify a sequence of three elementary rotations about the selected permutation of x,
y, and z axes. These rotation sequences are also known as Euler and Tait-Bryan
sequences. The rotations are those of the follower frame relative to the frame selected
in the Rotate About parameter.

If you set the Rotate About parameter to Follower Frame, the follower frame
rotates about its own axes. These axes change orientation with each successive
rotation. If you set the Rotate About parameter to Base Frame, the follower frame
rotates about the fixed base frame axes.
Parameter Description
Rotation About Frame whose axes to rotate the follower

frame about.
Sequence Sequence of axes about which to apply

the elementary rotations.
Angles Three-element vector with elementary

rotation angles about the axes specified
in the Sequence parameter.

Rotation Matrix
Specify the 3×3 transformation matrix of a proper rotation between the base and
follower frames. The matrix must be orthogonal and have determinant +1. The
default matrix is [1 0 0; 0 1 0; 0 0 1].
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Spring Stiffness
Enter the linear spring constant. This is the torque required to displace the joint
primitive by a unit angle. The term linear refers to the mathematical form of the
spring equation. The default is 0. Select a physical unit. The default is N*m/deg.

Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select a physical unit. The default is N*m/(deg/s).

Spherical Primitive: Actuation

Specify actuation options for the spherical joint primitive. Actuation modes include
Torque only. Selecting a torque input adds the corresponding physical signal port to the
block. Use this port to specify the actuation torque signal.

Torque
Select a source for the actuation torque. The default setting is None.
Actuation Torque Setting Description
None Apply no actuation torque.
Provided by Input Apply an actuation torque based on a

physical signal. The signal specifies the
torque acting on the follower frame with
respect to the base frame. An equal and
opposite torque acts on the base frame.
Selecting this option exposes additional
parameters.

Torque (X), Torque (Y), Torque (Z)
Select in order to actuate the spherical joint primitive about each standard Cartesian
axis (X, Y, Z) separately. The block exposes the corresponding physical signal ports.
Use these ports to specify the actuation torque signals. The signals must be scalar
values.

Torque (XYZ)
Select in order to actuate the spherical joint primitive about an arbitrary axis [X Y
Z]. The block exposes the corresponding physical signal port. Use this port to specify
the actuation torque signal. The signal must be a 3-D vector.
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Frame
Select the frame to resolve the actuation torque signal in. The axes of this frame
establish the directions of the X, Y, and Z torque components. The default setting is
Base.

Spherical Primitive: Sensing

Select the motion variables to sense in the spherical joint primitive. The block adds the
corresponding physical signal ports. Use these ports to output the numerical values of
the motion variables.

The block measures each motion variable for the follower frame with respect to the base
frame. It resolves that variable in the resolution frame that you select from the Frame
drop-down list.
Motion Variables Description
Position Quaternion describing follower frame

rotation with respect to base frame. The
quaternion coefficients are

cos , sin , sin , sin
q q q q
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The measurement is the same in all
measurement frames.

Velocity (X), Velocity (Y), Velocity (Z) Angular velocity components about X, Y,
and Z axes.

Velocity 3–D angular velocity vector with
components about X, Y, and Z axes.

Acceleration (X), Acceleration (Y),
Acceleration (Z)

Angular acceleration components about X,
Y, and Z axes.

Acceleration 3–D angular acceleration vector with
components about X, Y, and Z axes.

Frame
Select the frame to resolve the measurement in. The axes of this frame establish the
directions of X, Y, and Z vector components. The default setting is Base.
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Composite Force/Torque Sensing
Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.
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Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.
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Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.

Frame Ports
• B — Base frame
• F — Follower frame

Actuation Ports

The spherical joint primitive provides the following actuation ports:

• t — Actuation torque vector [tx, ty, tz] acting on the spherical joint primitive
• tx, ty, tz — X, Y, and Z components of the actuation torque acting on the spherical

joint primitive

Sensing Ports

The spherical primitive provides the following sensing ports:

• Q — Orientation of the spherical joint primitive in quaternion form
• wx, wy, wz — X, Y, and Z angular velocity components of the spherical joint primitive
• w — Angular velocity [wx, wy, wz] of the spherical joint primitive
• bx, by, bz — X, Y, and Z angular acceleration components of the spherical joint

primitive
• b — Angular acceleration [bx, by, bz] of the spherical joint primitive

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
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• tt — Total torque

See Also
6-DOF Joint | Bushing Joint | Gimbal Joint | Revolute joint

Topics
“Motion Sensing”
“Measurement Frames”
“Actuating and Sensing with Physical Signals”

Introduced in R2012a
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Spline
Cubic interpolating plane curve or space curve
Library: Curves and Surfaces

Description
This block represents a continuous spline curve based on cubic interpolation between the
points specified. The curve can be two-dimensional, such as a planar cam profile, or
three-dimensional, such as a roller coaster track. Depending on the end conditions
selected, the curve can be either open or closed.

Cam profile — An Example of a 2-D Spline Curve

Whether a spline curve is two- or three-dimensional depends solely on the coordinate
matrix dimensions. A two-column matrix specifies a two-dimensional curve in the xy
plane. Each row in this matrix provides the [x, y] coordinates of a point. A three-column
matrix specifies a three-dimensional curve. Each row in this matrix provides the [x, y, z]
coordinates of a point. All coordinates are resolved in the local reference frame of the
block.

The spline curve is a piecewise function of third-order polynomial segments connected
end-to-end. The curve is built such that adjacent polynomial segments have the same
first and second derivatives at the shared end point. If the curve is periodic, an additional
curve segment connects the last point specified to the first point. The first and second
derivatives of this segment matches those of the adjacent segments at the shared end
point.

1 Blocks—Alphabetical List

1-238



Ports

Frame

R — Reference frame
frame

Spline curve reference frame. Connect this frame port to that of another block to resolve
the placement of the spline curve in a model.

G — Geometry Specification
geometry

Spline curve geometry. Connect this geometry port to that of a Point On Curve
Constraint block to provide that block with a spline curve specification.

Parameters
Interpolation Points — Matrix of points used to generate the spline
6-by-3 matrix associated with a space curve (default) | Two-column matrix for plane
curves | Three-column matrix for space curves

Coordinates of the interpolation points specified as an [x, y] matrix for a 2-D curve or [x,
y, x] matrix for a 3-D curve. Coordinates are resolved in the reference frame of the block.

If you set the end conditions to Periodic (Closed), the block joins the first and last
data points with an additional spline segment. Like all spline segments, the additional
segment and its first two derivatives are continuous at the shared point.

Each data point in the coordinate matrix must be unique. If the curve is closed, you must
ensure that the first and last data points have different coordinates.

End Conditions — Treatment to apply to the curve end points
Sphere (default) | Cube | Frame

Type of end conditions to use. Periodic end conditions correspond to a closed curve.
Natural end conditions correspond to an open curve. The default setting is Periodic
(Closed).
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Graphic

Type — Solid visualization setting
From Geometry (default) | Marker | None

Visualization setting for this solid. Use the default setting, From Geometry, to show the
solid geometry. Select Marker to show a graphic marker such as a sphere or frame.
Select None to disable visualization for this solid.

Marker: Shape — Shape of the graphic marker
Sphere (default) | Cube | Frame

Geometrical shape of the graphic marker. Mechanics Explorer shows the marker using
the selected shape.

Marker: Size — Pixel size of the graphic marker
10 (default)

Absolute size of the graphic marker in screen pixels. The marker size is invariant with
zoom level.

Visual Properties — Parameterizations for color and opacity
Simple (default) | Advanced

Parameterization for specifying visual properties. Select Simple to specify color and
opacity. Select Advanced to add specular highlights, ambient shadows, and self-
illumination effects.

Simple: Color — True color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

RGB color vector with red (R), green (G), and blue (B) color amounts specified on a 0–1
scale. A color picker provides an alternative interactive means of specifying a color. If you
change the Visual Properties setting to Advanced, the color specified in this parameter
becomes the Diffuse Color vector.

Simple: Opacity — Surface opacity as scalar number on 0–1 scale
1.0 (default) | scalar with value constrained to 0–1

Graphic opacity specified on a scale of 0–1. An opacity of 0 corresponds to a completely
transparent graphic and an opacity of 1 to a completely opaque graphic.

1 Blocks—Alphabetical List

1-240



Advanced: Diffuse Color — True color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

True color under direct white light specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. An optional fourth element specifies the color opacity also on a scale of 0–1.
Omitting the opacity element is equivalent to specifying a value of 1.

Advanced: Specular Color — Highlight color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of specular highlights specified as an [R,G,B] or [R,G,B,A] vector on a 0–1 scale.
The optional fourth element specifies the color opacity. Omitting the opacity element is
equivalent to specifying a value of 1.

Advanced: Ambient Color — Shadow color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of shadow areas in diffuse ambient light, specified as an [R,G,B] or [R,G,B,A] vector
on a 0–1 scale. The optional fourth element specifies the color opacity. Omitting the
opacity element is equivalent to specifying a value of 1.

Advanced: Emissive Color — Self-illumination color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Surface color due to self illumination, specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. The optional fourth element specifies the color opacity. Omitting the opacity
element is equivalent to specifying a value of 1.

Advanced: Shininess — Highlight sharpness as scalar number on 0–128 scale
75 (default) | scalar with value constrained to 0–128

Sharpness of specular light reflections, specified as a scalar number on a 0–128 scale.
Increase the shininess value for smaller but sharper highlights. Decrease the value for
larger but smoother highlights.

See Also
Inertia | Solid
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Topics
“Visualize Simscape Multibody Frames”
“Manipulate the Color of a Solid”

Introduced in R2015b
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Spring and Damper Force
Force proportional to the distance and relative velocity between two frame origins

Library
Forces and Torques

Description
This block represents a linear spring and damper force pair acting reciprocally between
base and follower frame origins. The two forces in the pair have equal magnitude but
opposite directions. One force acts on the base frame origin, along the vector connecting
follower to base frame origins. The other force acts on the follower frame origin, along the
vector connecting base to follower frame origins.

The magnitude of the spring force component is proportional to the distance between
base and follower frame origins. This distance is the length of the straight line segment
connecting the two origins. The magnitude of the damper force component is proportional
to the relative velocity of the follower frame origin with respect to the base frame.

Parameters
Natural Length

Enter the equilibrium distance between the base and follower frame origins. This is
the distance at which the magnitude of the spring force is zero. The default value is
0. Select or enter a physical unit.

Spring Stiffness
Enter the value of the linear spring constant. The value must be greater than or
equal to zero. The default value is zero. Select or enter a physical unit.
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Damping Coefficient
Enter the value of the linear damping coefficient. The value must be greater than or
equal to zero. The default value is zero. Select or enter a physical unit.

Sense Force
Select to sense the signed magnitude of the spring and damper force acting between
the two frame origins. The block exposes an additional physical signal port to output
the force signal. The output signal is a scalar value. This value is positive if the force
is repulsive; it is negative if the force is attractive.

Ports
The block contains frame ports B and F, representing base and follower frames,
respectively.

Selecting the Sense Force check box in the block dialog box adds a physical signal port,
fm.

See Also
External Force and Torque | Internal Force | Inverse Square Law Force

Topics
“Actuating and Sensing with Physical Signals”

Introduced in R2012a
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Telescoping Joint
Joint with one prismatic and one spherical joint primitive

Library
Joints

Description
This block represents a joint with one translational and three rotational degrees of
freedom. One prismatic primitive provides the translational degree of freedom. One
spherical primitive provides the three rotational degrees of freedom.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates or rotates the follower frame with respect to the
joint primitive base frame. For all but the first joint primitive, the base frame coincides
with the follower frame of the previous joint primitive in the sequence.
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At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Rotation:

• About an arbitrary 3-D axis resolved in the Spherical Primitive (S) base frame.
2 Translation:

• Along the Z axis of the Z Prismatic Primitive (Pz) base frame. This frame is
coincident with the Spherical Primitive (S) follower frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation. Because 3-D rotation occurs as a single rotation
about an arbitrary 3-D axis (as opposed to three separate rotations about the X, Y, Z
axes), gimbal lock does not occur.

Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.
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Parameters

Spherical Primitive: State Targets

Specify the spherical primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation of the follower frame with respect to the base frame. It is
resolved in the base frame. Selecting this option exposes priority and value fields.

Priority
Select state target priority. This is the importance level assigned to the state target.
If all state targets cannot be simultaneously satisfied, the priority level determines
which targets to satisfy first and how closely to satisfy them. This option applies to
both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Select a method to specify the joint primitive state target.
Method Description
None Constrain the base and follower frames

to share the same orientation.
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Method Description
Aligned Axes Set frame rotation by aligning two

follower frame axes with two base frame
axes.

Standard Axis Specify frame rotation as an angle about
a standard axis (x, y, or z).

Arbitrary Axis Specify frame rotation as an angle about
a general [x, y, z] axis.

Rotation Sequence Specify frame rotation as a sequence of
three elementary rotations.

Rotation Matrix Specify frame rotation as a right-handed
orthogonal rotation matrix.

Aligned Axes
Select two pairs of base-follower frame axes.
Parameter Description
Pair 1 First pair of base-follower frame axes to

align.
Pair 2 Second pair of base-follower frame axes

to align. Axis choices depend on Pair 1
axis selections.

Standard Axis
Select a standard rotation axis, resolved in the base frame, and specify the follower
frame rotation angle.
Parameter Description
Axis Standard rotation axis (X, Y, or Z)

resolved in the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Arbitrary Axis
Select a general 3-D rotation axis, resolved in the base frame, and specify the
follower frame rotation angle.
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Parameter Description
Axis General rotation axis [X Y Z] resolved in

the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Rotation Sequence
Specify a sequence of three elementary rotations about the selected permutation of x,
y, and z axes. These rotation sequences are also known as Euler and Tait-Bryan
sequences. The rotations are those of the follower frame relative to the frame selected
in the Rotate About parameter.

If you set the Rotate About parameter to Follower Frame, the follower frame
rotates about its own axes. These axes change orientation with each successive
rotation. If you set the Rotate About parameter to Base Frame, the follower frame
rotates about the fixed base frame axes.
Parameter Description
Rotation About Frame whose axes to rotate the follower

frame about.
Sequence Sequence of axes about which to apply

the elementary rotations.
Angles Three-element vector with elementary

rotation angles about the axes specified
in the Sequence parameter.

Rotation Matrix
Specify the 3×3 transformation matrix of a proper rotation between the base and
follower frames. The matrix must be orthogonal and have determinant +1. The
default matrix is [1 0 0; 0 1 0; 0 0 1].

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity of the follower frame with respect to the base frame. It is
resolved in the base frame. Selecting this option exposes priority and value fields.
The priority field is identical to that used for the position state target.
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Value
Enter a three element vector with the angular velocity components of the follower
frame with respect to the base frame. Select a physical unit. The default is deg/s
(degree/second).

Resolution Frame
From the drop-down list, select a resolution frame. This is the frame in which the
state target is resolved. It identifies the axes the velocity vector components
apply to. The default is Follower.

Spherical Primitive: Internal Mechanics

Specify the spherical primitive internal mechanics. This includes linear spring and
damping forces, accounting for energy storage and dissipation, respectively. To ignore
internal mechanics, keep spring stiffness and damping coefficient values at the default
value of 0.

Equilibrium Position
Select a method to specify the spring equilibrium position. The equilibrium position
is the rotation angle between base and follower port frames at which the spring
torque is zero.
Method Description
None Constrain the base and follower frames

to share the same orientation.
Aligned Axes Set frame rotation by aligning two

follower frame axes with two base frame
axes.

Standard Axis Specify frame rotation as an angle about
a standard axis (x, y, or z).

Arbitrary Axis Specify frame rotation as an angle about
a general [x, y, z] axis.

Rotation Sequence Specify frame rotation as a sequence of
three elementary rotations.

Rotation Matrix Specify frame rotation as a right-handed
orthogonal rotation matrix.
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Aligned Axes
Select two pairs of base-follower frame axes.
Parameter Description
Pair 1 First pair of base-follower frame axes to

align.
Pair 2 Second pair of base-follower frame axes

to align. Axis choices depend on Pair 1
axis selections.

Standard Axis
Select a standard rotation axis, resolved in the base frame, and specify the follower
frame rotation angle.
Parameter Description
Axis Standard rotation axis (X, Y, or Z)

resolved in the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Arbitrary Axis
Select a general 3-D rotation axis, resolved in the base frame, and specify the
follower frame rotation angle.
Parameter Description
Axis General rotation axis [X Y Z] resolved in

the base frame.
Angle Follower frame rotation angle about the

rotation axis with respect to the base
frame.

Rotation Sequence
Specify a sequence of three elementary rotations about the selected permutation of x,
y, and z axes. These rotation sequences are also known as Euler and Tait-Bryan
sequences. The rotations are those of the follower frame relative to the frame selected
in the Rotate About parameter.

If you set the Rotate About parameter to Follower Frame, the follower frame
rotates about its own axes. These axes change orientation with each successive
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rotation. If you set the Rotate About parameter to Base Frame, the follower frame
rotates about the fixed base frame axes.
Parameter Description
Rotation About Frame whose axes to rotate the follower

frame about.
Sequence Sequence of axes about which to apply

the elementary rotations.
Angles Three-element vector with elementary

rotation angles about the axes specified
in the Sequence parameter.

Rotation Matrix
Specify the 3×3 transformation matrix of a proper rotation between the base and
follower frames. The matrix must be orthogonal and have determinant +1. The
default matrix is [1 0 0; 0 1 0; 0 0 1].

Spring Stiffness
Enter the linear spring constant. This is the torque required to displace the joint
primitive by a unit angle. The term linear refers to the mathematical form of the
spring equation. The default is 0. Select a physical unit. The default is N*m/deg.

Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select a physical unit. The default is N*m/(deg/s).

Spherical Primitive: Actuation

Specify actuation options for the spherical joint primitive. Actuation modes include
Torque only. Selecting a torque input adds the corresponding physical signal port to the
block. Use this port to specify the actuation torque signal.

Torque
Select a source for the actuation torque. The default setting is None.
Actuation Torque Setting Description
None Apply no actuation torque.
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Actuation Torque Setting Description
Provided by Input Apply an actuation torque based on a

physical signal. The signal specifies the
torque acting on the follower frame with
respect to the base frame. An equal and
opposite torque acts on the base frame.
Selecting this option exposes additional
parameters.

Torque (X), Torque (Y), Torque (Z)
Select in order to actuate the spherical joint primitive about each standard Cartesian
axis (X, Y, Z) separately. The block exposes the corresponding physical signal ports.
Use these ports to specify the actuation torque signals. The signals must be scalar
values.

Torque (XYZ)
Select in order to actuate the spherical joint primitive about an arbitrary axis [X Y
Z]. The block exposes the corresponding physical signal port. Use this port to specify
the actuation torque signal. The signal must be a 3-D vector.

Frame
Select the frame to resolve the actuation torque signal in. The axes of this frame
establish the directions of the X, Y, and Z torque components. The default setting is
Base.

Spherical Primitive: Sensing

Select the motion variables to sense in the spherical joint primitive. The block adds the
corresponding physical signal ports. Use these ports to output the numerical values of
the motion variables.

The block measures each motion variable for the follower frame with respect to the base
frame. It resolves that variable in the resolution frame that you select from the Frame
drop-down list.
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Motion Variables Description
Position Quaternion describing follower frame

rotation with respect to base frame. The
quaternion coefficients are
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The measurement is the same in all
measurement frames.

Velocity (X), Velocity (Y), Velocity (Z) Angular velocity components about X, Y,
and Z axes.

Velocity 3–D angular velocity vector with
components about X, Y, and Z axes.

Acceleration (X), Acceleration (Y),
Acceleration (Z)

Angular acceleration components about X,
Y, and Z axes.

Acceleration 3–D angular acceleration vector with
components about X, Y, and Z axes.

Frame
Select the frame to resolve the measurement in. The axes of this frame establish the
directions of X, Y, and Z vector components. The default setting is Base.

Prismatic Primitive: State Targets

Specify the prismatic primitive state targets and their priority levels. A state target is
the desired value for one of the joint state parameters—position and velocity. The
priority level is the relative importance of a state target. It determines how precisely the
target must be met. Use the Model Report tool in Mechanics Explorer to check the
assembly status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative position, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. The specified target is resolved in the
base frame. Selecting this option exposes priority and value fields.
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Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative velocity, measured along the joint primitive axis, of the follower frame
origin with respect to the base frame origin. It is resolved in the base frame.
Selecting this option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is m for position and m/s for velocity.

Prismatic Primitive: Internal Mechanics

Specify the prismatic primitive internal mechanics. Internal mechanics include linear
spring forces, accounting for energy storage, and damping forces, accounting for energy
dissipation. You can ignore internal mechanics by keeping spring stiffness and damping
coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the distance between base and follower
frame origins at which the spring force is zero. The default value is 0. Select or enter
a physical unit. The default is m.
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Spring Stiffness
Enter the linear spring constant. This is the force required to displace the joint
primitive by a unit distance. The default is 0. Select or enter a physical unit. The
default is N/m.

Damping Coefficient
Enter the linear damping coefficient. This is the force required to maintain a
constant joint primitive velocity between base and follower frames. The default is 0.
Select or enter a physical unit. The default is N/(m/s).

Prismatic Primitive: Actuation

Specify actuation options for the prismatic joint primitive. Actuation modes include
Force and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Actuation signals are resolved in the base frame.

Force
Select an actuation force setting. The default setting is None.
Actuation Force Setting Description
None No actuation force.
Provided by Input Actuation force from physical signal

input. The signal provides the force
acting on the follower frame with respect
to the base frame along the joint
primitive axis. An equal and opposite
force acts on the base frame.

Automatically computed Actuation force from automatic
calculation. Simscape Multibody
computes and applies the actuation force
based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
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Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Prismatic Primitive: Sensing
Select the variables to sense in the prismatic joint primitive. Selecting a variable exposes
a physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative position of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Velocity
Select this option to sense the relative velocity of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Acceleration
Select this option to sense the relative acceleration of the follower frame origin with
respect to the base frame origin along the joint primitive axis.

Actuator Force
Select this option to sense the actuation force acting on the follower frame with
respect to the base frame along the joint primitive axis.

Composite Force/Torque Sensing
Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.
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During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
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between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.
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Frame Ports
• B — Base frame
• F — Follower frame

Actuation Ports

The prismatic joint primitive provides the following actuation ports:

• fz — Actuation force of the Z prismatic joint primitive
• pz — Desired trajectory of the Z prismatic joint primitive

The spherical joint primitive provides the following actuation ports:

• t — Actuation torque vector [tx, ty, tz] acting on the spherical joint primitive
• tx, ty, tz — X, Y, and Z components of the actuation torque acting on the spherical

joint primitive

Sensing Ports

The prismatic primitive provides the following sensing ports:

• pz — Position of the Z prismatic joint primitive
• vz — Velocity of the Z prismatic joint primitive
• az — Acceleration of the Z prismatic joint primitive
• fz — Actuation force acting on the Z prismatic joint primitive

The spherical primitive provides the following sensing ports:

• Q — Orientation of the spherical joint primitive in quaternion form
• wx, wy, wz — X, Y, and Z angular velocity components of the spherical joint primitive
• w — Angular velocity [wx, wy, wz] of the spherical joint primitive
• bx, by, bz — X, Y, and Z angular acceleration components of the spherical joint

primitive
• b — Angular acceleration [bx, by, bz] of the spherical joint primitive

The following sensing ports provide the composite forces and torques acting on the joint:
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• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
Prismatic Joint | Spherical Joint

Introduced in R2012a
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Transform Sensor
Sensor that measures the spatial relationship between two frames

Library
Frames and Transforms

Description
This block represents a sensor that measures the spatial relationship between two
frames. Parameters that this sensor measures include rotational and translational
position, velocity, and acceleration. The sensor can measure these parameters between
any two frames in a model. This block provides the broadest motion sensing capability in
Simscape Multibody.

Each measurement provides the value of a parameter for the follower frame with respect
to the base frame, resolved in the Measurement Frame that you choose. Measurement
frames include World as well as rotating and non-rotating base and follower frames.

To output a parameter, the block provides a set of optional physical signal ports. Ports
remain hidden until you select the corresponding parameters in the dialog box. Each port
outputs a parameter as a time-varying physical signal. By default, measurements are in
SI units. If connecting to Simulink blocks, you can use the PS-Simulink Converter block
to select a different physical unit.

Parameters
Measurement Frame

Select a frame in which to resolve the selected spatial measurements. The choice of
measurement frame affects the expression of a vector quantity in terms of its X, Y,
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and Z components. Some quantities, such as Angle, are not affected by the choice of
measurement frame. For more information, see “Measurement Frames”. The default
is World.

Rotation
Select the rotation parameters to sense. These parameters encode the rotation operation
required to bring the base frame into coincidence with the follower frame. Rotation
observes the right-hand rule: with the rotation axis pointing out of the screen,
counterclockwise motion defines positive rotation, while clockwise motion defines
negative rotation.

Non-vector quantities require no measurement frame for resolution; these quantities are
unaffected by measurement frame choice. Vector quantities, such as Axis, are always
resolved in either base or follower measurement frames; the World measurement frame
does not apply.

Angle
3–D rotation angle of the follower frame with respect to the base frame. Selecting
Angle exposes physical signal port q.

Axis
Vector components of the normalized rotation axis. The output is a three-element
vector with the X, Y, and Z axis components resolved in the measurement frame.
Selecting Axis exposes physical signal port axs.

Quaternion
Unit quaternion that describes the pure rotation of the follower frame with respect to
the base frame. The output is a four-element vector with the scalar (S) and vector (Vx,
Vy, Vz) quaternion coefficients. The vector provides the coefficients in the order [S Vx
Vy Vz]. Selecting Quaternion exposes physical signal port Q.

Transform
Transform matrix that describes the pure rotation of the follower frame with respect
to the base frame. The output is a nine-element, 3×3 matrix. Selecting Transform
exposes physical signal port R.

Angular Velocity
Select the angular velocity parameters to sense. The parameters encode the angular
velocity of the follower frame with respect to the base frame, resolved in the
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measurement frame. Rotation observes the right-hand rule: with the rotation axis
pointing out of the screen, counterclockwise motion defines positive rotation, while
clockwise motion defines negative rotation.

Omega X/Omega Y/Omega Z
Relative angular velocities about the X, Y, and Z axes of the base frame. Selecting
Omega X, Omega Y, and Omega Z exposes physical signal ports wx, wy, and wz.

Quaternion
Unit quaternion that describes the angular velocity of the follower frame with respect
to the base frame. The output is a four-element vector with the scalar (S) and vector
(Vx, Vy, Vz) quaternion coefficients. The vector provides the coefficients in the order [S
Vx Vy Vz]. Selecting Quaternion exposes physical signal port Qd.

Transform
Transform matrix that describes the angular velocity of the follower frame with
respect to the base frame. The output is a nine-element, 3×3 matrix. Selecting
Transform exposes physical signal port Rd.

Angular Acceleration

Select the angular acceleration parameters to sense. The parameters encode the angular
acceleration of the follower frame with respect to the base frame, resolved in the
measurement frame. Rotation observes the right-hand rule: with the rotation axis
pointing out of the screen, counterclockwise motion defines positive rotation, while
clockwise motion defines negative rotation.

Alpha X/Alpha Y/Alpha Z
Relative angular accelerations about the X, Y, and Z axes of the base frame. Selecting
Alpha X, Alpha Y, and Alpha Z exposes physical signal ports bx, by, and bz.

Quaternion
Unit quaternion that describes the angular acceleration of the follower frame with
respect to the base frame. The output is a four-element vector with the scalar (S) and
vector (Vx, Vy, Vz) quaternion coefficients. The vector provides the coefficients in the
order [S Vx Vy Vz]. Selecting Quaternion exposes physical signal port Qdd.

Transform
Transform matrix that describes the angular acceleration of the follower frame with
respect to the base frame. The output is a nine-element, 3×3 matrix. Selecting
Transform exposes physical signal port Rdd.
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Translation

Select the translation parameters to sense. The parameters encode the translation of the
follower frame with respect to the base frame, resolved in the measurement frame.

X/Y/Z
Offset vector from the base frame origin to the follower frame origin along the X, Y,
and Z axes. Selecting X, Y, and Z exposes physical signal ports x, y, and z.

Radius
Standard radius coordinate found in cylindrical coordinate systems. This radius is
the shortest distance from the base frame Z axis to the follower frame origin. The
value of the radius is always greater than or equal to zero. Selecting Radius exposes
physical signal port rad.

The figure shows the cylindrical translation parameters Z, Radius, and Azimuth.

Azimuth
Standard azimuth coordinate found in cylindrical and spherical coordinate systems.
The azimuth is the angle from the base frame +X axis to the projection of the ray
connecting base to follower frame origins onto the base frame XY plane. The angle
measurement observes the right-hand rule. The azimuth falls in the range [-180°,
+180°]. If base and follower frame origins coincide with each other, the azimuth is
undefined. Selecting Azimuth exposes sensing port azm.
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Distance
Standard radius found in spherical coordinate systems. This is the distance from the
origin of the base frame to the origin of the follower frame. This distance is always
equal to or greater than zero. Selecting Distance exposes sensing port dst.

The figure shows the spherical translation parameters Azimuth, Distance, and
Inclination.

Inclination
Standard inclination found in spherical coordinate systems. The inclination is the
angle of the ray connecting base to follower frame origins with respect to the
projection of this ray onto the base frame XY plane. The angle measurement observes
the right-hand rule. The inclination falls in the range [-90°, +90°]. If base and
follower frame origins coincide with each other, the inclination is undefined.
Selecting Inclination exposes sensing port inc.

Velocity
Select the linear velocity parameters to sense. The parameters encode the linear velocity
of the follower frame with respect to the base frame, resolved in the measurement frame.
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Differentiation of a translation parameter occurs in measurement coordinates, after that
parameter is resolved in the chosen measurement frame.

X/Y/Z
Relative linear velocities along the X, Y, and Z axes. Selecting X, Y, and Z exposes
physical signal ports vx, vy, and vz.

Radius
Time rate of change of the Radius coordinate defined under Translation. Selecting
Radius exposes physical signal port vrad.

Azimuth
Time rate of change of the Azimuth coordinate defined under Translation.
Selecting Azimuth exposes physical signal port vazm.

Distance
Time rate of change of the Distance coordinate defined under Translation.
Selecting Distance exposes physical signal port vdst.

Inclination
Time rate of change of the Inclination coordinate defined under Translation.
Selecting Inclination exposes physical signal port vinc.

Acceleration

Select the linear acceleration parameters to sense. The parameters encode the linear
acceleration of the follower frame with respect to the base frame, resolved in the
measurement frame. Differentiation of a translation parameter occurs in measurement
coordinates, after that parameter is resolved in the chosen measurement frame.

X/Y/Z
Relative linear accelerations along the X, Y, and Z axes. Selecting X, Y, and Z
exposes physical signal ports ax, ay, and az.

Radius
Second time-derivative of the Radius coordinate defined under Translation.
Selecting Radius exposes physical signal port arad.

Azimuth
Second time-derivative of the Azimuth coordinate defined under Translation.
Selecting Azimuth exposes physical signal port aazm.
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Distance
Second time-derivative of the Distance coordinate defined under Translation.
Selecting Distance exposes physical signal port adst.

Inclination
Second time-derivative of the Inclination coordinate defined under Translation.
Selecting Inclination exposes physical signal port ainc.

Ports
The block contains frame ports B and F, representing base and follower frames,
respectively.

See Also
Rigid Transform

Topics
“Motion Sensing”
“Working with Frames”

Introduced in R2012a
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Universal Joint
Joint with two revolute primitives

Library
Joints

Description
This block represents a joint with two rotational degrees of freedom. Two revolute
primitives provide the two rotational degrees of freedom. The base and follower frame
origins remain coincident during simulation.

Joint Degrees of Freedom

The joint block represents motion between the base and follower frames as a sequence of
time-varying transformations. Each joint primitive applies one transformation in this
sequence. The transformation translates or rotates the follower frame with respect to the
joint primitive base frame. For all but the first joint primitive, the base frame coincides
with the follower frame of the previous joint primitive in the sequence.
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At each time step during the simulation, the joint block applies the sequence of time-
varying frame transformations in this order:

1 Rotation:

a About the X axis of the X Revolute Primitive (Rx) base frame.
b About the Y axis of the Y Revolute Primitive (Ry) base frame. This frame is

coincident with the X Revolute Primitive (Rx) follower frame.

The figure shows the sequence in which the joint transformations occur at a given
simulation time step. The resulting frame of each transformation serves as the base
frame for the following transformation.

Joint Transformation Sequence

A set of optional state targets guide assembly for each joint primitive. Targets include
position and velocity. A priority level sets the relative importance of the state targets. If
two targets are incompatible, the priority level determines which of the targets to satisfy.

Internal mechanics parameters account for energy storage and dissipation at each joint
primitive. Springs act as energy storage elements, resisting any attempt to displace the
joint primitive from its equilibrium position. Joint dampers act as energy dissipation
elements. Springs and dampers are strictly linear.

Each joint primitive has a set of optional actuation and sensing ports. Actuation ports
accept physical signal inputs that drive the joint primitives. These inputs can be forces
and torques or a desired joint trajectory. Sensing ports provide physical signal outputs
that measure joint primitive motion as well as actuation forces and torques. Actuation
modes and sensing types vary with joint primitive.
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Parameters

Revolute Primitive: State Targets
Specify the revolute primitive state targets and their priority levels. A state target is the
desired value for one of the joint state parameters—position and velocity. The priority
level is the relative importance of a state target. It determines how precisely the target
must be met. Use the Model Report tool in Mechanics Explorer to check the assembly
status for each joint state target.

Specify Position Target
Select this option to specify the desired joint primitive position at time zero. This is
the relative rotation angle, measured about the joint primitive axis, of the follower
frame with respect to the base frame. The specified target is resolved in the base
frame. Selecting this option exposes priority and value fields.

Specify Velocity Target
Select this option to specify the desired joint primitive velocity at time zero. This is
the relative angular velocity, measured about the joint primitive axis, of the follower
frame with respect to the base frame. It is resolved in the base frame. Selecting this
option exposes priority and value fields.
Priority

Select state target priority. This is the importance level assigned to the state
target. If all state targets cannot be simultaneously satisfied, the priority level
determines which targets to satisfy first and how closely to satisfy them. This
option applies to both position and velocity state targets.
Priority Level Description
High (desired) Satisfy state target precisely
Low (approximate) Satisfy state target approximately

Note During assembly, high-priority targets behave as exact guides. Low-priority
targets behave as rough guides.

Value
Enter the state target numerical value. The default is 0. Select or enter a
physical unit. The default is deg for position and deg/s for velocity.
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Revolute Primitive: Internal Mechanics

Specify the revolute primitive internal mechanics. Internal mechanics include linear
spring torques, accounting for energy storage, and linear damping torques, accounting
for energy dissipation. You can ignore internal mechanics by keeping spring stiffness and
damping coefficient values at 0.

Equilibrium Position
Enter the spring equilibrium position. This is the rotation angle between base and
follower frames at which the spring torque is zero. The default value is 0. Select or
enter a physical unit. The default is deg.

Spring Stiffness
Enter the linear spring constant. This is the torque required to rotate the joint
primitive by a unit angle. The default is 0. Select or enter a physical unit. The
default is N*m/deg.

Damping Coefficient
Enter the linear damping coefficient. This is the torque required to maintain a
constant joint primitive angular velocity between base and follower frames. The
default is 0. Select or enter a physical unit. The default is N*m/(deg/s).

Revolute Primitive: Actuation

Specify actuation options for the revolute joint primitive. Actuation modes include
Torque and Motion. Selecting Provided by Input from the drop-down list for an
actuation mode adds the corresponding physical signal port to the block. Use this port to
specify the input signal. Input signals are resolved in the base frame.

Torque
Select an actuation torque setting. The default setting is None.
Actuation Torque Setting Description
None No actuation torque.
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Actuation Torque Setting Description
Provided by Input Actuation torque from physical signal

input. The signal provides the torque
acting on the follower frame with respect
to the base frame about the joint
primitive axis. An equal and opposite
torque acts on the base frame.

Automatically computed Actuation torque from automatic
calculation. Simscape Multibody
computes and applies the actuation
torque based on model dynamics.

Motion
Select an actuation motion setting. The default setting is Automatically
Computed.
Actuation Motion Setting Description
Provided by Input Joint primitive motion from physical

signal input. The signal provides the
desired trajectory of the follower frame
with respect to the base frame along the
joint primitive axis.

Automatically computed Joint primitive motion from automatic
calculation. Simscape Multibody
computes and applies the joint primitive
motion based on model dynamics.

Revolute Primitive: Sensing

Select the variables to sense in the revolute joint primitive. Selecting a variable exposes a
physical signal port that outputs the measured quantity as a function of time. Each
quantity is measured for the follower frame with respect to the base frame. It is resolved
in the base frame. You can use the measurement signals for analysis or as input in a
control system.

Position
Select this option to sense the relative rotation angle of the follower frame with
respect to the base frame about the joint primitive axis.
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Velocity
Select this option to sense the relative angular velocity of the follower frame with
respect to the base frame about the joint primitive axis.

Acceleration
Select this option to sense the relative angular acceleration of the follower frame with
respect to the base frame about the joint primitive axis.

Actuator Torque
Select this option to sense the actuation torque acting on the follower frame with
respect to the base frame about the joint primitive axis.

Composite Force/Torque Sensing

Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.
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Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.
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Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.

The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for specifying
actuation inputs and sensing dynamical variables such as forces, torques, and motion.
You expose an optional port by selecting the sensing check box corresponding to that
port.

Frame Ports

• B — Base frame
• F — Follower frame

Actuation Ports

The revolute joint primitives provide the following actuation ports:

• tx, ty — Actuation torques acting on the X and Y revolute joint primitives
• qx, qy — Desired rotations of the X and Y revolute joint primitives

Sensing Ports

The revolute joint primitives provide the following sensing ports:
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• qx, qy — Angular positions of the X and Y revolute joint primitives
• wx, wy — Angular velocities of the X and Y revolute joint primitives
• bx, by — Angular accelerations of the X and Y revolute joint primitives
• tx, ty — Actuation torques acting on the X and Y revolute joint primitives

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
Gimbal Joint | Revolute Joint

Topics
“Actuating and Sensing with Physical Signals”
“Motion Sensing”
“Rotational Measurements”

Introduced in R2012a
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Variable Brick Solid
Solid brick with variable mass and size
Library: Body Elements / Variable Mass

Description
The Variable Brick Solid block adds to the attached frame a solid brick with variable
mass and size. The mass and side lengths (x, y, and z) of the brick can each be a constant
or vary with time. A variable quantity can be specified directly as a physical signal or it
can be calculated as a function of the remaining quantities. Only one quantity, either
mass or one side length, can be calculated during simulation.

A reference frame encodes the position and orientation of the solid in a model. The frame
origin is located at the midpoint of the x- and y-dimensions and at the lower end of the z-
dimension. These relationships are preserved during simulation. The z-dimension
increases asymmetrically relative to the lower z-plane, along the positive direction of the
z-axis.

Variable Brick with z-Dimension Calculated from Mass

Visualization is dynamic. Solid dimensions update continuously as they occur, in the
visualization pane of Mechanics Explorer. The initial dimensions of the solid depend
on the parameters and physical signals that you specify. It is possible for a variable
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dimension to begin with a zero value—for example, if it derives from a physical signal
whose initial value is zero also.

Density can itself be constant or variable. This quantity is specified as a constant if at
least one solid parameter is calculated during simulation. It is calculated as a variable if
all solid parameters are explicitly specified, either as (constant) block parameters or as
physical signals. As in the case of the Solid block, you can specify a negative density, for
example, to model voids in compound bodies.

Ports

Frame

R — Reference frame
frame

Local reference frame of the solid. This frame is fixed with respect to the solid geometry.
Its origin is located at the center of geometry. Its x-, y-, and z-axes align with the length,
width, and height dimensions of the brick, respectively. Connect this port to a frame
entity—port, line, or junction—to resolve the frame placement in a model. For more
information, see “Working with Frames”.

Physical Signal Input

lx — x-dimension of the brick
physical signal

Input port for the x-dimension of the brick.

ly — y-dimension of the brick
physical signal

Input port for the y-dimension of the brick.

lz — z-dimension of the brick
physical signal

Input port for the z-dimension of the brick.

 Variable Brick Solid

1-279



m — Brick mass
physical signal

Input port for the mass of the brick.

Physical Signal Output
lx — x-dimension of the brick
physical signal

Output port for the x-dimension of the brick.

ly — y-dimension of the brick
physical signal

Output port for the y-dimension of the brick.

lz — z-dimension of the brick
physical signal

Output port for the z-dimension of the brick.

m — Brick mass
physical signal

Output port for the mass of the brick.

com — Center-of-mass coordinates of the brick
physical signal

Output port for the center of mass of the brick, reported as a three-element vector with
Cartesian coordinates resolved in the reference frame of the solid.

I — Inertia matrix of the brick
physical signal

Output port for the inertia matrix of the brick, reported as a nine-element matrix
resolved in the inertia frame of resolution of the solid—a virtual copy of the reference
frame whose origin has been shifted to the center of mass. The axes of the inertia frame
of resolution are parallel to the axes of the reference frame. The diagonal elements of the
matrix are the moments of inertia and the off-diagonal elements are the products of
inertia.
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Parameters
Geometry and Inertia

X Length — Parameterization of the x dimension
Constant (default) | Calculate from Mass | Provided by Input

Parameterization of the x dimension of the solid—the length along the x-axis of the local
reference frame. Select Constant to specify a fixed value as a block parameter. Select
Provided by Input to specify a variable value as a physical signal input. Use the
default setting (Calculated from Mass) to obtain this parameter from the specified
solid density and remaining dimensions. Selecting Provided by Input exposes a new
physical signal input port, labeled lx, through which to specify the variable value.

X Length: Value — Value of the x dimension
1 m (default) | scalar with units of length

Length of the solid along the x-axis of the local reference frame. The x dimension is
constant when this block parameter is active.

Parameter Dependencies

This parameter is active when the X Length parameter is set to Constant.

Y Length — Parameterization of the y dimension
Constant (default) | Calculate from Mass | Provided by Input

Parameterization of the y dimension of the solid—the length along the y-axis of the local
reference frame. Select Constant to specify a fixed value as a block parameter. Select
Provided by Input to specify a variable value as a physical signal input. Use the
default setting (Calculated from Mass) to obtain this parameter from the specified
solid density and remaining dimensions. Selecting Provided by Input exposes a new
physical signal input port, labeled ly, through which to specify the variable value.

Y Length: Value — Value of the y dimension
1 m (default) | scalar with units of length

Length of the solid along the y-axis of the local reference frame. The y dimension is
constant when this block parameter is active.
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Parameter Dependencies

This parameter is active when the Y Length parameter is set to Constant.

Z Length — Parameterization of the z dimension
Calculate from Mass (default) | Constant | Provided by Input

Parameterization of the z dimension of the solid—the length along the z-axis of the local
reference frame. Select Constant to specify a fixed value as a block parameter. Select
Provided by Input to specify a variable value as a physical signal input. Use the
default setting (Calculated from Mass) to obtain this parameter from the specified
solid density and remaining dimensions. Selecting Provided by Input exposes a new
physical signal input port, labeled lz, through which to specify the variable value.

Z Length: Value — Value of the z dimension
1 m (default) | scalar with units of length

Length of the solid along the z-axis of the local reference frame. The z dimension is
constant when this block parameter is active.

Parameter Dependencies

This parameter is active when the Z Length parameter is set to Constant.

Mass — Mass parameterization
Provided by Input (default) | Calculate from Geometry

Parameterization of the mass of the solid. Select Calculate from Geometry to obtain
this parameter from the specified solid density and dimensions. Use the default setting
(Provided by Input) to specify this parameter directly as a time-variable physical
signal. This option exposes a new physical signal input port, labeled M, through which to
specify the time-variable solid mass.

Mass: Density — Mass per unit volume of material
1000 kg/m^3 (default) | scalar in units of mass per unit volume

Mass per unit volume of material. The mass density can take on a positive or negative
value. Specify a negative mass density to model the effects of a void or cavity in a solid
body. The default value, 1000 kg/m^3, is characteristic of polymers such as ABS plastic.
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Parameter Dependencies

This parameter is active when the Mass parameter is set to Calculate from
Geometry.

Sensing

X Length — Sensing selection for the x dimension
cleared (default) | checked

Sensing selection for the x dimension of the solid. Check to expose a new physical signal
output port, labeled lx, through which to output the time-varying value of the x
dimension.

Y Length — Sensing selection for the y dimension
cleared (default) | checked

Sensing selection for the y dimension of the solid. Check to expose a new physical signal
output port, labeled ly, through which to output the time-varying value of the y
dimension.

Z Length — Sensing selection for the z dimension
cleared (default) | checked

Sensing selection for the z dimension of the solid. Check to expose a new physical signal
output port, labeled lz, through which to output the time-varying value of the z
dimension.

Mass — Sensing selection for the total mass
cleared (default) | checked

Sensing selection for the total mass of the solid. Check to expose a new physical signal
output port, labeled m, through which to output the time-varying value of the solid mass.

Center of Mass — Sensing selection for the center-of-mass coordinates
cleared (default) | checked

Sensing selection for the coordinates of the center of mass of the solid. Check to expose a
new physical signal output port, labeled com, through which to output the time-varying
coordinates. The output is a three-element vector with Cartesian coordinates resolved in
the reference frame of the solid.
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Inertia Matrix — Sensing option for the inertia matrix
cleared (default) | checked

Sensing selection for the inertia matrix of the solid. Check to expose a new physical
signal output port, labeled I, through which to output the time-varying inertia matrix.
The output is a nine-element matrix with the moments of inertia in the diagonal
positions and the products of inertia in the off-diagonal positions. The moments and
products of inertia are resolve in the inertia frame of resolution—a frame with axes
parallel to those of the reference frame but origin at the center of mass.

Graphic

Type — Solid visualization setting
From Geometry (default) | Marker | None

Visualization setting for this solid. Use the default setting, From Geometry, to show the
solid geometry. Select Marker to show a graphic marker such as a sphere or frame.
Select None to disable visualization for this solid.

Marker: Shape — Shape of the graphic marker
Sphere (default) | Cube | Frame

Geometrical shape of the graphic marker. Mechanics Explorer shows the marker using
the selected shape.

Marker: Size — Pixel size of the graphic marker
10 (default) | scalar with units of pixels

Size of the marker in units of pixels. The size does not change with zoom level.

Visual Properties — Parameterizations for color and opacity
Simple (default) | Advanced

Parameterization for specifying visual properties. Select Simple to specify color and
opacity. Select Advanced to add specular highlights, ambient shadows, and self-
illumination effects.

Simple: Color — True color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

RGB color vector with red (R), green (G), and blue (B) color amounts specified on a 0–1
scale. A color picker provides an alternative interactive means of specifying a color. If you
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change the Visual Properties setting to Advanced, the color specified in this parameter
becomes the Diffuse Color vector.

Simple: Opacity — Surface opacity as scalar number on 0–1 scale
1.0 (default) | scalar with value constrained to 0–1

Graphic opacity specified on a scale of 0–1. An opacity of 0 corresponds to a completely
transparent graphic and an opacity of 1 to a completely opaque graphic.

Advanced: Diffuse Color — True color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

True color under direct white light specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. An optional fourth element specifies the color opacity also on a scale of 0–1.
Omitting the opacity element is equivalent to specifying a value of 1.

Advanced: Specular Color — Highlight color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of specular highlights specified as an [R,G,B] or [R,G,B,A] vector on a 0–1 scale.
The optional fourth element specifies the color opacity. Omitting the opacity element is
equivalent to specifying a value of 1.

Advanced: Ambient Color — Shadow color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of shadow areas in diffuse ambient light, specified as an [R,G,B] or [R,G,B,A] vector
on a 0–1 scale. The optional fourth element specifies the color opacity. Omitting the
opacity element is equivalent to specifying a value of 1.

Advanced: Emissive Color — Self-illumination color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Surface color due to self illumination, specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. The optional fourth element specifies the color opacity. Omitting the opacity
element is equivalent to specifying a value of 1.

Advanced: Shininess — Highlight sharpness as scalar number on 0–128 scale
75 (default) | scalar with value constrained to 0–128
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Sharpness of specular light reflections, specified as a scalar number on a 0–128 scale.
Increase the shininess value for smaller but sharper highlights. Decrease the value for
larger but smoother highlights.

See Also
Rigid Transform | Solid | Variable Cylindrical Solid | Variable Spherical Solid

Topics
“Modeling Bodies”
“Representing Solid Geometry”
“Manipulate the Color of a Solid”

Introduced in R2017b
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Variable Cylindrical Solid
Solid cylinder with variable mass and size
Library: Body Elements / Variable Mass

Description
The Variable Cylindrical Solid block adds to the attached frame a solid cylinder with
variable mass and side. The mass, radius, and length of the cylinder can each be constant
or vary with time. A variable quantity can be specified directly as a physical signal or it
can be calculated as a function of the remaining quantities. Either the mass or the
cylinder dimensions can be calculated during simulation, but not both simultaneously.

A reference frame encodes the position and orientation of the solid in a model. The frame
is defined relative to the solid geometry so that its origin is located at the intersection of
the longitudinal axis of the cylinder (as observed with a Z up view convention). This
relationship is preserved during simulation. Length increases asymmetrically relative to
the bottom surface, along the positive direction of the z-axis.

Variable Cylinder with Length Calculated from Mass

Visualization is dynamic. Solid dimensions update continuously as they occur, in the
visualization pane of Mechanics Explorer. The initial dimensions of the solid depend
on the parameters and physical signals that you specify. It is possible for a variable
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dimension to begin with a zero value—for example, if it derives from a physical signal
whose initial value is zero also.

Density can itself be constant or variable. This quantity is specified as a constant if at
least one solid parameter is calculated during simulation. It is calculated as a variable if
all solid parameters are explicitly specified, either as (constant) block parameters or as
physical signals. As in the case of the Solid block, you can specify a negative density, for
example, to model voids in compound bodies.

Ports

Frame

R — Reference frame
frame

Local reference frame of the solid. This frame is fixed with respect to the solid geometry.
Its origin is located at the center of geometry and its z-axis is aligned with the
longitudinal axis of the cylinder. Connect this port to a frame entity—port, line, or
junction—to resolve the frame placement in a model. For more information, see “Working
with Frames”.

Physical Signal Input

len — Cylinder length
physical signal

Input port for the length of the cylinder.

r — Radius of the cylinder
physical signal

Input port for the radius of the cylinder.

m — Mass of the cylinder
physical signal

Input port for the mass of the cylinder.
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Physical Signal Output

len — Length of the cylinder
physical signal

Output port for the length of the cylinder.

r — Radius of the cylinder
physical signal

Output port for the width of the cylinder.

m — Mass of the cylinder
physical signal

Output port for the mass of the cylinder.

com — Center-of-mass coordinates of the cylinder
physical signal

Output port for the center of mass of the cylinder, reported as a three-element vector
with Cartesian coordinates resolved in the reference frame of the solid.

I — Inertia matrix of the cylinder
physical signal

Output port for the inertia matrix of the cylinder, reported as a nine-element matrix
resolved in the inertia frame of resolution of the solid—a virtual copy of the reference
frame whose origin has been shifted to the center of mass. The axes of the inertia frame
of resolution are parallel to the axes of the reference frame. The diagonal elements of the
matrix are the moments of inertia and the off-diagonal elements are the products of
inertia.

Parameters
Geometry and Inertia

Radius — Radius parameterization
Calculate from Mass (default) | Constant | Provided by Input

 Variable Cylindrical Solid

1-289



Parameterization of the radius of the solid. Select Constant to specify a fixed value as a
block parameter. Select Provided by Input to specify a variable value as a physical
signal input. Use the default setting (Calculated from Mass) to obtain this parameter
from the specified solid density and remaining dimensions. Selecting Provided by
Input exposes a new physical signal input port, labeled r, through which to specify the
variable value.

Radius: Value — Value of the radius
1 m (default) | scalar with units of length

Radius of the solid. The longitudinal axis of the solid is aligned with the z-axis of the
local reference frame. The z dimension is constant when this block parameter is active.
Parameter Dependencies

This parameter is active when the Radius parameter is set to Constant.

Length — Length parameterization
Calculate from Mass (default) | Constant | Provided by Input

Parameterization of the length of the solid. Select Constant to specify a fixed value as a
block parameter. Select Provided by Input to specify a variable value as a physical
signal input. Use the default setting (Calculated from Mass) to obtain this parameter
from the specified solid density and remaining dimensions. Selecting Provided by
Input exposes a new physical signal input port, labeled len, through which to specify the
variable value.

Length: Value — Value of the length
1 m (default) | scalar with units of length

Length of the solid. The longitudinal axis of the cylinder is aligned with the z-axis of the
local reference frame. The z dimension is constant when this block parameter is active.
Parameter Dependencies

This parameter is active when the Length parameter is set to Constant.

Mass — Mass parameterization
Provided by Input (default) | Calculate from Geometry

Parameterization of the mass of the solid. Select Calculate from Geometry to obtain
this parameter from the specified solid density and dimensions. Use the default setting
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(Provided by Input) to specify this parameter directly as a time-variable physical
signal. This option exposes a new physical signal input port, labeled M, through which to
specify the time-variable solid mass.

Mass: Density — Mass per unit volume of material
1000 kg/m^3 (default) | scalar in units of mass per unit volume

Mass per unit volume of material. The mass density can take on a positive or negative
value. Specify a negative mass density to model the effects of a void or cavity in a solid
body. The default value, 1000 kg/m^3, is characteristic of polymers such as ABS plastic.
Parameter Dependencies

This parameter is active when the Mass parameter is set to Calculate from
Geometry.

Sensing

Radius — Sensing selection for the radius
cleared (default) | checked

Sensing selection for the radius of the solid. Check to expose a new physical signal output
port, labeled r, through which to output the time-varying value of the radius.

Length — Sensing selection for the length
cleared (default) | checked

Sensing selection for the z dimension of the solid. Check to expose a new physical signal
output port, labeled len, through which to output the time-varying value of the length.

Mass — Sensing selection for the total mass
cleared (default) | checked

Sensing selection for the total mass of the solid. Check to expose a new physical signal
output port, labeled m, through which to output the time-varying value of the solid mass.

Center of Mass — Sensing selection for the center-of-mass coordinates
cleared (default) | checked

Sensing selection for the coordinates of the center of mass of the solid. Check to expose a
new physical signal output port, labeled com, through which to output the time-varying
coordinates. The output is a three-element vector with Cartesian coordinates resolved in
the reference frame of the solid.
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Inertia Matrix — Sensing option for the inertia matrix
cleared (default) | checked

Sensing selection for the inertia matrix of the solid. Check to expose a new physical
signal output port, labeled I, through which to output the time-varying inertia matrix.
The output is a nine-element matrix with the moments of inertia in the diagonal
positions and the products of inertia in the off-diagonal positions. The moments and
products of inertia are resolve in the inertia frame of resolution—a frame with axes
parallel to those of the reference frame but origin at the center of mass.

Graphic

Type — Solid visualization setting
From Geometry (default) | Marker | None

Visualization setting for this solid. Use the default setting, From Geometry, to show the
solid geometry. Select Marker to show a graphic marker such as a sphere or frame.
Select None to disable visualization for this solid.

Marker: Shape — Shape of the graphic marker
Sphere (default) | Cube | Frame

Geometrical shape of the graphic marker. Mechanics Explorer shows the marker using
the selected shape.

Marker: Size — Pixel size of the graphic marker
10 (default) | scalar with units of pixels

Size of the marker in units of pixels. The size does not change with zoom level.

Visual Properties — Parameterizations for color and opacity
Simple (default) | Advanced

Parameterization for specifying visual properties. Select Simple to specify color and
opacity. Select Advanced to add specular highlights, ambient shadows, and self-
illumination effects.

Simple: Color — True color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

RGB color vector with red (R), green (G), and blue (B) color amounts specified on a 0–1
scale. A color picker provides an alternative interactive means of specifying a color. If you
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change the Visual Properties setting to Advanced, the color specified in this parameter
becomes the Diffuse Color vector.

Simple: Opacity — Surface opacity as scalar number on 0–1 scale
1.0 (default) | scalar with value constrained to 0–1

Graphic opacity specified on a scale of 0–1. An opacity of 0 corresponds to a completely
transparent graphic and an opacity of 1 to a completely opaque graphic.

Advanced: Diffuse Color — True color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

True color under direct white light specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. An optional fourth element specifies the color opacity also on a scale of 0–1.
Omitting the opacity element is equivalent to specifying a value of 1.

Advanced: Specular Color — Highlight color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of specular highlights specified as an [R,G,B] or [R,G,B,A] vector on a 0–1 scale.
The optional fourth element specifies the color opacity. Omitting the opacity element is
equivalent to specifying a value of 1.

Advanced: Ambient Color — Shadow color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of shadow areas in diffuse ambient light, specified as an [R,G,B] or [R,G,B,A] vector
on a 0–1 scale. The optional fourth element specifies the color opacity. Omitting the
opacity element is equivalent to specifying a value of 1.

Advanced: Emissive Color — Self-illumination color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Surface color due to self illumination, specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. The optional fourth element specifies the color opacity. Omitting the opacity
element is equivalent to specifying a value of 1.

Advanced: Shininess — Highlight sharpness as scalar number on 0–128 scale
75 (default) | scalar with value constrained to 0–128
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Sharpness of specular light reflections, specified as a scalar number on a 0–128 scale.
Increase the shininess value for smaller but sharper highlights. Decrease the value for
larger but smoother highlights.

See Also
Rigid Transform | Solid | Variable Brick Solid | Variable Spherical Solid

Topics
“Specifying Custom Inertias”
“Representing Solid Inertia”

Introduced in R2017b
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Variable Spherical Solid
Solid sphere with variable mass and size
Library: Body Elements / Variable Mass

Description
The Variable Spherical Solid block adds to the attached frame a solid sphere with
variable mass and size. The mass and radius of the sphere can each be constant or vary
with time. A variable quantity can be specified directly as a physical signal or it can be
calculated as a function of the remaining quantity. Only one quantity, mass or radius,
can be calculated during simulation.

A reference frame encodes the position and orientation of the solid relative to other
components in a model. The frame is defined relative to the solid geometry so that its
origin is located at the center of the sphere. This relationship is preserved during
simulation. The radius increases symmetrically in all directions with respect to the frame
origin.

Variable Sphere with Radius Calculated from Mass

Visualization is dynamic. Solid dimensions update continuously as they occur, in the
visualization pane of Mechanics Explorer. The initial dimensions of the solid depend
on the parameters and physical signals that you specify. It is possible for a variable
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dimension to begin with a zero value—for example, if it derives from a physical signal
whose initial value is zero also.

Density can itself be constant or variable. This quantity is specified as a constant if
either mass or radius is calculated during simulation. It is calculated as a variable if both
mass and radius are explicitly specified, either as (constant) block parameters or as
physical signals. As in the case of the Solid block, you can specify a negative density, for
example, to model voids in compound bodies.

Ports

Frame
R — Reference frame
frame

Local reference frame of the solid. This frame is fixed with respect to the solid geometry.
The frame origin is located at the center of geometry. Connect this port to a frame entity
—port, line, or junction—to resolve the frame placement in a model. For more
information, see “Working with Frames”.

Physical Signal Input
r — Radius of the sphere
physical signal

Input port for the radius of the sphere.

m — Mass of the sphere
physical signal

Input port for the mass of the sphere.

Physical Signal Output
r — Radius of the sphere
physical signal

Output port for the radius of the sphere.
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m — Mass of the sphere
physical signal

Output port for the mass of the sphere.

com — Center-of-mass coordinates of the sphere
physical signal

Output port for the center of mass of the sphere, reported as a three-element vector with
Cartesian coordinates resolved in the reference frame of the solid.

I — Inertia matrix of the sphere
physical signal

Output port for the inertia matrix of the sphere, reported as a nine-element matrix
resolved in the inertia frame of resolution of the solid—a virtual copy of the reference
frame whose origin has been shifted to the center of mass. The axes of the inertia frame
of resolution are parallel to the axes of the reference frame. The diagonal elements of the
matrix are the moments of inertia and the off-diagonal elements are the products of
inertia.

Parameters
Geometry and Inertia

Radius — Radius parameterization
Calculate from Mass (default) | Constant | Provided by Input

Parameterization of the radius of the solid. Select Constant to specify a fixed value as a
block parameter. Select Provided by Input to specify a variable value as a physical
signal input. Use the default setting (Calculated from Mass) to obtain this parameter
from the specified solid density and remaining dimensions. Selecting Provided by
Input exposes a new physical signal input port, labeled r, through which to specify the
variable value.

Radius: Value — Value of the radius
1 m (default) | scalar with units of length

Radius of the solid. The longitudinal axis of the solid is aligned with the z-axis of the
local reference frame. The z dimension is constant when this block parameter is active.
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Parameter Dependencies

This parameter is active when the Radius parameter is set to Constant.

Mass — Mass parameterization
Provided by Input (default) | Calculate from Geometry

Parameterization of the mass of the solid. Select Calculate from Geometry to obtain
this parameter from the specified solid density and dimensions. Use the default setting
(Provided by Input) to specify this parameter directly as a time-variable physical
signal. This option exposes a new physical signal input port, labeled M, through which to
specify the time-variable solid mass.

Mass: Density — Mass per unit volume of material
1000 kg/m^3 (default) | scalar in units of mass per unit volume

Mass per unit volume of material. The mass density can take on a positive or negative
value. Specify a negative mass density to model the effects of a void or cavity in a solid
body. The default value, 1000 kg/m^3, is characteristic of polymers such as ABS plastic.

Parameter Dependencies

This parameter is active when the Mass parameter is set to Calculate from
Geometry.

Sensing

Radius — Sensing selection for the radius
cleared (default) | checked

Sensing selection for the radius of the solid. Check to expose a new physical signal output
port, labeled r, through which to output the time-varying value of the radius.

Mass — Sensing selection for the total mass
cleared (default) | checked

Sensing selection for the total mass of the solid. Check to expose a new physical signal
output port, labeled m, through which to output the time-varying value of the solid mass.

Center of Mass — Sensing selection for the center-of-mass coordinates
cleared (default) | checked
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Sensing selection for the coordinates of the center of mass of the solid. Check to expose a
new physical signal output port, labeled com, through which to output the time-varying
coordinates. The output is a three-element vector with Cartesian coordinates resolved in
the reference frame of the solid.

Inertia Matrix — Sensing option for the inertia matrix
cleared (default) | checked

Sensing selection for the inertia matrix of the solid. Check to expose a new physical
signal output port, labeled I, through which to output the time-varying inertia matrix.
The output is a nine-element matrix with the moments of inertia in the diagonal
positions and the products of inertia in the off-diagonal positions. The moments and
products of inertia are resolve in the inertia frame of resolution—a frame with axes
parallel to those of the reference frame but origin at the center of mass.

Graphic

Type — Solid visualization setting
From Geometry (default) | Marker | None

Visualization setting for this solid. Use the default setting, From Geometry, to show the
solid geometry. Select Marker to show a graphic marker such as a sphere or frame.
Select None to disable visualization for this solid.

Marker: Shape — Shape of the graphic marker
Sphere (default) | Cube | Frame

Geometrical shape of the graphic marker. Mechanics Explorer shows the marker using
the selected shape.

Marker: Size — Pixel size of the graphic marker
10 (default) | scalar with units of pixels

Size of the marker in units of pixels. The size does not change with zoom level.

Visual Properties — Parameterizations for color and opacity
Simple (default) | Advanced

Parameterization for specifying visual properties. Select Simple to specify color and
opacity. Select Advanced to add specular highlights, ambient shadows, and self-
illumination effects.
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Simple: Color — True color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

RGB color vector with red (R), green (G), and blue (B) color amounts specified on a 0–1
scale. A color picker provides an alternative interactive means of specifying a color. If you
change the Visual Properties setting to Advanced, the color specified in this parameter
becomes the Diffuse Color vector.

Simple: Opacity — Surface opacity as scalar number on 0–1 scale
1.0 (default) | scalar with value constrained to 0–1

Graphic opacity specified on a scale of 0–1. An opacity of 0 corresponds to a completely
transparent graphic and an opacity of 1 to a completely opaque graphic.

Advanced: Diffuse Color — True color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5] (default) | three-element vector with values constrained to 0–1

True color under direct white light specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. An optional fourth element specifies the color opacity also on a scale of 0–1.
Omitting the opacity element is equivalent to specifying a value of 1.

Advanced: Specular Color — Highlight color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of specular highlights specified as an [R,G,B] or [R,G,B,A] vector on a 0–1 scale.
The optional fourth element specifies the color opacity. Omitting the opacity element is
equivalent to specifying a value of 1.

Advanced: Ambient Color — Shadow color as [R,G,B,A] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1

Color of shadow areas in diffuse ambient light, specified as an [R,G,B] or [R,G,B,A] vector
on a 0–1 scale. The optional fourth element specifies the color opacity. Omitting the
opacity element is equivalent to specifying a value of 1.

Advanced: Emissive Color — Self-illumination color as [R,G,B] vector on 0–1 scale
[0.5 0.5 0.5 1.0] (default) | three- or four-element vector with values constrained to
0–1
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Surface color due to self illumination, specified as an [R,G,B] or [R,G,B,A] vector on a 0–1
scale. The optional fourth element specifies the color opacity. Omitting the opacity
element is equivalent to specifying a value of 1.

Advanced: Shininess — Highlight sharpness as scalar number on 0–128 scale
75 (default) | scalar with value constrained to 0–128

Sharpness of specular light reflections, specified as a scalar number on a 0–128 scale.
Increase the shininess value for smaller but sharper highlights. Decrease the value for
larger but smoother highlights.

See Also
Rigid Transform | Solid | Variable Brick Solid | Variable Cylindrical Solid

Topics
“Specifying Custom Inertias”
“Representing Solid Inertia”

Introduced in R2017b
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Weld Joint
Joint with zero primitives

Library
Joints

Description
This block represents a joint with zero degrees of freedom. It contains no joint primitives.
Base and follower frames, each connected to a separate rigid body, are coincident for all
time. The block dialog box provides sensing options for constraint and total forces and
torques.

Joint Degrees of Freedom

1 Blocks—Alphabetical List

1-302



Parameters

Composite Force/Torque Sensing

Select the composite, or joint-wide, forces and torques to sense. These are forces and
torques that act not at individual joint primitives but at the whole joint. Options include
constraint and total forces and torques.

During simulation, the block computes the selected composite forces and torques acting
between the base and follower port frames. It outputs these variables using physical
signal output ports. Check the port labels to identify the output variables at different
ports.

Direction
Forces and torques acting at joints do so in pairs. Newton’s third law of motion
requires that every action be accompanied by an equal and opposite reaction. If the
base frame of a joint exerts a force or torque on the follower frame, then the follower
frame must exert an equal and opposite force or torque on the base frame.

Select whether to sense the composite forces and torques exerted by the base frame
on the follower frame or vice versa. The force and torque vector components are
positive if they point along the positive X, Y, and Z axes of the selected resolution
frame.

Resolution Frame
You can resolve a vector quantity into Cartesian components in different frames. If
the resolution frames have different orientations, then the measured components are
themselves different—even though the vector quantity remains the same.

Select the frame in which to resolve the sensed force and torque variables. Possible
resolution frames include Base and Follower. The block outputs the Cartesian
components of the sensed force and torque vectors as observed in this frame.

Constraint Force
Joint blocks with fewer than three translational degrees of freedom forbid motion
along one or more axes. For example, the Gimbal Joint block forbids translation
along all axes. To prevent translation along an axis, a joint block applies a constraint
force between its base and follower port frames. Constraint forces are orthogonal to
joint translation axes and therefore do no work.
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Select the check box to compute and output the 3-D constraint force vector [fcx, fcy,
fcz] acting at the joint. Only constraint force components that are orthogonal to the
joint translational degrees of freedom have nonzero values. Selecting this option
causes the block to expose physical signal port fc.

Constraint Torque
Joint blocks with fewer than three rotational degrees of freedom forbid motion about
one or more axes. For example, the Cartesian Joint block forbids rotation about all
axes. To prevent rotation about an axis, a joint block applies a constraint torque
between its base and follower port frames. Constraint torques are orthogonal to joint
rotation axes and therefore do no work.

Select the check box to compute and output the 3-D constraint torque vector [tcx, tcy,
tcz] acting at the joint. Only constraint torque components that are orthogonal to the
joint rotational degrees of freedom have nonzero values. Selecting this option causes
the block to expose physical signal port tc.

Total Force
A joint block generally applies various forces between its port frames:

• Actuation forces that drive prismatic joint primitives.
• Internal spring and damper forces that resist motion at prismatic joint primitives.
• Constraint forces that forbid motion in directions orthogonal to prismatic joint

primitives.

The net sum of the different force components equals the total force acting between
the joint port frames. Select the check box to compute and output the 3-D total force
vector [ftx, fty, ftz]. Selecting this option causes the block to expose physical signal
port ft.

Total Torque
A joint block generally applies various torques between its port frames:

• Actuation torques that drive revolute or spherical joint primitives.
• Internal spring and damper torques that resist motion at revolute or spherical

joint primitives.
• Constraint torques that forbid motion in directions orthogonal to the revolute or

spherical joint primitive axes.
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The net sum of the different torque components equals the total torque acting at a
joint. Select the check box to compute and output the 3-D total torque vector [ttx, tty,
ttz]. Selecting this option causes the block to expose physical signal port tt.

Ports
This block has two frame ports. It also has optional physical signal ports for sensing
dynamical variables such as forces, torques, and motion. You expose an optional port by
selecting the sensing check box corresponding to that port.

Frame Ports
• B — Base frame
• F — Follower frame

Sensing Ports

The following sensing ports provide the composite forces and torques acting on the joint:

• fc — Constraint force
• tc — Constraint torque
• ft — Total force
• tt — Total torque

See Also
Rigid Transform

Introduced in R2012a
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World Frame
Inertial reference frame
Library: Frames and Transforms

Description
This block represents the global reference frame in a model. This frame is inertial and at
absolute rest. Rigidly connecting a frame to the World frame makes that frame inertial.
Frame axes are orthogonal and arranged according to the right-hand rule.

In a frame network, the World frame is the ultimate reference frame. Directly or
indirectly, all other frames are defined with respect to the World frame. If multiple
World Frame blocks connect to the same frame network, those blocks identify the same
frame. If no World Frame block connects to a frame network, a copy of an existing frame,
frozen in its initial position and orientation, serves as the World frame.

Ports

Frame

W — World frame
frame

World frame represented by the block. Connect to another frame to fix the position and
orientation of that frame to the world frame.

See Also
Reference Frame | Rigid Transform
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Topics
“Working with Frames”
“Creating Connection Frames”

Introduced in R2012a
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Worm and Gear Constraint
Kinematic constraint between worm and gear bodies with perpendicular non-intersecting
rotation axes
Library: Gears and Couplings / Gears

Description
The Worm and Gear Constraint block represents a kinematic constraint between worm
and gear bodies held at a right angle. The base frame port identifies the connection frame
on the worm and the follower frame port identifies the connection frame on the gear. The
rotation axes coincide with the connection frame z-axes. The worm and gear rotate at a
fixed velocity ratio determined by the gear pitch radii or tooth-thread ratio.

The worm thread direction can follow either right-hand or left-hand conventions. The
convention used determines the relative directions of the worm and gear rotational
velocities. A right-hand convention causes the worm and gear to rotate in the same
direction about the respective z-axes. A left-hand convention causes the worm and gear
to rotate in opposite directions instead.

The block represents only the kinematic constraint characteristic to a worm-and-gear
system. Gear inertia and geometry are solid properties that you must specify using Solid
blocks. The gear constraint model is ideal. Backlash and gear losses due to Coulomb and
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viscous friction between teeth are ignored. You can, however, model viscous friction at
joints by specifying damping coefficients in the joint blocks.

Gear Geometry

The rack-and-pinion constraint is parameterized in terms of the dimensions of the worm
and gear pitch circles. The pitch circles are imaginary circles concentric with the worm
and gear bodies and tangent to the thread contact point. The pitch radii, labeled RB and
RF in the figure, are the radii that the worm and gear would have if they were reduced to
friction cylinders in mutual contact.

Gear Assembly

Gear constraints occur in closed kinematic loops. The figure shows the closed-loop
topology of a simple worm-and-gear model. Joint blocks connect the worm and gear
bodies to a common fixture or carrier, defining the maximum degrees of freedom between
them. A Worm and Gear Constraint block connects the worm and gear bodies,
eliminating one degree of freedom and effectively coupling the worm and gear motions.
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Assembly Requirements

The block imposes special restrictions on the relative positions and orientations of the
gear connection frames. The restrictions ensure that the gears assemble only at distances
and angles suitable for meshing. The block enforces the restrictions during model
assembly, when it first attempts to place the gears in mesh, but relies on the remainder
of the model to keep the gears in mesh during simulation.
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Position Restrictions

• The distance between the base and follower frame z-axes, denoted dB-F in the figure,
must be equal to the distance between the gear centers.

• The translational offset between the base and follower frame origins along the
follower frame z-axis, denoted ΔZF in the figure, must be zero.

Orientation Restrictions

• The z-axes of the base and follower frames must be perpendicular to each other. The
z-axes are shown in blue in the figure.
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• The cross product of the follower frame z-axis with the base frame z-axis must be a
vector aimed from the follower frame origin to the base frame z-axis. The z-axes and
their cross-product vector are shown in the figure. The cross product is defined as
ˆ ˆz z

F B
¥ .

Ports

Frame

B — Base frame
frame

Connection frame on the worm body.

F — Follower frame
frame
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Connection frame on the gear body.

Parameters
Worm Direction — Winding direction of the worm thread
Right-Hand (default) | Left-Hand

Winding direction of the worm thread relative to the base frame z-axis. As viewed from
the base frame origin, a right-hand thread is one that wraps around the base frame z-
axis in a counterclockwise direction. A left-hand thread is one that wraps in a clockwise
direction. This parameter determines the relative directions of motion of the worm and
gear bodies.

Worm Lead Angle — Angle between the worm thread and rotation plane
10 deg (default) | positive scalar between 0 and 180 in units of angle

Angle between the tangent to the worm thread and the plane perpendicular to the base
frame z-axis. The lead angle impacts the gear rotation corresponding to a full worm
revolution.

Specification Method — Gear geometry parameterization
Center Distance and Ratio (default) | Pitch Circle Radii

Parameterization for specifying the worm and gear geometries. You can specify the gear
dimensions in terms of the distance between the gear centers or the individual gear radii.

Center Distance — Distance between the worm and gear centers
20 cm (default) | positive scalar in units of length

Distance between the worm and gear centers. This distance must equal that enforced by
rigid transforms, joints, and any other constraints located between the gear bodies and
the common carrier body.
Dependencies

This parameter is enabled when the Specification Method parameter is set to Center
Distance and Ratio.

Ratio (Ng/Nw) — Ratio of gear teeth to worm threads
1 (default) | positive unitless scalar
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Ratio of gear teeth to worm threads, or starts. This ratio impacts the torque transmitted
between the worm and gear.
Dependencies

This parameter is enabled when the Specification Method parameter is set to Center
Distance and Ratio.

Worm Radius — Radius of the worm pitch circle
10 cm (default) | positive scalar in units of length

Radius of the worm pitch circle. This is the distance between the worm rotation axis and
the tooth-thread contact point. This parameter impacts the torque transmitted between
the worm and gear.
Dependencies

This parameter is enabled when the Specification Method parameter is set to Pitch
Circle Radius.

Gear Radius — Radius of the gear pitch circle
10 cm (default) | positive scalar in units of length

Radius of the gear pitch circle. This is the distance between the gear rotation axis and
the tooth-thread contact point. This parameter impacts the torque transmitted between
the worm and gear.
Dependencies

This parameter is enabled when the Specification Method parameter is set to Pitch
Circle Radius.

See Also
Bevel Gear Constraint | Common Gear Constraint | Rack and Pinion Constraint

Topics
“Worm and Gear”

Introduced in R2016b
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Configuration Parameters

• “Simscape Multibody Pane: General” on page 2-2
• “Simscape Multibody Pane: Diagnostics” on page 2-3
• “Simscape Multibody Pane: Explorer” on page 2-10

2



Simscape Multibody Pane: General

Simscape Multibody Pane Overview

Configure the mechanical settings for an entire Simscape Multibody model.

Configuration

• This pane appears only if your model contains at least one block from the Simscape
product or a product based on the Simscape product, such as the Simscape Multibody
product.

• The settings in this pane are saved only if your model contains at least one Simscape
Multibody block.
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Simscape Multibody Pane: Diagnostics

In this section...
“Invalid visual properties” on page 2-4
“Repeated vertices in a cross-section” on page 2-4
“Unconnected frame port” on page 2-5
“Unconnected Geometry port” on page 2-5
“Redundant block” on page 2-6
“Conflicting reference frames” on page 2-7
“Rigidly constrained block” on page 2-7
“Unsatisfied high priority state targets” on page 2-8
“Overspecified targets in kinematic loops” on page 2-9
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Invalid visual properties

Select the diagnostic action to take if the application detects an improperly specified color
vector.

Settings

Default: warning

none
The application does not check for this situation.

warning
When the application detects this situation, it displays a warning.

error
When the application detects this situation, it terminates the simulation and
displays an error message.

Command-Line Information
Parameter: SimMechanicsInvalidVisualProperty
Type: string
Value: none | warning | error
Default: warning

Repeated vertices in a cross-section

Select the diagnostic action to take if the application detects repeated vertices in a cross-
section.

Settings

Default: warning

none
The application does not check for this situation.

warning
When the application detects this situation, it displays a warning.
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error
When the application detects this situation, it terminates the simulation and
displays an error message.

Command-Line Information
Parameter: SimMechanicsCrossSectionNullEdge
Type: string
Value: none | warning | error
Default: warning

Unconnected frame port

Select the diagnostic action to take if the application detects an unconnected frame port.

Settings

Default: Warning

none
The application does not check for this situation.

warning
When the application detects this situation, it displays a warning.

error
When the application detects this situation, it terminates the simulation and
displays an error message.

Command-Line Information
Parameter: SimMechanicsUnconnectedFramePorts
Type: string
Value: none | warning | error
Default: warning

Unconnected Geometry port

Select the diagnostic action to take if the application detects an unconnected geometry
port.
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Settings

Default: Warning

none
The application does not check for this situation.

warning
When the application detects this situation, it displays a warning.

error
When the application detects this situation, it terminates the simulation and
displays an error message.

Command-Line Information
Parameter: SimMechanicsUnconnectedGeometryPorts
Type: string
Value: none | warning | error
Default: warning

Redundant block

Select the diagnostic action to take if the application detects a redundant block in the
model.

Settings

Default: warning

none
The application does not check for this situation.

warning
When the application detects this situation, it displays a warning.

error
When the application detects this situation, it terminates the simulation and
displays an error message.

Command-Line Information
Parameter: SimMechanicsRedundantBlock
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Type: string
Value: none | warning | error
Default: warning

Conflicting reference frames

Select the diagnostic action to take if the application detects conflicting reference frames
in the model.

Settings

Default: warning

none
The application does not check for this situation.

warning
When the application detects this situation, it displays a warning.

error
When the application detects this situation, it terminates the simulation and
displays an error message.

Command-Line Information
Parameter: SimMechanicsConflictingReferenceFrames
Type: string
Value: none | warning | error
Default: warning

Rigidly constrained block

Select the diagnostic action to take if the application detects a rigidly constrained block
in the model.

Settings

Default: warning

none
The application does not check for this situation.
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warning
When the application detects this situation, it displays a warning.

error
When the application detects this situation, it terminates the simulation and
displays an error message.

Command-Line Information
Parameter: SimMechanicsRigidlyBoundBlock
Type: string
Value: none | warning | error
Default: error

Unsatisfied high priority state targets

Select the diagnostic action to take if the application detects targets with unsatisfied
desired states in the model.

Settings

Default: warning

none
The application does not check for this situation.

warning
When the application detects this situation, it displays a warning.

error
When the application detects this situation, it terminates the simulation and
displays an error message.

Command-Line Information
Parameter: SimMechanicsUnsatisfiedHighPriorityTargets
Type: string
Value: none | warning | error
Default: warning
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Overspecified targets in kinematic loops

Select the diagnostic action to take if the application detects overspecified targets
contained in kinematic loops in the model.

Settings

Default: warning

none
The application does not check for this situation.

warning
When the application detects this situation, it displays a warning.

error
When the application detects this situation, it terminates the simulation and
displays an error message.

Command-Line Information
Parameter: SimMechanicsJointTargetOverSpecification
Type: string
Value: none | warning | error
Default: error
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Simscape Multibody Pane: Explorer

Open Mechanics Explorer on model update or simulation

Start Mechanics Explorer when model is updated or simulated.

Settings

Default: on

 On
Model Explorer starts when model is updated or simulated.

 Off
Model Explorer does not start when model is updated or simulated.

Tip

If you clear this check box, you can start Model Explorer by selecting Desktop >
Mechanics Explorers from the MATLAB Command Window.

Command-Line Information
Parameter: SimMechanicsOpenEditorOnUpdate
Type: string
Value: 'on' | 'off'
Default: 'on'
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Multibody Visualization

3



Mechanics Explorer
Visualize and explore multibody models

Description
Mechanics Explorer is a Simscape Multibody tool based on the Silicon Graphics
OpenGL® API that lets you visualize and explore your multibody models. The tool
comprises a visualization pane to view the model, a tree view pane to explore the model
hierarchy, and a properties pane to examine the individual component parameters.

The visualization pane is interactive and allows you to manipulate the model viewpoint.
You can rotate, roll, pan, and zoom the model to more clearly view its components. You
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can also select from a list of preset viewpoints that includes isometric, front, side, and top
views. To access the view manipulation tools, use the Mechanics Explorer View menu.

For more information on view manipulation, see “Manipulate the Visualization
Viewpoint”.

A Camera Manager tool allows you to create, edit, and delete dynamic cameras with
moving viewpoints. You can interactively set the camera views at discrete playback times
(Keyframes mode) or constrain the camera to coordinate frames in your model
(Tracking mode). To open Camera Manager, in the Mechanics Explorer menu bar, select
Tools > Camera Manager.

For more information on dynamic cameras, see “Create a Dynamic Camera”.

A Video Creator tool allows you to configure and create videos from your multibody
animations. You can set the video frame rate, frame size, playback speed ratio, and file
format. Video Creator captures the model animation as shown in the active visualization
tile the moment you click the Create button. To open Video Creator, in the Mechanics
Explorer menu bar, select Tools > Video Creator.

For more information on video creation, see “Create a Model Animation Video”.

Open the Mechanics Explorer App
Update or simulate the model you want to visualize. By default, Mechanics Explorer
opens automatically with the corresponding model visualization. The visualization shows
the initial model configuration on model update and a dynamic animation during model
simulation. If Mechanics Explorer fails to open, check that automatic model visualization
is enabled:

1 In the Simulink menu bar, select Simulation > Model Configuration
Parameters.

2 In the Model Configuration Parameters window, select Simscape Multibody >
Explorer.

3 Select the Open Mechanics Explorer on model update or simulation check
box.
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Examples
• “Manipulate the Visualization Viewpoint”
• “Create a Dynamic Camera”
• “Selectively Show and Hide Model Components”
• “Visualize Simscape Multibody Frames”
• “Go to a Block from Mechanics Explorer”
• “Create a Model Animation Video”

See Also

Topics
“Manipulate the Visualization Viewpoint”
“Create a Dynamic Camera”
“Selectively Show and Hide Model Components”
“Visualize Simscape Multibody Frames”
“Go to a Block from Mechanics Explorer”
“Create a Model Animation Video”

Introduced in R2012a
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Camera Manager
Create, edit, and delete dynamic cameras

Description
Camera Manager is a Mechanics Explorer tool that lets you create, edit, and delete
cameras with dynamic viewpoints.

You can constrain the camera trajectories using keyframe and tracking modes. Use the
keyframe mode to set the camera viewpoints at specific playback times and apply smooth
interpolation between them. Use the tracking mode to fix the camera position and aim to
coordinate frames and follow them during playback.

The cameras that you create appear in the cameras list shown in the visualization
context-sensitive menu. To select a camera, right-click the visualization pane and select
Camera. If the visualization pane is split into tiles, you can assign a different camera to
each tile. All dynamic cameras use a perspective projection to capture the visualization
contents.

Open the Camera Manager App
From the Mechanics Explorer menu bar, select Tools > Camera Manager. To open the
camera definition pane, click the  button in the New Camera field or the  button in
an existing camera field. Use the camera definition pane to set the camera mode and
trajectory constraints.

Parameters
Camera Name — Name of the camera
MATLAB string

Label used to identify the camera in the main pane of Camera Manager and in the
visualization context-sensitive menu.

 Camera Manager
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Mode — Dynamic camera mode
Keyframes (default) | Tracking

Select a mode for defining the camera trajectory:

• Keyframes — Set the camera viewpoints at specific playback times. The camera
trajectory is the result of smooth interpolation applied between keyframes.

• Tracking — Constrain the camera position, aim, and up vector to coordinate frames
in the model. The camera trajectory is the result of the constraints applied to the
camera.

Keyframes — Set, remove, and navigate keyframes
Buttons

Use the buttons to set, remove, and navigate camera keyframes:

• Set — Define a keyframe with the current viewpoint shown in the active visualization
tile. Click Set for an existing keyframe to modify its definition.

• Remove — Remove the currently selected keyframe from the camera trajectory
definition. The location of the playback slider identifies the selected keyframe.

• Previous and Next — Jump to the previous or next defined keyframes.

Before setting keyframes, you must simulate the model and pause playback. The
Keyframes parameter is active only when the Mode parameter is set to Keyframes.

Position — Fix the camera position to a frame origin
Button

Frame origin used to constrain the camera position. During simulation, the camera
position follows the trajectory traced by the selected frame origin. To set the camera
position:

1 In the Mechanics Explorer visualization or tree view panes, select a coordinate
frame.

2 In Camera Manager, click the Use Selected Frame button.

Be sure to select the frame itself and not simply the solid or body it belongs to. The
Position parameter is active only when the Mode parameter is set to Tracking.

Aim — Fix the camera aim to a frame origin or along a frame axis
Button
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Frame origin or axis used to constrain the camera orientation. During simulation, the
camera aim stays fixed on the selected frame origin or aligned along the selected frame
axis. To set the camera aim:

1 In the Mechanics Explorer visualization or tree view panes, select a coordinate
frame.

2 In Camera Manager, click the Use Selected Frame button.
3 From the adjacent drop-down list, select the frame origin or axis to constrain the

camera aim to.

Be sure to select the frame itself and not simply the solid or body it belongs to. The Aim
parameter is active only when the Mode parameter is set to Tracking.

Up Vector — Fix the camera up direction along a frame axis
Button

Frame axis used to constrain the camera up direction. During simulation, the up
direction stays aligned with the selected axis. To set the camera up direction:

1 In the Mechanics Explorer visualization or tree view panes, select a coordinate
frame.

2 In Camera Manager, click the Use Selected Frame button.
3 From the adjacent drop-down list, select the frame axis to align the camera up

direction with.

Be sure to select the frame itself and not simply the solid or body it belongs to. This
parameter is active only when the Mode parameter is set to Tracking.

See Also

Topics
“Visualization Cameras”
“Create a Dynamic Camera”

Introduced in R2016a
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Video Creator
Configure and create multibody animation videos

Description
Video Creator is a Mechanics Explorer tool that lets you configure and create videos of
multibody animations. You can modify the video playback speed, frame rate, file format,
and frame size. Click Create to generate a video with the specified properties. Use the
smwritevideo function for a programmatic alternative to Video Creator.

Open the Video Creator App
From the Mechanics Explorer menu bar, select Tools > Video Creator. You must
simulate the model in order to use Video Creator or the programmatic equivalent
smwritevideo function.

Parameters
Playback Speed Ratio — Video playback speed relative to real time
1.0 (default)

Video playback speed relative to real time, specified as a positive number. The video
plays faster than real time at values greater than 1 and slower at values smaller than 1.
For example, a ratio of 2 doubles the playback speed while a ratio of 0.5 halves it.

Frame Rate (FPS) — Number of video frames per second
30 (default)

Number of video frames per second of playback time, specified as a positive number.
Larger frame rates result in smoother video playback time but also larger file sizes.

Video Format — Video file format
Motion JPEG AVI (default) | Archival | Motion JPEG 2000 | MPEG-4 | Uncompressed
AVI
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File format to save the video in. The dropdown list provides various formats to select
from, including compressed and uncompressed formats.

Frame Size — Video frame width and height
auto (default)

Video frame width and height, specified in pixel units as the two-element row vector
[Width Height]. The frame dimensions must be positive integers. For example, the vector
[800 400] sets the video frame dimensions to 800 pixels in width and 400 pixels in height.
Enter the string auto instead to use the current dimensions of the active visualization
tile in Mechanics Explorer.

See Also
smwritevideo

Introduced in R2016b
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sm_lib
Open the Simscape Multibody block library

Syntax
sm_lib

Description
sm_lib opens the Simscape Multibody block library. Use this function to access
Simscape Multibody blocks without having to wait for the Simulink and Simscape
libraries to load.

Examples

Open the Simscape Multibody Block Library

Open the block library from the MATLAB command prompt

sm_lib

The Simscape Multibody block library opens in a new window.

• “Start a New Model”

See Also
smnew

Topics
“Start a New Model”
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Introduced in R2012a
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smexportonshape
Export a CAD assembly model from Onshape cloud software

Syntax
multibodyDescriptionFile = smexportonshape(assemblyURL)
multibodyDescriptionFile = smexportonshape(assemblyURL,Name,Value)

Description
multibodyDescriptionFile = smexportonshape(assemblyURL) generates the
files that you need in order to import an Onshape® assembly model into the Simscape
Multibody environment.

The assemblyURL argument is the web address of the Onshape assembly model to
export. To obtain the web address, open the Onshape model, select the assembly tab, and
copy the URL shown on your web browser.

The generated files include an XML multibody description file and a set of STEP files.
The XML file identifies the bodies that comprise the model and defines their kinematic
relationships. The STEP files provide the 3-D geometries of the bodies. By default, all
files are stored in the current MATLAB folder.

The multibodyDescriptionFile output is the name of the XML multibody description
file. You must use the smimport function with this name as an argument in order to
import the Onshape model into the Simscape Multibody environment. The figure shows
the export and import stages of the Onshape CAD translation workflow. The Simscape
Multibody model and M data file are the product of the import stage.
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Onshape CAD Translation Workflow

You must have an active Onshape account. The first time you use this function, you must
give the Simscape Multibody Exporter access privileges to your Onshape account. The
function uses these privileges strictly to access and export your Onshape models.
Onshape software grants the function access via Javascript tokens that keep your login
credentials and any user information secure and visible only to you.

To obtain the access tokens for your account, Simscape Multibody software requires you
to log in to your Onshape account once per MATLAB session. A secure Onshape log-in
page opens automatically on the first use of the smexportonshape function of a
MATLAB session.

You can revoke the access privileges granted to the Simscape Multibody Exporter at any
time. You must, however, restore those privileges if you want to export additional
Onshape models. If you revoke the access privileges, then on your next use of
smexportonshape an Onshape web page opens prompting you to accept or reject a
request to restore those privileges.

multibodyDescriptionFile = smexportonshape(assemblyURL,Name,Value)
adds a name-value pair argument to specify the folder in which to save the XML and
STEP files for the model.

Examples
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Export a Humanoid Robot Model

Export an Onshape model of a humanoid robot assembly into the current MATLAB
folder using the smexportonshape function. Then, import the generated model files into
the Simscape Multibody environment using the smimport function.

1 Store the URL of the Onshape model in a MATLAB variable named url. The URL
must always correspond to the Onshape assembly tab that you want to export.

url = 'https://cad.onshape.com/documents/5817806f96eae5105bfa5085/w/15ab3bfb58cacbf427d77ff3/e/181493813f84966648a8db1b';
2 Export the humanoid robot model using the smexportonshape function. Store the

name of the generated multibody description file in a variable named xmlFile. You
may be prompted to log in to your Onshape account.

xmlFile = smexportonshape(url);
3 Import the model into the Simscape Multibody environment using the smimport

function. Simscape Multibody software recreates the Onshape model as a block
diagram.

smimport(xmlFile);
4 Update the block diagram. Mechanics Explorer opens with a static visualization of

the model in its initial configuration—one matching the pose of the Onshape model
at the time of export.

Note that the vertical axis of the robot (+Y) differs from the default vertical axis used
in the Mechanics Explorer visualization pane (+Z). To orient the robot vertically,
select View > View convention > Y Up (XY Front). Select a standard view from
the View > Standard Views menu to activate the new view convention.
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Export a Humanoid Robot Model to a Specific Folder

Export an Onshape model of a humanoid robot assembly into a specific folder using the
smexportonshape function.

1 Store the URL of the Onshape model in a MATLAB variable named url and the
folder in which to save the model in a variable named folder. You must create the
folder shown or replace that folder with one to which you have write privileges.
url = 'https://cad.onshape.com/documents/5817806f96eae5105bfa5085/w/15ab3bfb58cacbf427d77ff3/e/181493813f84966648a8db1b';
folder = 'C:\Documents\Export

2 Export the humanoid robot model using the smexportonshape function. Use the
FolderPath name-value pair argument to specify the export folder.

xmlFile = smexportonshape(url, 'FolderPath', folder);

Import the model into the Simscape Multibody environment as before using the
smimport function. Update the diagram to visualize the imported model in
Mechanics Explorer.

Input Arguments
assemblyURL — Web address of the Onshape assembly model to export
custom string or character vector
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Web address of the Onshape assembly model to export. The function uses this address to
access the assembly model and export it in a format compatible with Simscape Multibody
software.

To obtain the URL, open the Onshape assembly model, select the assembly tab, and copy
the URL from the web browser. The assembly model need not belong to your Onshape
account if it is shared with you or made public.
Example: https://cad.onshape.com/documents/3e07ba43d290f9b924933ce8/w/
eb80497ae2e1a3af0c4ce16d/e/f7903984700a200643fb6141
Data Types: char | string

Name-Value Arguments

Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside single
quotes (' '). You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.
Example: xmlFile = smexportonshape('https://cad.onshape.com/documents/
5817806f96eae5105bfa5085/w/15ab3bfb58cacbf427d77ff3/e/181493813f84966648a8db1b',
'FolderPath', 'C:\Documents\Export');

folderPath — Destination folder for exported files
custom string or character vector

Path of the folder in which to save the XML and STEP files generated during model
export. The path can be absolute or relative. You must have write privileges to the folder
in order to save the files there.
Example: 'C:/Documents/Models'
Data Types: char | string

Output Arguments
multibodyDescriptionFile — Name of the XML multibody description file generated
during export
character vector
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Name of the XML multibody description file generated during Onshape CAD export. The
name is derived from the OnShape assembly name. You use this name as an argument in
the smimport function to import the model into the Simscape Multibody environment.
Data Types: char

See Also
smimport

Introduced in R2017a
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smimport
Import a multibody model from a URDF or Simscape Multibody XML file

Syntax
[H,dataFileName] = smimport(multibodyDescriptionFile)
[H,dataFileName] = smimport(multibodyDescriptionFile,Name,Value)

Description
[H,dataFileName] = smimport(multibodyDescriptionFile) generates a
Simscape Multibody model from a multibody description file conforming to the URDF
XML specification or to the Simscape Multibody XML schema. Models generated from
Simscape Multibody XML files are accompanied by data files that provide the block
parameter values.

H is the model handle and dataFileName is the name of the supporting data file. By
default, the model and data file are named after the URDF or XML multibody
description file. If the name of the multibody description file does not conform to
MATLAB naming rules, a modified version of the file name is used in its place.

multibodyDescriptionFile is the name of the multibody description file. The file
path can be absolute or relative. If no path is given, the function searches for the file on
the MATLAB path. The file extension is optional. In the absence of an extension, the
function treats the file as a Simscape Multibody XML file.

The multibody description file details the structure and properties of the model to
import. The file can be in URDF or Simscape Multibody XML formats. URDF files must
conform to the URDF XML specification. Simscape Multibody XML files must conform to
the Simscape Multibody XML schema.

You can use the Simscape Multibody Link CAD plug-in to generate a valid Simscape
Multibody XML file from the following CAD applications:

• Autodesk Inventor®
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• PTC® Creo™
• SolidWorks®

The data file, which accompanies models generated from Simscape Multibody XML files,
provides the numerical values of the block parameters in the form of a MATLAB data
structure. Blocks in the imported model reference the MATLAB structure fields through
the model workspace. The default structure name is smiData.

[H,dataFileName] = smimport(multibodyDescriptionFile,Name,Value) adds
options for specifying a CAD import mode, a CAD model simplification mode, and various
file names. Set ImportMode to dataFile in order to generate a new data file for a
previously imported CAD assembly model. Specify PriorDataFile to catch unexpected
changes to the XML multibody description file, such as part name changes or the
addition and deletion of parts. Only the ModelName argument applies if importing from a
URDF multibody description file.

Input Arguments
multibodyDescriptionFile — Multibody description file to import
custom string or character vector

Name, extension, and path of the multibody description file to import. The file must
conform to the published URDF specification or the Simscape Multibody XML schema.
The file extension and path are optional parts of the argument. In the absence of a file
extension, the function treats the file as a Simscape Multibody XML file. In the absence
of a file path, the function searches for the file on the MATLAB path.
Example: 'robotto.xml'
Data Types: char | string

Name-Value Arguments
Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside single
quotes (' '). You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.
Example:
smimport('sm_robot','ModelName','robotto','DataFileName','robottos_data_file');
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ModelSimplification — Topology simplification mode
none (default) | dataFile

Topology simplification mode to use during CAD import. Set ModelSimplification to:

• bringJointsToTop to group rigidly connected parts into subsystems and promote
joints to the top level in the model hierarchy.

• groupRigidBodies to group rigidly connected parts into subsystems but leave joints
in their original places in the model hierarchy.

• None to import the model as is, without simplification.

Joints brought to the top level of a model are renamed using generic names based on the
joint type—for example, Revolute_Joint1. Subsystems of rigidly connected
components that have been grouped together are given generic names based on the
string RigidSubsystem—for example, RigidSubsystem1. This argument does not
apply to multibody description files in URDF format.
Example: bringJointsToTop
Data Types: char | string

ImportMode — Choice of model import or data file update function modes
modelAndDataFile (default) | dataFile

Option to generate a new model or update existing model data. Set ImportMode to
modelAndDataFile to generate a new model and data file. Set ImportMode to
dataFile to generate a new data file for a previously imported model. The function does
not update the block diagram itself. If you do not specify ImportMode, the function runs
in modelAndDataFile mode. This argument does not apply to multibody description
files in URDF format.
Example: 'dataFile'
Data Types: char | string

ModelName — Name of the multibody model to generate
custom string or character vector

Name of the Simscape Multibody model to generate. The model is saved in SLX format.
This argument is not valid when ImportMode is set to dataFile. If you do not specify
ModelName, the model file is named after the multibody description file. If the multibody
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description file name is inconsistent with MATLAB naming rules, a modified version is
used instead.
Example: 'robotto'
Data Types: char | string

DataFileName — Name of the parameter data file to generate
custom string or character vector

Name of the supporting parameter data file. The data file is an M file with the block
parameter values referenced in the imported Simscape Multibody model. If you do not
specify DataFileName, the data file is named after the multibody description file. If the
multibody description file name is inconsistent with MATLAB naming rules, a modified
version is used instead. This argument does not apply to multibody description files in
URDF format.
Example: 'robottos_new_data'
Data Types: char | string

PriorDataFile — Name of the last used parameter data file
custom string or character vector

Name of the last parameter data file associated with a previously imported model. The
prior data file helps to identify changes requiring special attention, such as new physical
units, added and deleted components, and model topology changes. This argument is
valid only when ImportMode is set to dataFile. This argument does not apply to
multibody description files in URDF format.
Example: 'robottos_original_data'
Data Types: char | string

VariableName — Name of the MATLAB structure provided in the parameter data file
custom string or character vector

Name of the MATLAB data structure provided in the parameter data file. This structure
contains the numerical values of all block parameters in the Simscape Multibody model.
If you specify neither PriorDataFile nor VariableName, the data structure is named
smiData. If you specify PriorDataFile but not VariableName, the data structure
name is derived from the prior data file. This argument does not apply to multibody
description files in URDF format.
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Example: 'robottosData'
Data Types: char | string

Output Arguments
H — Model handle
double

Model handle returned as a double. Use the model handle to get or set model parameters,
for example, using the get_param and set_param functions.

dataFileName — Name of the parameter data file
string

Name of the parameter data file. The data file is an M file with the block parameter
values referenced in the imported Simscape Multibody model. This output argument does
not apply to models generated from URDF multibody description files.
Data Types: double

Examples

Import a CAD Robotic Arm Model

Import a model of a robotic arm from an XML multibody description file named
sm_robot.xml. The XML file is part of your Simscape Multibody installation.

1 Import the model and store it in memory as Untitled. You can later save the model
with your name of choice.

smimport('sm_robot');
2 Update the diagram to assemble the model and visualize it in Mechanics Explorer.

You can update the diagram from the Simulink menu bar by selecting Simulation >
Update Diagram.
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The view convention of the source CAD platform differs from that of Simscape
Multibody software, causing the model to appear on its side.

3 In the Mechanics Explorer tool strip, set the View convention parameter to Y up
(XY Front) and select a standard viewpoint, such as the isometric view shown
below.

Selecting a standard view activates the new view convention. The visualization
rotates to show the robot arm in the proper orientation.

4 Simulate the model. The robot arm lacks a control system and swings around under
the influence of gravity.

Build on the model by adding control subsystems to simulate useful tasks. Add
internal mechanics and state targets at joints to dampen motion and configure the
starting pose of the arm.

Import a CAD Robotic Model Using Custom File Names
Generate a CAD robotic arm model from the sm_robot.xml multibody description file
included in your Simscape Multibody installation. Specify the model name as robotto
and the data file name as robottos_data_file. At the MATLAB command prompt,
enter the following code.
smimport('sm_robot','ModelName','robotto',...
'DataFileName','robottos_data_file');
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Regenerate the Data File for a Previously Imported CAD Robotic Arm
Model

Regenerate the data file for the previously imported CAD robotic arm model. Specify the
data file name as robottos_new_data_file to avoid overwriting the original data file.
At the MATLAB command prompt, enter the following code.

smimport('sm_robot','ImportMode','dataFile','DataFileName',...
'robottos_new_data_file','PriorDataFile','robottos_data_file');

Point the previously generated model to the new data file and reinitialize the model
workspace using the following MATLAB code.

hws = get_param(bdroot,'modelworkspace');
hws.DataSource = 'MATLAB File';
hws.FileName = 'robotFileData';
hws.reload;

You can perform the same task using Model Explorer. In the Model Workspace pane
for the imported model, enter the updated File Name parameter. Then, click the
Reinitialize from Source button.

Import a URDF Humanoid Robot Model

Import a URDF model of a humanoid robot from the URDF model file
sm_humanoid.urdf. The URDF file is part of the Simscape Multibody installation.

1 Import the model and store it in memory as Untitled. You can later save the model
with your name of choice. The file extension is optional when importing XML files
but required when importing URDF files.

smimport('sm_humanoid.urdf');
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2 Update the diagram to assemble the model and visualize it in Mechanics Explorer.
You can update the diagram from the Simulink menu bar by selecting Simulation >
Update Diagram.

3 Simulate the model. The robot arm lacks a control system and swings around under
the influence of gravity. The shoulder line is the root body in the URDF model and it
is fixed to the world frame in the imported model.

Try modifying the model—for example, by removing the rigid connection between the
shoulder line and the world frame and by adding control subsystems at the various
joints. See the Humanoid Robot featured example for a version of the model with
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basic motion controls. You can open the example by entering
sm_import_humanoid_urdf at the MATLAB command prompt.

See Also
smexportonshape

Introduced in R2012b
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smnew
Open Simscape Multibody model template and block library

Syntax
smnew
smnew(modelName)
smnew(modelName,solverType)

Description
smnew creates a model from the Simscape Multibody template. The template includes
several commonly used blocks and an automatic variable-step solver selection. Simscape
data logging is enabled by default, with the data history limited to 10,000 data points.

smnew(modelName) adds an option to name the model built from the template.

smnew(modelName,solverType) adds an option to specify the Simulink solver to use
with the model.

Examples

Create a Simscape Multibody Model

Create a model from the Simscape Multibody template at the MATLAB command
prompt:

smnew

The model name is untitled and the solver type is auto.
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Create a Simscape Multibody Model with the Specified Name

Create a model named robotto from the Simscape Multibody template:

smnew('robotto')

The solver type is auto.

Create a Simscape Multibody Model with the Specified Name and Solver Type

Create a model named robotto with the Simulink solver type set to ode15s from the
Simscape Multibody template:

smnew('robotto','ode15s')

• “Start a New Model”

Input Arguments
modelName — Name of the model to create from the template
untitled (default) | String or character vector with the model name

Name of the model to create from the template. The name must conform to the MATLAB
naming rules. Do not include the file path in the model name. If the specified character
vector is invalid, the model is named untitled.
Example: 'robotto'
Data Types: char | string

solverType — Simulink solver to use for simulation
auto (default) | String or character vector with the solver name

Solver to use for simulation. The solver type must be a valid Simulink solver, such as
ode45, or ode15s. For best performance, consider using a variable-step solver unless you
have a specific need for fixed-step simulation.
Example: 'ode15s'
Data Types: char | string
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See Also
sm_lib

Topics
“Start a New Model”

Introduced in R2012a
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smwritevideo
Configure and create multibody animation videos

Syntax
smwritevideo(modelIdentifier,videoName)
smwritevideo(modelIdentifier,videoName,Name,Value)

Description
smwritevideo(modelIdentifier,videoName) creates an animated video from the
visualization results of a multibody simulation. modelIdentifier is the source model
name or handle. videoName is the generated video file name and path. You can open the
video file with any compatible media player.

The video properties are those specified in the Video Creator interface the moment you
run the function. If the Video Creator parameters are in their default settings, the video
properties are set to those defaults.

Before running smwritevideo, you must simulate the model. In addition, the model
visualization results must open in a Mechanics Explorer window. If you have previously
disabled model visualization, reenable it before continuing. To do this, see “Enable
Mechanics Explorer”.

If the model visualization pane is split into tiles, the function captures only the active
tile. A colored outline identifies the active tile. Select the desired tile before creating a
video.

smwritevideo(modelIdentifier,videoName,Name,Value) adds options for
specifying the video properties. Use the Name,Value pair arguments to change the video
file format, frame refresh rate, frame width and height, and playback speed ratio.
Unused arguments are set to the latest settings specified in the Video Creator tool.
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Examples

Create Video of Flapping Wing Model

Create a video named flapping_wing_video from the simulation results of the
sm_cam_flapping_wing featured example. Use the video settings currently specified in
the Video Creator tool.

1 Open the flapping wing featured example.

sm_cam_flapping_wing
2 Simulate the model.

sim('sm_cam_flapping_wing')
3 Create a video of the simulation results.

smwritevideo('sm_cam_flapping_wing','flapping_wing_video');

The function saves the video as flapping_wing_video in the current MATLAB
folder. The video file format is that specified in the Video Creator tool. Open the
video using your media player of choice.
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Create Video of Double Wishbone Suspension Model

Create a video named wishbone_suspension_video from the simulation results of the
sm_double_wishbone_suspension featured example. Change the video settings as
shown in the table.
Property Argument Setting
Playback Speed Ratio PlaybackSpeedRatio 2.0
Frame Rate (FPS) FrameRate 60
Video Format VideoFormat uncompressed avi

1 Open the wishbone suspension featured example.

sm_double_wishbone_suspension
2 Simulate the model.

sim(s'm_double_wishbone_suspension')
3 Create a video of the simulation results.

smwritevideo('sm_double_wishbone_suspension', 'wishbone_suspension_video',...
'PlaybackSpeedRatio', 2.0, 'FrameRate', 60, 'VideoFormat', 'uncompressed avi');

The function saves the video as wishbone_suspension_video.avi in the current
MATLAB folder. Open the video using your media player of choice. The video plays
at twice the original speed seen in Mechanics Explorer.
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Input Arguments
modelIdentifier — Name or handle of the source model
Character vector with the model name or handle

Name or handle of the source model, specified as a MATLAB string. You must simulate
the specified model before using this function. The model visualization window must be
open in order for the function to create a video.
Example: ‘sm_cam_flapping_wing’
Data Types: string

videoName — Name and path of the video file
Character vector with the desired video file name

Name and full or relative path of the video file, specified as a string. In the absence of a
file path, the function saves the video file in the current MATLAB folder. The file format
is determined from the video settings specified using the Video Creator tool or the
VideoFormat Name,Value pair argument.
Example: ‘flapping_wing_video’
Data Types: string

Name-Value Pair Arguments
Specify optional comma-separated pairs of Name,Value arguments. Name is the
argument name and Value is the corresponding value. Name must appear inside single
quotes (' '). You can specify several name and value pair arguments in any order as
Name1,Value1,...,NameN,ValueN.
Example: 'PlaybackSpeedRatio', 2.0

PlaybackSpeedRatio — Playback speed relative to real time
1.0 (default)

Video playback speed relative to real time, specified as a positive scalar. Increase this
factor for faster playback speeds. For example, a value of 2.0 doubles the video playback
speed relative to the base playback speed used in Mechanics Explorer.
Data Types: single | double | int8 | int16 | int32 | int64 | uint8 | uint16 |
uint32 | uint64
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FrameRate — Number of video frames per second of playback time
30 (default)

Number of video frames per second of playback time, specified as a positive scalar.
Increase this factor for smoother playback but larger video files. Small numbers may lead
to choppy videos.
Data Types: single | double | int8 | int16 | int32 | int64 | uint8 | uint16 |
uint32 | uint64

VideoFormat — Video file format
motion jpeg avi (default) | archival | motion jpeg 2000 | mpeg-4 | uncompressed avi

File format to save the video in, specified as a string. Select from a list of compressed and
uncompressed formats with varying quality levels and storage space requirements. Use
the default format of uncompressed jpeg avi if file size is a concern. Use
uncompressed avi if top video quality is a priority. The mpeg-4 format is not
supported in Linux systems.
Data Types: string

FrameSize — Video frame width and height
auto (default) | custom width and height

Width (W) and height (H) of the video contents, specified in pixel units as the two-
element row vector [W H]. The vector elements must be positive integers. Use the default
setting of auto to obtain the video dimensions from the Mechanics Explorer visualization
pane size.
Example: [800 800]
Data Types: single | double | int8 | int16 | int32 | int64 | uint8 | uint16 |
uint32 | uint64

See Also
Video Creator

Introduced in R2016b
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Convert a First-Generation Model
The Simscape Multibody environment spans two product generations. The first builds on
a modeling paradigm introduced at the inception of the product and actively developed
up to software version R2011b. The second builds on a revamped modeling paradigm
introduced in software version R2012a and actively developed to this day.

Second-generation technology is not only an alternative to its first-generation
counterpart, it is its intended replacement. You should, for this reason, create all new
models using second-generation features alone. In addition, to ensure that your older
models remain in a functional state, you should recreate those dependent on first-
generation features using second-generation features instead.

The following sections summarize the key similarities and differences between the two
software generations. The vast majority of first-generation features have second-
generation analogues. The sparse few that do not, massless joint connectors and velocity
drivers among them, have relatively simple workarounds. Those workarounds are
discussed in detail in those cases that might not at first sight seem obvious.

Frames and Signals
The axis triads known in first-generation models as coordinate systems are referred to in
second-generation models as frames. Frames serve an important role in your modeling
workflow. They encode in their origins and axes the positions and orientations of bodies
in a model. You use frames to connect bodies, constrain their motions, even apply forces
and sense motion.

In a manner similar to first-generation blocks, second-generation blocks use frame ports
to identify their respective frames. The connection rules for these ports remain much the
same. A direct connection line between frame ports establishes an identity relationship
between them, making the corresponding frames coincident in space. Placing a Rigid
Transform block between any two frames enables you to offset those frames in space—by
applying a translational offset, a rotational offset, or a mixed translational-rotational
offset between them.

The input and output ports of blocks are now compatible only with Simscape physical
signals. In first-generation blocks, the same types of ports were compatible only with
Simulink signals. The switch to physical signal inputs and outputs allows for tighter
integration with other Simscape physical domains. For example, you can now directly
connect the output of a Simscape Fluids subsystem to the input of a Simscape Multibody
block.

5 First-Generation Conversion

5-2



Simulink signals remain a practical means of specifying model inputs and analyzing
model outputs. You can still interface Simscape Multibody blocks with Simulink blocks.
You must, however, convert between physical signals and Simulink signals. You do this
by using the appropriate converter block—PS-Simulink Converter or Simulink-PS
Converter.

Rigid Bodies

Bodies are the source of all geometries and nearly all inertias in a model. In a first-
generation model, a Body block, complete with inertia, geometry, and coordinate systems
(now frames) represents a body. In the second-generation environment, this role is filled
by the Solid block, often in conjunction with the Rigid Transform block, by means of
which the solid frames can be properly placed, e.g., for connection to other bodies. The
figure shows an example.

The table compares the first- and second-generation features relevant to the modeling of
bodies. A green icon denotes a feature that is maximally supported. A yellow icon denotes
a feature that is partially supported. A red icon denotes a feature that is not supported.
Feature First Generation Second

Generation
Native solid geometries

Imported solid geometries

Manual inertia inputs

Derived inertia parameters

Variable inertia parameters
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Feature First Generation Second
Generation

Body visualization

Interactive frame creation

Geometry, Inertia, and Frames

The Solid block provides a selection of native geometries parameterized in terms of key
dimensions, such as Sphere (parameterized in terms of radius) and Cylinder
(parameterized in terms of radius and length). These geometries replace the more
primitive convex hulls and inertia ellipsoids used in the Body block. You can also import
detailed geometries in STL format (both generations) and STEP format (second
generation only).

The Solid block provides other features not found in the Body block. You can specify the
mass properties of the solid explicitly or, for ease of modeling, you can have them derived
from density and geometry. You can track the current state of the solid and the
placement of its frames using a visualization pane embedded in the block dialog box. And
you can add new frames to the solid and place them using geometry features such as
vertices, edges, and planes as guides.

A second-generation library of variable-mass blocks enables you to model bodies whose
dimensions and mass properties can evolved over time. These blocks, which include
General Variable Mass, Variable Brick Solid, Variable Cylindrical Solid, and Variable
Spherical Solid, replace the first-generation functionality provided by the combination of
the Body block with the Variable Mass & Inertia Actuator block.

Frame Definitions as Local

Unlike the coordinate systems of first-generation models, the frames of second-
generation models are always locally defined. The position and orientation of a frame
provided by a Rigid Transform block is always specified relative to a local frame (the base
frame of the block). This approach is in contrast to that taken in first-generation models.
There, the coordinate systems of a Body block are variously defined relative to local
coordinate systems (base or follower) or to the world coordinate system.

The requirement that all frames in a model be locally defined ensures that all bodies in
that model are reusable. In a second-generation model, you can generally connect a body
elsewhere in the model, or even in a different model, without first having to redefine its
connection frames. You can in principle create a custom library of body blocks and use
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them in your models without worrying about which frame a particular connection frame
is defined against.

Multibody Assembly

Joints are the primary means of connecting bodies in a model. Specialized kinematic
constraints, such as those characteristic of gears, provide a means to recreate motions
not possible through joints alone. Most joint blocks in the first-generation library have
second-generation counterparts, and these are built on the same concept of joint
primitive found also in first-generation joint blocks. Most constraint blocks have second-
generation counterparts also, with the exception of Velocity Driver, although the
functionality of this block is easily reproduced with joint blocks.

Disassembled joint blocks and massless connector blocks are among the joint blocks no
longer provided in the second-generation library. Disassembled joints are those few
whose rotational axes were freely and automatically aligned during the model assembly
stage. Such joints provided a convenience in models with loop topologies, where the
placement of one joint could be automatically determined from the placement of all
others upon closure of the loop. Massless connector blocks are pairs of joints connected to
each other without a mass element in between. You can approximate a massless joint
connector in a second-generation model using other available blocks.

The table compares the first- and second-generation features relevant to the assembly of
bodies by means of joints and constraints. A green icon denotes a feature that is
maximally supported. A yellow icon denotes a feature that is partially supported. A red
icon denotes a feature that is not supported.
Feature First Generation Second

Generation
Angle and Distance
Constraints
Point-on-curve constraint

Gear constraints

Velocity constraints

Massless joint connectors

Disassembled joints
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Feature First Generation Second
Generation

Joint initial state targets

For more information, see:

• “Modeling Joint Connections”
• “Modeling Gear Constraints”

Reproducing Massless Joint Connectors

You can approximate a massless joint connector by means of rigid transforms and Solid
or Inertia blocks:

1 Connect the joints that you want to use in the massless connector—for example, two
Revolute Joint blocks—with a frame connection line.

2 Insert a Rigid Transform block in the connection line and use it to specify the
translational and rotational offsets between the joints.

3 Place a Solid or Inertia block between the joints and set its mass to a small value.
This block satisfies the simulation requirement that joints with rotational degrees of
freedom connect on each side to a nonzero inertia. The small value of the mass
ensures that the connector behaves approximately as though it were massless.

System Dynamics

The forces and torques specified in a model determine to a great extent the dynamics
exhibited during simulation. You can specify those forces and torques directly: as
actuation inputs to joints and the use of specialized forces and torques such as those
provided by External Force and Torque and Inverse Square Law Force blocks. You can
also specify those forces and torques indirectly: in terms of the joint motions that they
must, on the aggregate, produce, and by the introduction of a gravitational acceleration
constant (a mere proxy for the gravitational force itself).

Both generations support the use of joint force and torque actuation as well as of joint
motion actuation, with some notable differences. While in a first-generation model the
actuation inputs derive from separate Joint Actuator blocks, in a second-generation
model they are specified directly through the joint blocks themselves. The actuation
inputs are in the form of Simulink signals in a first-generation model, but in the form of
Simscape physical signals in a second-generation model.
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The table compares the first- and second-generation features relevant to the specification
and sensing of forces, torques, and motion variables in a model. A green icon denotes a
feature that is maximally supported. A yellow icon denotes a feature that is partially
supported. A red icon denotes a feature that is not at all supported.
Feature First Generation Second

Generation
Constant uniform gravity

Variable uniform gravity

Gravitational fields

Force and torque actuation

Force and torque sensing

Motion actuation

Motion sensing

Joint springs and dampers

Reproducing the Effects of Velocity Drivers

In a second-generation model, all motion inputs are specified directly through joints—the
components from which bodies derive their degrees of freedom. If you want to constrain
the relative velocity of a body, you must configure the appropriate joint to accept motion
signals as actuation inputs. The motion signals must by definition provide the time-
variable position of the body. As such, if your known variable is velocity, you must first
integrate velocity to obtain the final position input.

Model Visualization

Visualization provides a means to explore and analyze the results of a multibody
simulation. In a second-generation model, visualization is handled by Mechanics
Explorer, the replacement to the visualization utility of the first-generation
environment. By default, Mechanics Explorer opens automatically when you first update
or simulate a model. You can manipulate the visualization contents using controls
familiar from the first-generation utility—such as Pan, Rotate, and Zoom—and others
new in Mechanics Explorer, such as Roll.
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The visualization is static on model update and dynamic during simulation. You can
replay a dynamic visualization, more aptly referred to as an animation, without having
to simulate the model again—a requirement of first-generation models. You can
selectively hide bodies, for example, to more clearly visualize others, and navigate to the
block corresponding to a selected component. So that you can share the results of your
simulations, a Video Creator tool enables you to record animations and save them in
formats such as MPEG-4 and uncompressed AVI.

Mechanics Explorer supports also dynamic visualization cameras—those that can move
during the course of simulation. You can constrain the camera trajectories via keyframes,
each a point in time at which you specify the desired camera position and orientation.
You can also constrain the camera trajectory by attaching it to and aiming it at frames
that you select. Dynamic cameras are useful when visualizing models of moving vehicles,
such as that shown in the featured example Configuring Dynamic Cameras - Vehicle
Slalom.

The table compares the first- and second-generation features relevant to the
visualization of a multibody model. A green icon denotes a feature that is maximally
supported. A yellow icon denotes a feature that is partially supported. A red icon denotes
a feature that is not at all supported.
Feature First Generation Second

Generation
Static visualization

Dynamic visualization

3-D model exploration

Animation replay

Visualization filtering

Video Creation

Dynamic Cameras

"Go to Block" Navigation

For more information, see: “Selective Model Visualization”

• “Selective Model Visualization”
• “Create a Model Animation Video”
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• “Go to a Block from Mechanics Explorer”
• “Visualization Cameras”

Simulation and Analysis

Machine dimensionality and analysis mode are no longer required parameters in a
model. In the first-generation environment, both were specified explicitly via the
Machine Environment block. In the second-generation environment, dimensionality is
determined automatically from the relative placement of joints and constraints. The
types of analysis allowed during simulation are a direct consequence of the actuation
inputs specified at, and the sensing outputs provided at, joints.

The table compares the first- and second-generation features relevant to the analysis of
model parameters and simulation data. A green icon denotes a feature that is maximally
supported. A yellow icon denotes a feature that is partially supported. A red icon denotes
a feature that is not at all supported.
Feature First Generation Second

Generation
2-D and 3-D simulation

Forward and inverse
dynamics
Trimming and linearization

Simscape data logging

Simscape variable viewer

Simscape statistics viewer

Reproducing the First-Generation Analysis Modes

The (first-generation) Machine Environment block provides a selection of four analysis
modes:

• Forward dynamics — Compute the motions of bodies (their positions and velocities)
given some force and torque inputs and some initial positions and velocities.

• Inverse dynamics — Compute the forces and torques acting on bodies arranged in
an open-loop structure given some position and velocity inputs and some initial
positions and velocities.
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• Kinematics — Compute the forces and torques acting on bodies arranged in a closed-
loop structure given some position and velocity inputs and some initial positions and
velocities. This mode is merely the closed-loop analogue of Inverse dynamics.

• Trimming — Configure a model for trimming via the Simulink trim function or the
more powerful Control Design Toolbox findop function. Trimming is the discovery of
steady-state operating points. Models are often linearized about such points, for
example, by means of the Simulink linmod function.

You can trim and linearize a second-generation model using the appropriate Simulink
tools. No special Simscape Multibody setting is required to perform either task. The size
of perturbations applied in linearization tasks is specified through the Mechanism
Configuration block.

Third-Party Model Import

CAD import remains an important modeling workflow in the second-generation
environment. The smimport function replaces the mech_import function as the means
of importing a CAD assembly model. URDF model import is now also possible by means
of the same function, as is Onshape model export, by means of the smexportonshape
function.

The table compares the first- and second-generation features relevant to the import of
third-party multibody models into the Simscape Multibody environment. A green icon
denotes a feature that is maximally supported. A yellow icon denotes a feature that is
partially supported. A red icon denotes a feature that is not at all supported.
Feature First Generation Second

Generation
CAD assembly import

CAD assembly update

Imported-model
simplification
URDF assembly import

Onshape assembly export

For more information, see:
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• “CAD Translation”
• “URDF Import”
• “Onshape Import”

 Convert a First-Generation Model

5-11




